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วิธีการใชงานคูมือฉบับแปลไทย 12 

การทํางานพื้นฐาน 14 

เพิ่มชื่อหลักทรัพยใหม (Adding a new symbol) 14 

ลบชื่อหลักทรัพย (Removing a symbol) 14 

แตกหุน(Splitting a stock) 14 

ลบจํานวนหุน (Deleting quotation) 15 

เพิ่ม/ลด ชื่อหลักทรัพยจากรายการโปรด (Adding/removing symbol from favourites) 15 

รวมจํานวนหุนจาก หลักทรัพย 2 ตัว (Merging quotations of two symbols) 16 

คูมือการใชชารทเบื้องตน 17 

เกริ่นนํา (Introduction) 17 

การทํางานพื้นฐาน (Basic operations) 19 

การเลื่อน (Scrolling) 19 

การซูม (Zooming) 19 

ยอ, ขยาย และขยับสเกลของแกน Y (Shrinking, expanding and moving Y-axis scale) 19 

เปลี่ยนไทมเฟรมของแทง (Changing bar interval (periodicity)) 20 

Selecing a quote 21 

เลือกชวง (Marking range) 22 

เพิ่ม / ปดหนาตางชารท (Adding / closing chart panes) 22 

เชื่อมโยงและล็อคชารท (Linking and locking chart) 22 

การใชเครื่องมือวาด (Using drawing tools) 23 

วิธีใชงานการลากและวางชารท(Indicator) 27 

เกริ่นนํา (Introduction) 27 

จะใสอินดิเคเตอรใหมไดอยางไร (How to insert a new indicator) 27 

จะทํายังไงใหอินดิเคเตอรอันนึงวางซอนบนอีกอันนึงได (How to overlay one indicator on another 

indicator) 28 

จะลบอินดิเคเตอรอยางไร (How to delete the indicator) 29 
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จะลบอินดิเคเตอรในหนาตางนั้นออกไปอยางไร (How to remove the indicator plot from the 

pane) 30 

จะเปลี่ยนคาพารามิเตอร สี และสไตลของอินดิเคเตอรอยางไร (How to change 

parameters/colors/styles of indicators) 31 

จะใสอินดิเคเตอรที่มีสเกลตางกันซอนกันไดอยางไร (How to overlay indicators with different 

scales) 31 

จะสรางอินดิเคเตอรใหมโดยอางอิงบนอินดิเคเตอรอ่ืนอยางไร(How to create an indicator based on 

another indicator) 32 

การใชคําสั่ง Param(), ParamColor(), ParamToggle(), ParamStyle() (Using Param(), 

ParamColor(), ParamToggle(), ParamStyle() functions) 33 

คําถามที่พบบอยเกี่ยวกับฟงกช่ันลากและวาง (Frequently Asked Questions about drag & drop 

functionality) 39 

ธีมของชารท 43 

1. ธีมพื้นฐาน (Basic Theme) 44 

2. ธีมแบบงาย(Nature Simple Theme) 45 

3. ธีมแบบมีสี (Nature Gradient Theme) 46 

4. ธีมสีเทา (Gray Theme) 47 

5. ธีมสีเทาเขม (Dark Gray Theme) 48 

6. ธีมสีดํา (Black Theme) 49 

การปรับแตงหนาจอผูใช 50 

การเอากลุมบางอันออก / การซอนแท็บ (Advanced nested docking / tear-off tabs) 50 

การซอนหนาตางอัตโนมัติ (Sliding Auto-hide panes) 51 

การปรับแตงแถบเครื่องมือ เมนู และปุมลัดข้ันสูง (Advanced customizable toolbars, menus and 

keyboard shortcuts) 53 

ธีมที่ปรากฏ (Themed appearance) 55 

แท็บ MDI (multiple document interface) (MDI (multiple document interface) tabs) 56 

การใชงานหนาชารทและหนาตาง Layout 59 
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หนาชารทและรูปแบบ (Chart sheets and templates) 59 

ชื่อหลักทรัพยและการเชื่อมโยงภายใน (Symbol and Interval Linking) 63 

การแยกหนาตาง (Floating windows) 64 

โครงสรางของหนาตาง (Window layouts) 65 

การใชงาน Layers 67 

Layers คืออะไร (What layers are) 67 

Layers ทํางานอยางไร(How to work with layers) 67 

เมนูยอย (Context menu) 68 

การใชงานหนาตางการวิเคราะหแบบใหม 70 

เกริ่นนํา (Introduction) 70 

หนาจอผูใช (User interface) 71 

การทํางานพื้นฐาน (Basic operations) 73 

ระบุตัวกรอง (Defining Filter) 74 

กําหนดชวงวันและเวลา (Defining date/time Range) 74 

การดูผลรายงาน / เปดหนา Report Explorer (Viewing reports / Running Report Explorer)

74 

เปลี่ยนการตั้งคา / ตัวเลือก (Changing settings / options) 75 

ใชการเทสแบบ Walk Forward (Running Walk forward Test) 75 

แสดงผลการ Optimize แบบชารท 3 มิติ (Displaying 3D optimization chart) 76 

สงออกและนําเขาผลลัพธ (Exporting and importing result list) 76 

การจัดการ Watch List 78 

การ เพิ่ม/ลบ Watchlist (Adding / removing watch lists) 78 

การนํา tickers เขาสู watch lists (Adding tickers to watch lists) 79 

การเรียงลําดับ tickers in a watch list (Sorting tickers in a watch list) 80 

การลบ tickers ออกจาก watch list(Removing tickers from watch lists) 80 

การลบ watch list หรือ ลางรายช่ือท่ีอยูใน watch list ของคุณ(Erasing watch lists) 81 

ซอน/ปดการซอน watch list ตางๆท่ีวางเปลา (Hiding/Unhiding empty watch lists) 81 
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การใช watch lists ในหนาตาง Automatic analysis ( Using watch lists in Automatic analysis 

window) 81 

จะ นําเขา/นําออก watch list จาก/ไปยัง ไฟล ไดอยางไร 82 

การนําเขา watch list จากไฟลใดๆ (IMPORT WATCH LIST FROM FILE) 82 

นําออก WATCHLIST ไปยังไฟล (EXPORT WATCHLIST TO FILE) 83 

จะ นําเขา watch list จากฐานขอมูลภายนอก หรือ จะนําออก watch list 

ไปสูฐานขอมูลภายนอกไดอยางไร (How to import/export watch list from/to external database)

84 

การนําเขา Family จาก Fasttrack (IMPORT FAMILY FROM FASTTRACK) 84 

การนําออก Family ไปยัง Fasttrack (EXPORT WATCHLIST TO FASTTRACK FAMILY) 86 

ทําความเขาใจวา AFL นั้นทํางานอยางไร 87 

บทนํา (Introduction) 87 

อารเรย คือ อะไร? (What is an Array? ) 88 

การทํางานของอารเรย - ทําไม AFL ถึงทํางานไดรวดเร็วมากนัก(Processing arrays - why is AFL so 

fast?) 88 

Moving averages เงื่อนไขของคําส่ัง (Moving averages, conditional statements) 89 

ลองเพิ่มความซับซอนเขาไปอีกหนอย (Getting little bit more complex) 90 

IIF(condition, truepart, falsepart) ฟงกชัน 92 

AMA( array, factor) ฟงกชัน 92 

การสรางลูปใหม (New looping) 93 

สรางอินดิเคเตอรดวยตัวคุณเอง 94 

การใชปรับใช styles, colors, titles และ parameters ในกราฟ   Indicator 100 

Plot() function 100 

การกําหนดคาของสี (Color Constants) 101 

การกําหนดรูปแบบของกราฟ (Style) (Style Constants) 104 

X-shift feature 107 

PlotForeign() function 107 
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การพล็อตกราฟหลายๆอันดวยสเกลท่ีตางกัน (Multiple plots using different scaling) 108 

การใชการกําหนดพารามิเตอรดวยตนเอง (Using custom defined parameters) 110 

การพล็อตขอความตัวหนังสือลงบนกราฟ (Plotting texts at arbitrary positions on the chart) 111 

การใสสีแบบไลระดับลงบนพ้ืนหลัง (Gradient fill of the background) 112 

การไลระดับสีบนพื้นที่ของกราฟ (Gradient fill area charts) 113 

การทําใหกราฟมีความหนา (Super thick charts) 115 

จิปาถะ (Miscellaneous) 115 

คุณจะสรางตัว Exploration ดวยตัวเองไดอยางไร 118 

กราฟ Scatter (X-Y) พล็อต ใน Exploration (Scatter (X-Y) charts in Exploration) 122 

เคล็ดลับสงทาย (Final tip) 125 

วิธีการเขียนคอมเมนทบนชารท 125 

การเขียนอักษรธรรมดา (Writing static texts) 126 

สีและไสตล (Colors and styles) 127 

ขอความที่แปรไปตามการประมวลผล (Dynamic content) 127 

เงื่อนไขตางๆของผลลัพธท่ีมีลักษณะเปนตัวหนังสือ (Conditional text output) 129 

การใชงานเครื่องมือวาดบนสตร AFL 132 

การวาดเสนเทรนดไลน (Drawing trend line) 132 

กําหนด Study ID (Define study ID) 132 

การเขียนโคดเพื่อระบุการเบรคของเสนเทรนดไลน (Write the formula that checks trend line  

break) 134 

การ Backtest ไอเดียการเทรดของคุณ 135 

เกริ่นนํา (Introduction) 135 

การเขียนกฎการลงทุน (Writing your trading rules) 135 

การ Back Test (Back testing) 136 

การวิเคราะหผลลัพธ (Analysing results) 136 

การเปลี่ยน Setting (Changing your back testing settings) 137 
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คําสั่ง Default (Reserved variable names) 137 

คอนเซประดับสูง (Advanced concepts ) 139 

การชอรท (Short trade support) 139 

การกําหนดราคาซื้อ (Controlling trade price) 140 

การตั้ง Stop (Profit target stops) 143 

"Exit at stop" 143 

Trailing stops 144 

Dynamic stops 145 

การเขียนโคดสรางจุด Stop (Coding your own custom stop types) 146 

Position sizing 147 

จํานวนหนวยการลงทุน และ การเคล่ือนไหวของราคา (Round lot size and tick size) 149 

Round lot size 149 

Tick size 149 

บัญชี Margin (Margin account) 150 

Setting อื่นๆ (Additional settings) 150 

Portfolio-level backtesting 152 

ขั้นตอนการติดตั้ง (HOW TO SET IT UP ?) 152 

การตั้งจํานวน position สูงสุดในการเทรดหนึ่งคร้ัง (SETTING UP MAXIMUM NUMBER OF 

SIMULTANEOUSLY OPEN TRADES) 152 

การตั้งขนาดการเทรดตอหนึ่งการเทรด (SETTING UP POSITION SIZE) 153 

การใช Position Score (USING POSITION SCORE) 154 

BACKTEST MODES 155 

ROTATIONAL TRADING 158 

HOLDMINBARS และ EARLY EXIT FEES (HOLDMINBARS AND EARLY EXIT FEES) 158 

การแกไขปญหาการเขาซื้อพรอมๆกัน (RESOLVING SAME BAR, SAME SYMBOL SIGNAL 

CONFLICTS) 161 

กรณี 1. Only one signal per symbol is taken at any bar ( 1 Bar 1 Signal) 162 
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กรณีที่ 2 สัญญาณในการเขา และ สัญญาณในการออกเกิดข้ึนพรอมๆกัน (Both entry and exit 

signals are used and entry signal precedes exit signal) 163 

กรณีที่ 3. สัญญษณทั้งสองเกิดข้ึนพรอมๆกัน แตสัญญษณในการเขามาทีหลังสัญญาณในการออก 

(Both signals are used and entry signal comes after exit signal) 164 

ใชงานในรูปแบบของพอรต (How does it work in portfolio case?) 165 

กลยุทธแบบ market-neutral, long-short balanced strategies (Support for market-neutral, 

long-short balanced strategies) 165 

SeparateLongShortRank backtester option 166 

การอานผลการ Backtest 168 

Exposure % 169 

Net Risk Adjusted Return % 169 

Annual Return % 169 

Risk Adjusted Return % 169 

Avg. Profit/Loss 169 

Avg. Profit/Loss % 170 

Avg. Bars Held 170 

Max. trade drawdown 170 

Max. trade % drawdown 170 

Max. system drawdown 170 

Max. system % drawdown 170 

Recovery Factor 170 

CAR/MaxDD 170 

RAR/MaxDD 171 

Profit Factor 171 

Payoff Ratio 171 

Standard Error 171 

Risk-Reward Ratio 171 
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Ulcer Index 171 

Ulcer Performance Index 171 

Sharpe Ratio of trades 171 

K-Ratio 172 

การใสสีเขาไปในผลการ backtest  (ใหมในเวอรช่ัน 5.60) (Color-coding in the backtest report)172 

วิธีการ Optimize 173 

เกริ่นนํา (Introduction) 174 

โคด AFL formula (Writing AFL formula) 174 

แสดงผล optimization แบบสามมิติ (Displaying 3D animated optimization charts) 177 

การควบคุมกราฟสามมิติ (3D chart viewer controls) 179 

โหมด Smart (non-exhaustive) optimization (Smart (non-exhaustive) optimization) 180 

เกริ่นนํา (Introduction) 180 

Quick Start 180 

ขั้นตอนเปนอยางไร (How does it work ? ) 181 

SPSO - Standard Particle Swarm Optimizer 183 

TRIBES - Adaptive Parameter-less Particle Swarm Optimizer 184 

CMA-ES - Covariance Matrix Adaptation Evolutionary Strategy optimizer 185 

Multi-threaded individual optimization 187 

Walk-forward testing 189 

การสรางเสน IN-SAMPLE และ OUT-OF-SAMPLE (IN-SAMPLE and OUT-OF-SAMPLE combined 

equity) 193 

บันทึกสรุปผลลัพธโดยรวมจากขอมูล OUT-OF-SAMPLE (ใหมสําหรับเวอรช่ัน 5.60) (OUT-OF-SAMPLE 

summary report (new in 5.60)) 194 

การจําลองดวยวิธี Monte Carlo 196 

บทนํา (Introduction) 196 

แลวมันทํางานอยางไรบน AmiBroker? (How does it work in AmiBroker?) 197 

การตั้งคา (Settings) 198 
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Enable Monte Carlo simulation 199 

Number of runs 199 

Position sizing 199 

Enable MC equity curves (Min/Max/Avg) 200 

การอานและตีความผลลัพธจากการทดสอบแบบ Monte Carlo (Interpreting the results) 201 

จะควบคุมมัน จากการใสสูตร/โคด (formula) ไดอยางไร? (How to control it from the formula 

level?) 204 

จะเพิ่มตัวบงชี้ที่กําหนดขึ้นเองในการทํา Monte Carlo ใน backtest Report ไดอยางไร? (How to add 

custom metric based on MC test distribution(s) to the backtest report ?) 205 

จะใชการสุมแบบ Monte Carlo แทนการใชการทดสอบแบบ bootstrap ไดอยางไร? (How about 

Monte Carlo randomization instead of bootstrap test?) 207 

Pyramiding (scaling in/out) และ การปรับใชอัตรตราแลกเปลี่ยนคาเงินในการ backtest 

พอรทการลงทุน 209 

Pyramiding / Scaling 209 

ตัวอยาง อยางงาย (Easy examples) 211 

ตัวอยางที่ 1: dollar-cost averaging (แตละเดือนซื้อหุนดวยจํานวนเงินท่ีเทาๆกัน) (Example 1: 

dollar-cost averaging (each month you buy stocks for fixed dollar amount)) 211 

ตัวอยางที่ 2: dollar-cost averaging (เปนโคดอยางงาย เนื่องจาก amibroker 

ถือวาหากมีสัญญาณคร้ังแรกใหซื้ออยูแลว) (Example 2: dollar-cost averaging (simplified 

formula because AB treats first sigScaleIn as buy anyway)) 211 

ตัวอยางที่ 3: เพิ่มขนาดของ position เมื่อเทรดแลวไดกําไร โดยปราศจากการทํา Pyramiding 

เพิ่มขนาดเมื่อกําไรมากกวา 5% และลดขนาดเมื่อ ขาดทุนมากกวา -5% (Example 3: increasing 

position when profit generated by trade without pyramiding becomes greater than 

5% and decreasing position when loss is greater than -5%) 212 

ตัวอยางที่ 4: การออกบางสวน (scaling out) เมื่อถึงเปากําไรท่ีเรากําหนด (Example 4: partial 

exit (scaling out) on profit target stops) 213 

Mulitple Currency Support 215 

การเขียนโคดเพื่อตั้งการแจงเตือน 217 
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บทนํา(Introduction) 217 

การตั้งคาตางๆ (Settings) 217 

ฟงกชัน AlertIF (AlertIF function) 219 

หมายเหตุ (Notes) 221 

การเปดใชหนาตางการตีความ 223 

การสนับสนุนการใช Multiple Time Frame ดวย AFL 225 

มันทํางานไดอยางไร ? (How does it work internally ?) 231 

ฟงกชั่นการจัดอันดับ 235 

StaticVarGenerateRanks ฟงกชัน (StaticVarGenerateRanks function) 237 

จะสามารถใช StaticVarGenerateRanks ใน Analysis window ไดอยางไร (How to use 

StaticVarGenerateRanks in Analysis window) 242 

คียลัดในโคด AFL 244 

การกําหนดคียลัดของตัวคุณเอง (DEFINING YOUR OWN SNIPPETS) 245 

TECHNICAL INFO (สําหรับผูใชข้ันสูง) (TECHNICAL INFO (advanced users only)) 248 

คูมือการใชงานแบบวิดีโอ (on-line) 250 
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วิธีการใชงานคูมือฉบับแปลไทย 
 

การทําความเขาใจตัวอยาง Coding ในคูมือ  

เพื่อใหผูอานมีความเขาใจมากข้ึน ผูแปลแนะนําในผูอานลองนําโคดในคูมือ ไปลองเขียนใสไวใน 

โปรแกรม Amibroker แลวของรัน หรือ ลองใหมันแสดงผลดูนะครับ 

 

วิธีการ เชื่อมโยง/อางอิง เนื้อหาในคูมือฉบับนี้ กับตัวตนฉบับ 

ในแตละหัวขอไมวาจะเปนหัวขอใหญ หรือ หัวขอยอย ทางผูแปลไดทําการแนบช่ือภาษาอังกฤษ 

ของหัวขอนั้นๆเพื่อใหผูอานมีความสะดวกสบายในการใชงานเรียบรอยแลวครับ วิธีใชงายๆดังน้ี 

 

หัวขอใหญ หนาตาจะเปนแบบน้ีครับ : 

 

ชื่อหัวขอใหญนั้นๆ  

(ตามดวยวงเล็บสีนํ้าเงินที่เปนชื่อภาษาอังกฤษของหัวขอนั้นๆ) 
 

ผูใชสามารถที่จะนําชือในวงเล็บสีนํ้าเงิน + คําวา Amibroker ไปคนหาใน google ไดเลยครับ เชน 

หากผูอานตองการเชื่อมโยงหัวขอ “การทํางานพ้ืนฐาน” ก็ใหผูอานใช Keyword น้ีในการคนหาใน google 

ครับ สยามควอนท 

 

Basic operations Amibroker  
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จากใจทีมงาน SiamQuant 

คูมือการใชงานเบื้องตน Amibroker ฉบับนี้ เกิดข้ึนดวยความประสงคท่ีตองการจะรวมถวายเปน    

พระราชกุศลเนื่องในโอกาสวันคลายวันพระบรมราชสมภพ พระบาทสมเด็จพระปรมินทรมหาภูมิพลอดุลยเดช  

ปที่ ๘๙ วันที่ ๕ ธันวาคม ๒๕๕๙ โดยมีจุดมุงหมายใหเปนแหลงความรูในการใชโปรแกรม Amibroker        

ใหกับนักลงทุนไทยทุกๆคน 

 

พวกเราหวังเปนอยางยิ่งวาคูมือการใชงาน Amibroker ฉบับนี้จะเปนประโยชนแกเพ่ือนๆนักลงทุนท่ีมี   

ความสนใจในการลงทุนอยางเปนระบบเชิง Quantitative and Systematic Trading ไมมากก็นอย โดยหาก       

คูมือเลมนี้มีขอผิดพลาดประการใด พวกเราตองขออภัยเพ่ือนๆนักลงทุนทุกทานไว ณ ท่ีน้ีดวย 

 

โดยหากวาทานมีขอสงสัยหรือขอแนะนําประการใดเกี่ยวกับคูมือฉบับน้ี กรุณาสอบถามพูดคุยกับพวก 

เราไดที่กลอง Comment ดานลางของ  www.siamquant.com/thai-amibroker-manu​l ตามอัธยาศัยครับ 

 

แหลงที่มา 

คูมือการใชงานเบื้องตน Amibroker ฉบับภาษาไทยนี้แปลจาก 

https://www.amibroker.com/bin/UsersGuide.pdf​ (ไฟล PDF) 

http://www.amibroker.com/guide/tutorial.html​ (ไฟล Online) 

โดยคุณ มด แมงเมาคลับ ( www.mangmaoclub.com​)  ไดรับอณุญาตอยางถูกตองจากคุณ Tomasz  

Janeczko เรียบรอยแลว 
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การทํางานพ้ืนฐาน 

(Basic operations) 

 

เพิ่มชื่อหลักทรัพยใหม (Adding a new symbol) 

 

ในการที่จะเพิ่มชื่อหลักทรัพยใหมเขาไปในฐานขอมูล ใหคุณเขาไปท่ี ​Symbol > New​ หรือ คลิกปุม       

Add symbol ในแถบ Toolbar หลังจากท่ีทําตามข้ันตอนขางตนแลว คุณจะไดรับการแจงวามีช่ือหลักทรัพย      

ใหมเพิ่มเขามา โดยที่ความยาวสูงสุดของตัวอักษรนั้น จะอยูท่ี 48 ตัวอักษร ตัวอักษรท่ีเหมาะสมสําหรับการนํา      

เขาขอมูลนั้นจะตองเปนตัวพิมพใหญ SiamสยามควอนทQuant 
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ลบชื่อหลักทรัพย (Removing a symbol) 

 

สําหรับการลบชื่อหลักทรัพยท่ีมีอยูในฐานขอมูลนั้นใหเขาไปท่ี ​Symbol > Remove​ ในแถบเมนู     

หรือจะคลิกที่ปุม Remove Symbol ในแถบ Toolbar ก็ได เมื่อกดแลวจะมีการถามเพ่ือยืนยันอีกคร้ังวา       

ตองการจะลบหรือไม (โปรดจําไววาข้ันตอนนี้ไมสามารถยอนกลับได !) การลบหลายๆ ช่ือหลักทรัพยพรอมกัน     

สามารถทําได โดยใช Assignment Organizer 

 

แตกหุน(Splitting a stock) 

 

ในการที่จะแตกหุน สามารถเขาไปไดท่ีเมนู ​Symbol > Split​ หรือ กดท่ีปุม Split ในแถบ Toolbar          

ก็ได Amibroker ไดนําเสนอวิธีการท่ีงาย ในการท่ีจะแตกหุนเองได โดยโปรแกรมจะพยายามคาดเดาวันท่ี     

แตกหุน และ คาดคะเนอัตราสวนตางๆ โดยการวิเคราะหจํานวนหุน หากมีเพียงแคหุนเดียวหลังจากแตกหุน     

แสดงวามันไดผล แตถาไมได คุณควรคนหาวันท่ีแตกหุน และ สัดสวนในการแตกหุนในคร้ังน้ันๆ (จากผูแปล :       

แตถาคุณใช Data จากทาง Siamquant คุณก็ไมจําเปนตองกังวลเกี่ยวกับเร่ืองน้ี) โปรดจําไววาข้ันตอนน้ีไม      

สามารถยอนกลับได ! 

 

แตเวอรชั่น 2.0 ขึ้นไป ฟงกช่ันการแตกหุนสามารถทําไดมากกวานั้น คุณสามารถใชสัดสวนแบบเกา     

หรือ คุณสามารถระบุการแตกหุนแบบเฉพาะเจาะจงไดดวยคําส่ังนี ้

 

x->y 

 

คําสั่งนี้หมายความวา หุนจํานวน x หุนกอนแตกหุน เปล่ียนมาเปน y หุนในเวลาตอมา ยกตัวอยางเชน        

2->3 ก็หมายความวา จาก 2 หุนเปน 3 หุน ดังนั้นถาตองการแตกหุนเปน 5 หุน ก็ใชคําส่ัง 1->5 

 

คุณนาจะพอเดาไดวาการแตกหุนสามารถยอนกลับได เชน การใช 2->1 ดวยคําส่ังน้ีแปลวาหุน 2 หุน       

จะถูกรวมเขาดวยกันเปนหุนเดียว 
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ลบจํานวนหุน (Deleting quotation) 

 

การที่จะลบจํานวนหุนนั้นสามารถทําไดงายๆ ดวยการเลือกช่ือหุนท่ีคุณตองการโดยคลิกท่ีชารทหุน 

(เสนแนวตั้งที่จะปรากฏขึ้นเมื่อเลือกวันท่ีหรือหุน) จากนั้นเลือก  Edit > Delete  

 

สําหรับการลบจํานวนหุนจากหุนทุกตัวภายในระยะเวลาท่ีกําหนดคุณตองเลือก ​Edit > Delete    

session 

 

และ ใช Quote Editor สําหรับลบหุน 

 

เพิ่ม/ลด ชื่อหลักทรัพยจากรายการโปรด (Adding/removing symbol from favourites) 

 

สําหรับการเพิ่มสัญลักษณเขาไปในรายการโปรด คุณตองติ๊กเลือกชอง Favourite ในหนาตาง    

Information สวนการลบมันออกจากรายการโปรด ก็เพียงแคเอาเคร่ืองหมายต๊ิกถูกออกไป หรือ อีกทางเลือก     

คือ คุณสามารถคลิกขวาที่แถบเมนูได และ เลือก “Add to favourites” และ “Remove from favourites”           

ตามที่คุณตองการ 

 

รวมจํานวนหุนจาก หลักทรัพย 2 ตัว (Merging quotations of two symbols) 

 

มันเปนไปไดที่บางคร้ัง Ticker ของหลักทรัพยอาจจะเปล่ียนไปเมื่อคุณมี Ticker 2 ตัว ในฐานขอมูล       

เดียวกัน ตัวหนึ่งอยูในราคาเกาและอีกตัวอยูในราคาอันใหม (หลังจากท่ีเปล่ียนช่ือแลว) เพ่ือท่ีจะเอาราคา    

ทั้งหมดใสไวใน Ticker ตัวเดียว คุณจําเปนตองใชคําส่ัง Symbol > Merge คุณจําเปนตองเลือกเฉพาะ Ticker         

ตัวใหมเทานั้น (หลังจากที่เปล่ียนช่ือแลว) และ เลือก Symbol > Merge เมื่อเสร็จแลวคุณจะตองเลือก Ticker         

อันเกา (“merge with”) และเลือกตรวจสอบรายการตอไปนี ้

 

- ทําซํ้าและเขียนทับ - การเลือกรายการนี้จะมีการเขียนทับราคาท่ีอยูใน Ticker อันใหมดวยการแสดง 

ผลเปน Ticker ตัวเกา (ตามจริงแลวไมควรเปนแบบนี้ แตก็มีโอกาสเกิดได) 
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- ลบหลังจากใช Merge with - เมื่อเลือกรายการนี้จะเปนการลบ Ticker ตัวเกาหลังจากรวมเขาดวย 

กันแลว 

- ตั้งชื่อเปนนามแฝง - ตัวเลือกนี้จะทําการคัดลอก Ticker ตัวเกาเปนช่ือแฝง และจะกลายเปน Ticker 

ตัวใหม 

 

 

 

 

 

 

 

คูมือการใชชารทเบื้องตน 

(Beginners' charting guide) 

 

เกริ่นนํา ( Introduction) 

 

เครื่องมือชารทของ Amibroker นั้นจะมีเคร่ืองมือดานการวาดตางๆมากมาย พรอมท้ังคุณสามารถ 

ยาย, ยอหรือขยาย, ตัด, คัดลอก, วาง และ ลบวัตถุไดโดยงาย บทความนี้จะแนะนําคุณ ถึงเคร่ืองมือท่ีสําคัญ 

ตางๆ สําหรับการใชงาน สยามควอนท 
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เรามาดูกันที่ User Interface กันกอนดีกวา

 

  

อยางที่คุณเห็น ตรงกลางจะเปนพ้ืนท่ีของชารท ซึ่งเปนชารทของราคาประกอบกับเสนคาเฉล่ีย และ    

Bollinger Band (คุณสามารถควบคุมการแสดงผลของชารทไดจาก Tools > Preferences) 

 

ดานลางของชารท คุณจะเห็นแกน X ท่ีเปนแกนของเวลา(วันท่ี) และ ดานใตจะเปน Scroll Bar        

ซึ่งคุณสามารถที่จะเลื่อน Scroll Bar เพ่ือดูราคายอนหลังได ในขณะท่ีแท็บของชีทๆ ใชเพ่ือดูชารทท่ีแตกตาง      

กันในแตละหนา (ขึ้นอยูกับวาคุณปรับแตงชีทตางๆของคุณอยางไร) 

 

ดานขวา คุณจะเห็นแกน Y ท่ีแสดงถึงระดับของราคา โดยท่ีราคาลาสุดน้ันจะมีการเติมสีไว     

(ถาในตัวอยางจะเห็นเปนแถบสีดํา) เพ่ือใหมองเห็นไดอยางเดนชัด บริเวณแกน Y น้ันยังสามารถใชเพ่ือยอ หรือ      

ขยายชารทในแนวตั้งไดดวย 
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ถัดมาอีกทางขวามือจะเปนเคร่ืองมือท่ีใชในการวาด ซึ่งคุณสามารถเลือกไดวาจะใชเคร่ืองมือตัวไหน (มี   

แตเครื่องมือยอดนิยมเทานั้นท่ีจะโชวในแถบเมนูดานขวานี้ ถาตองการดูเคร่ืองมือท้ังหมดใหเลือกท่ีเมนู Insert)  

 

“Select” (ลูกศรสีแดง) ใชเพ่ือเลือก, ยาย, ยอหรือ ขยาย วัตถุท่ีวาดไวเรียบรอยแลว หรือ        

ไวเลือกแทงราคาในชารท 

 

ในสวนของแถบดานบนคุณจะเห็นแถบเมนูการจัดรูปแบบท่ีใชเพ่ือใหคุณสามารถปรับสี, สไตล (เชน   

แบบหนา/แบบจุด) และ โหมด (snap to price หรือการวาดรูปโดยท่ีใหปลายจุดเขากับราคาไดอยางงาย) ได 

 

จากในภาพ คุณจะเห็นไดเลยวาการตีเสนเทรนดไลนนั้น ทําไดโดยการลากจากจุดท่ีคุณตองการไปสู   

อีกจุดหนึ่ง การควบคุมเครื่องมือวาดเหลือนี้ ทําไดโดยการลาก หรือ การยอขนาด ซ่ึงเราจะอธิบายตอจากน้ี 

การทํางานพื้นฐาน ( Basic operations) 

การเลื่อน (Scrolling) 

การเลื่อนชารทไปขางหนา/ขางหลัง เพียงแคเล่ือนปุม Scroll Bar หรือใชปุมท่ีเปนลูกศร “<” และ       

“>” ซึ่งอยูดานซายและขวาของ Scroll Bar โปรดทราบวาการใช “< >” จะเปนการเล่ือนชารททีละหน่ึงแทง        

และการเลื่อนชารทสามารถทําไดดวยการใชปุม Wheel ท่ีอยูบนเมาส  

การซูม (Zooming) 

สําหรับการขยายชารท (เพ่ิมหรือลดแทงท่ีแสดงบนหนาจอ) คุณสามารถเขาไปท่ี View > Zoom      

หรือใชปุม Zoom ที่อยูแถบเมนู Tool Bar หรือจะใชปุม Wheel ท่ีอยูบนเมาสก็ได (ท่ีเปน icon สีเหลือง และ            

สีเขียวมีลักษณะเปนวงกลม) 

 

คุณยังสามารถซูมไดโดยการลากขอบซายหรือขอบขวาของแทง Scroll Bar ถาทําตามน้ี การขยาย     

ชารทจะเปนการลดจํานวนแทงท่ีแสดงผลบนหนาจอ, แตถายอชารท จะเปนการเพ่ิมจํานวนแทงท่ีแสดงผล,   

การขยายภาพทั้งหมด (Zoom-all)จะปรากฎแทงท้ังหมดตามท่ีมีขอมูล, ขยายแบบธรรมดา (Zoom-normal)    

จะรีเซ็ตใหแสดงผลของแทงขอมูลตามท่ีไดตั้งคาไวใน Tools > Preferences > Charting การซูมเขา และ        

ออกนั้นสามารถทําไดโดยตรงผานการกดปุมในแถบ Tool Bar (ดูตัวอยางไดจากรูปดานลาง) สวนการซูมดวย     
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wheel ของเมาสนั้นจะตองกดปุม CTRL คางไวดวยถึงจะทําได คุณยังสามารถซูมไดดวยการเลือกชวงท่ีตอง     

การบนชารท (จะกลาวถึงภายหลังในหัวขอ Marking Range) 

ยอ, ขยาย และขยับสเกลของแกน Y (Shrinking, expanding and moving Y-axis 

scale) 

การที่จะ ​ขยับ ​สเกลของแกน Y ทําไดดวยการนําเมาสไปวางบริเวณแกน Y (พ้ืนท่ีสีฟาๆ ดังรูปภาพ        

ดานบนอันแรก) และ จากนั้นคุณจะเห็นวาลูกศรของเมาสมันไดเปล่ียนไปเปนลูกศรข้ึน และ ลงเรียบรอยแลว     

จากนั้นคุณก็เพียงแค คลิกและลากข้ึนลากลงตามท่ีตองการแลวปลอยในตําแหนงท่ีคุณตองการ 

 

ยอ / ขยาย ​แกน Y : กดปุม SHIFT คางไวและคลิกเมาสในบริเวณพ้ืนท่ีของแกน Y จากน้ันก็เล่ือน           

เมาสขึ้นลง และปลอย เมื่อคุณทําการเล่ือนเสร็จเรียบรอย 

 

สวนการ  Reset ​สเกลของแกน Y ทําไดงายๆ เพียงแคดับเบิ้ลคลิกบริเวณพ้ืนท่ีแกน Y เทาน้ันเอง 

เปลี่ยนไทมเฟรมของแทง (Changing bar interval (periodicity)) 

คุณสามารถสลับไทมเฟรมอยาง Daily / Weekly / Monthly และ Intraday ไดงายๆ ดวยการ          

เลือกไทมเฟรมที่ตองการจากในเมนู View (ดูตัวอยางไดดานลาง) 
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ใน Toolbar จะใชเคร่ืองหมายตามรูปภาพแทนท่ีไทมเฟรมแตละแบบ i - intraday, h - hourly, d -           

daily, w - weekly, m - monthly ตัว i นั้นเปนตัวแทนของ Intraday ตาม “ฐานขอมูล” ท่ีถูกอางอิงไวใน              

File > Database Settings กราฟไทมเฟรม Intraday จะยังคงมีอยูในเมนู View > Intraday อีกดวย 

 

การตั้งคาไทมเฟรมนั้นจะมีผลตอหนาตางปจจุบันเทานั้น ดังนั้นแตละหนาตางสามารถใชไทมเฟรมท่ี  

แตกตางกันได สยามควอนท 

 

หมายเหตุ : กราฟ Intraday นั้นจะไมสามารถใชไดหากฐานขอมูลของคุณเปนแบบ End-of-Day โหมด       

Intraday จะใชไดเฉพาะฐานขอมูลซึ่งมี “Base Time Interval” ท่ีอยูใน File > Database Settings ซ่ึงจะ           

ถูกตั้งคาไวดวยขอมูลที่เปนภาพเล็กกวา End-of-Day ตัวอยางเชน ถา Base Time Interval ถูกต้ังคาไวท่ี 5         

นาที นั่นแปลชารททั้งหมดจะสามารถใชไดเฉาะไทมเฟรมท่ีมีขนาดใหญกวา 5 นาทีข้ึนไป 

 

ไทมเฟรมที่มีใหจะมีดังตอไปนี้ 

 

- Daily 

- Weekly 

- Monthly 

- Hourly (intraday) 

- 15-minute (intraday) 

- 1-minute (intraday) 

- 15-second (intraday RT only) 

- 5-second (intraday RT only) 

- Tick (intraday RT only) 

 

คุณสามารถกําหนดแทงแบบรายนาทีไดท้ังหมด 5 แบบท่ีคุณตองการวาตองการแทงละก่ีนาที และ ยัง     

สามารถปรับกราฟแบบ Intraday ตามท่ีคุณตองการไดอีก 5 แบบเชนกัน วาตองการแทงละก่ี Tick เพียงเขา        

ไปที่ Tools > Preferences > Intraday ตัวเลือกท่ีปรับแลวจะเห็นไดเฉพาะผานทางการเขา View >         

Intraday เทานั้น 
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Selecing a quote 

มันงายมากๆ ในการท่ีจะดูราคา หรือ คาของอินดิเคเตอร โดยการใชโหมด Select ข้ันแรก       

ใหยอนไปดูขอมูลในอดีต และเลือกโหมดเปน Select (ลูกศรสีแดงในแถบ Toolbar) จากน้ันคลิกพ้ืนท่ีบริเวณ      

ชารท (แตตองไมโดนวัตถุท่ีวาดเอาไว) เสนแนวตั้งจะโชวข้ึนมาตรงท่ีลูกศรเมาสวางอยู ซ่ึงตรงสวนหัวขอ    

ของชารทนั้นจะโชวขอมูลของแทงท่ีเราเลือก ในหนาตางอินดิเคเตอรก็จะโชวคาของมันในตําแหนงเดียวกัน  

การเลื่อนทีละแทงคุณสามารถทําไดท้ังเล่ือนไปขางหนาหรือขางหลัง ดวยการใชปุมท่ีเปนลูกศร “<” และ “>” 

 

เมื่อตองการจะเปลี่ยนโหมดการใชงาน คุณสามารถคลิกท่ีเสนแนวตั้งน้ันอีกที หรือคลิกท่ีแกนของวันท่ี   

ก็ได (มารกดวยจุดสีแดงในรูปภาพกอนหนา) หรือคลิกตรงพ้ืนท่ีวางดานขวา เม่ือทําดังน้ี จะเปนการปดโหมดน้ี     

และ คาที่แสดงอยูในสวนหัวของชารทจะเปนคาลาสุดของแทงขอมูลลาสุดแทน 

เลือกชวง ( Marking range​ ) 

สําหรับการโชวสวนท่ีตองการ เพียงแคกดดับเบิ้ลคลิกบริเวณชารทท่ีตองการใหเปนจุดเร่ิมตน และ   

ดับเบิ้ลคลิกอีกครั้งในจุดที่ตองการใหเปนจุดส้ินสุดของชวง หรือคุณสามารถใชปุม F12 ประกอบกับโหมด    

Select (ที่อธิบายอยูดานบน) เพียงแคเลือกแทงของขอมูลท่ีตองการและกด F12 เพ่ือเลือกจุดเร่ิมตน และ      

กดปุม SHIFT+F12 เพื่อเลือกเปนจุดส้ินสุด คุณสามารถลบการเลือกชวงท่ีทําไวดวยการกด CTRL+F12 หรือ      

ดับเบิ้ลคลิกในที่เดิมที่เรามารกไว 

 

การเลือกชวงนั้นสามารถใชเพ่ือซูมดูชวงท่ีเราเลือกได (View > Zoom > Range) และ ยังใชเพ่ือการ 

คํานวณคาที่เราเลือกดวยคําสั่ง BeginValue และ EndValue ในฟงกช่ันของ AFL ไดอีกดวย 

เพิ่ม / ปดหนาตางชารท ( Adding / closing chart panes​ ) 

ในแตละหนาจะประกอบดวยหนาตางหลายๆอัน ซึ่งแสดงชารทหรืออินดิเคเตอรท่ีตางกันไป ในการท่ี   

จะใสอินดิเคเตอรตัวใหมเขาไปในหนาตางของชารท ก็เพียงแคเลือกอินดิเคเตอรใน Chart list (ใชเมนู     

Window > Charts​) และดับเบิ้ลคลิกท่ีช่ือของอินดิเคเตอรท่ีตองการ สําหรับขอมูลเพ่ิมเติม สามารถดูไดใน      

สวนของ  การลากและวางชารท 
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สวนการจะปดหนาตางชารท ใหคลิกท่ีหนาตางนั้น จากนั้นเขา ​View > Pane > Close ​ผานเมนู         

หลัก หรือ คลิกที่หนาตางนั้นๆ ดวยคลิกขวา และเลือก  Close ​ก็ทําไดเชนกัน 

 

เชื่อมโยงและล็อคชารท ( Linking and locking chart​ ) 

ชารทหลายๆ หนาตาง (สามารถเปดไดโดย File > New > Default Chart หรือ File > New >              

Blank Chart) สามารถเชื่อมโยงกันได Symbol-Linked จะแทนดวยตัว s พิมพเล็ก และ Interval-Linked         

จะแทนดวยตัว i พิมพเล็ก และ ท้ังสองปุมนี้อยูทางดานซายของแถบ Scroll Bar (ดานลาง) เม่ือคุณคลิก         

ที่ปุมจะมีเมนูโชวขึ้นมาเปนสีๆ เลือกสีท่ีตองการในหนาตางแรก และอีกหนาตางหน่ึงก็ใหเลือกสีเดียวกัน การ    

เชื่อมโยงความหมายก็คือ ถาเราใช Symbol-Linked เมื่อเปล่ียนช่ือสัญลักษณในหนาตางชารทแรก ชารทท่ี     

สองก็จะเปลี่ยนชื่อตามดวย สวน Interval-Linked เมื่อคุณคลิกท่ีแทงขอมูลไหนในหนาตางแรก หนาตางท่ีสอง     

ก็จะคลิกที่แทงขอมูลเดียวกัน 

 

คุณสามารถปองกันไมใหสัญลักษณเปล่ียนช่ือไปตามอีกหนาตางท่ีเราเปล่ียนช่ือได ดวยการกดท่ีเคร่ือง  

หมายแมกุญแจอันเล็กๆ ที่ฝงซายของ Scroll Bar (เลือก Symbol Lock) เม่ือกดแลวช่ือสัญลักษณ        

ของชารทหนาตางนี้จะไมเปลี่ยนตามชารทอันแรก จนกวาคุณจะกดปุม Symbol Lock อีกคร้ัง  

 

การใชเครื่องมือวาด ( Using drawing tools​ ) 

 

Amibroker นั้นมีเครื่องมือในการวาดท่ีหลากหลายมาก ดังนี้ 
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- trend line  

- ray (ตั้งแตเวอรชั่น 4.20)  

- extended line (ตั้งแตเวอรช่ัน 4.20)  

- vertical line  

- horizontal line  

- parallel lines (ตั้งแตเวอรช่ัน 4.20)  

- Regression channels: Raff, standard deviation, standard error (ต้ังแตเวอรช่ัน 4.20)  

- Fibonacci Retracement study (ตั้งแตเวอรช่ัน 4.20)  

- Fibonacci Time zones study  

- Fibonacci Fan  

- Fibonacci arc  
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- Gann Square (ตั้งแตเวอรช่ัน 4.20)  

- Gann Fan (ตั้งแตเวอรช่ัน 4.20)  

- Ellipse tool  

- Arc tool  

- Rectangle  

- text box tool  

 

ทั้งหมดนี้จะปรากฎในเมนู Insert และเมนู Draw ใน Toolbar แตละวัตถุท่ีวาดแลวจะสามารถยาย, 

ปรับขนาด, คัดลอก, ลบและปรับไดหลังจากท่ีวาดแลว SiamQuant 

 

ในการวาดวัตถุบนชารท กอนอ่ืนคุณตองเลือกเคร่ืองมือท่ีตองการจะวาด และ เร่ิมวาดดวยการใชเมาส    

คลิกตรงจุดที่ตองการใหเริ่มตน คลิกซายคางไว ทันทีท่ีลากเมาส เคร่ืองมือท่ีเราเลือกจะปรากฏใหเห็น    

เมื่อตองการลากถึงตรงไหนก็ใหปลอยตรงจุดนั้น คุณสามารถยกเลิกการวาดไดดวยการกดปุม ESC 

 

ถาคุณลากเมาสไปบริเวณวัตถุท่ีคุณวาด คุณจะเห็นลูกศรเมาสเปล่ียนไปเปนรูปอ่ืน ซ่ึงความหมายของ   

รูปแตละแบบก็ คือ 

 

 

ถาลูกศรไปอยูใกลขอบของวัตถุ จะเปล่ียนเปนรูปนี้ เรียกวา Sizing Pointer เอาไวยอขยายวัตถุได 

 

 

ถาลูกศรไปอยูในบริเวณวัตถุ จะเปล่ียนเปนรูปนี้ เรียกวา Moving Pointer เอาไวเคล่ือนยายวัตถุได 

ทุกๆ วัตถุที่วาดจะสามารถ ยาย ปรับขนาด ลบ และคัดลอกได 
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การเลือกวัตถุใดๆ นั้นสามารถทําไดงายๆ โดยเพียงแคใชเมาสเล่ือนไปบนวัตถุ เม่ือ Moving Pointer      

ปรากฏขึ้นใหคลิกหนึ่งครั้ง วัตถุนี้นั้นก็จะถูกเลือก และ ปุมท่ีใชสําหรับปรับขนาดก็จะปรากฏข้ึนมาดวย    

(ลักษณะเปนปุมสีเหลี่ยมเล็กๆ) 

 

สวนวิธียกเลิกการเลือกวัตถุนั้น ก็เพียงคลิกท่ีพ้ืนท่ีวางของชารท 

 

การยายวัตถุก็ใหคลิกเลือกสวนใดก็ไดของวัตถุนั้น กดคางไว แลวยายไปในจุดท่ีตองการ 

 

การลบวัตถุ  ใหเลือกวัตถุท่ีตองการแลวกดปุม DEL ท่ีอยูบนคียบอรดหรือใช Edit > Delete ในเมนู 

หรือจะใชปุม Delete ที่อยูใน Toolbar ก็ได 

 

การคัดลอกวัตถุ เลือกวัตถุท่ีตองการแลวกด Ctrl+C หรือใช Edit > Copy หรือใชปุม Copy ใน          

Toolbar 

 

การตัดวัตถุ เชนเคยใหเลือกวัตถุท่ีตองการจะตัด แลวกด Ctrl+X หรือใชเมนู Edit > Cut หรือใชปุม         

Cut ใน Toolbar 

 

การวางวัตถุ ทําไดโดยการกด Ctrl+V หรือใชเมนู Edit > Paste หรือ จะใชปุมวางใน Toolbar ก็ได           

เมื่อวางวัตถุแลว วัตถุชิ้นใหมจะวางทับช้ินเกาอยางพอดิบพอดี และ ถูกเลือกไวโดยอัตโนมัติ ดังน้ัน คุณจึง      

สามารถยายวัตถุชิ้นใหมไปตรงไหนก็ได 
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การนําสีหรือรูปแบบไปใช ​กับวัตถุทีเราเลือกไว สามารถทําไดผานเมนู Format หรือใชปุม Format      

ใน Toolbar เพื่อเปลี่ยนสี, ความหนา, จุดหรือปรับสไตลของขอมูลราคาได เพ่ิมเติมก็คือคุณสามารถเลือกสี      

หรือ สไตลกอนที่จะวาดวัตถุชิ้นใหม 

 

การปรับแตงคุณสมบัติ ​ของวัตถุช้ินใดๆ คุณสามารถใชวิธีดับเบิ้ลคลิกหรือใชเมนู ​Edit >     

Properties ​หรือ ใชปุม  Alt+ENTER ​ก็ได 

 

การลบทั้งหมด  ทําไดดวยการกดเมนู  Edit > Delete All 

 

ขอมูลเพิ่มเติม 

 

ถาอยากรูรายละเอียดเพ่ิมเติมเกี่ยวกับเคร่ืองมือการวาด โปรดอานในบทของ Drawing tools 

reference 

 

 

วิธีใชงานการลากและวางชารท(Indicator) 

(How to use drag-and-drop charting interface) 
 

เกริ่นนํา (Introduction) 

 

Amibroker ใหคุณสามารถสรางและปรับอินดิเคเตอรโดยเพียงแคการคลิกเมาสไมก่ีคร้ัง ในตอนน้ีคุณ   

สามารถสรางอินดิเคเตอรที่ซับซอนไดโดยไมตองมีความรูเร่ืองการโปรแกรมมิ่งเลย ซ่ึงอินดิเคเตอรท้ังหมดท่ี  

พรอมใชงานจะถูกบันทึกไวในแท็บ Charts ท่ีอยูในสวนของหนาตาง Workspace 
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วิดีโอสาธิตการใชงานจะอยูในลิงคนี้ http://www.amibroker.net/video/dragdrop1.html ท่ีจะ   

สอนเกี่ยวกับการใชงานเบื้องตนของฟงกช่ันลากและวาง 

 

จะใสอินดิเคเตอรใหมไดอยางไร (How to insert a new indicator) 

 

การที่จะใสอินดิเคเตอรตัวใหมแยกอีกหนาตาง สามารถทําไดโดยการเลือกอินดิเคเตอรในแท็บ Chart   

(ใช Window > Charts) และ ดับเบิ้ลคลิกท่ีช่ือของอินดิเคเตอรนั้นๆ 

 

 

 

หรือ อีกทางเลือกหน่ึง คุณสามารถคลิกขวาแลวเลือก Insert จากเมนูท่ีปรากฏข้ึนมาก็ได เม่ือทําแลว      

อินดิเคเตอรหนาตางใหมจะถูกสรางข้ึนมา และ คาตางๆก็จะแสดงข้ึนมาดวย คุณสามารถปรับคาของ    

อินดิเคเตอรไดเชนกัน (เชน สีหรือระยะเวลาท่ีใชคํานวณ) เมื่อปรับแตงเปนท่ีเรียบรอยแลวใหกด OK (คุณจะ      

เจอรายละเอียดเพิ่มเติมเกี่ยวกับหนาตางพารามิเตอรไดท่ีดานลาง) 

 

ตัวอยาง: สมมติตองการเพ่ิมหนาตาง RSI เขาไป ใหหาช่ืออินดิเคเตอร RSI จากในลิสต ดับเบิ้ลคลิกท่ี        

ชื่อ เลือกระยะเวลาที่ตองการใหคํานวณและเลือกสี จากนั้นกดโอเค เปนอันเสร็จ 
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จะทํายังไงใหอินดิเคเตอรอันนึงวางซอนบนอีกอันนึงได (How to overlay one indicator 

on another indicator)​สยามควอนท 

 

ในการที่จะวางอินดิเคเตอรซอนกัน ใหกดคลิกซายคางไวบนช่ืออินดิเคเตอรท่ีเราตองการ แลวลาก   

มันมาใสในหนาตางอินดิเคเตอรอีกอัน จากนั้นก็ปลอย 

 

ตัวอยาง: จากตัวอยางเดิม เราตองการใส RSI เขาไปอีกเสน (ดวยระยะเวลาท่ีตางจากเดิม) ไวในหนา       

ตางอันแรก สิ่งที่ตองทําก็คือลากช่ือ RSI เขาไปใสในหนาตางท่ีเราสรางกอนหนาน้ี เปล่ียนระยะเวลาท่ีใช     

คํานวณในหนาตางพารามิเตอร แลวกด OK หรือ อีกทางเลือกคือ คลิกขวาท่ีช่ืออินดิเคเตอรน้ัน แลวเลือก       

Overlay 

 

จะลบอินดิเคเตอรอยางไร (How to delete the indicator) 

 

เมื่อตองการเอาอินดิเคเตอรออก ใหกดปุม ปด จากเมนูท่ีอยูตรงมุมขวาบนของหนาตางอินดิเคเตอร    

นั้น (เมนูจะปรากฏขึ้นเมื่อคุณวางเมาสไวบริเวณนั้น) เมนูนี้จะยอมใหยายหนาตางข้ึน ลง หรือขยายใหใหญ     

สุดก็ได (เพื่อความเขาใจใหดูภาพดานลางประกอบ) 

 

 

 

คุณยังสามารถใชคําส่ังปดจากเมนูท่ีจะปรากฏข้ึนเมื่อคุณคลิกขวาท่ีหนาตางของชารทไดอีกดวย 
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จะลบอินดิเคเตอรในหนาตางนั้นออกไปอยางไร (How to remove the indicator plot 

from the pane) 

 

หากตองการลบอินดิเคเตอรตัวใดตัวหนึ่งออกจากหนาตางนั้น ใหคลิกขวาตรงท่ีช่ือของหนาตาง (ใกล   

กับบนสุดของหนาตางชารท) และเลือกอินดิเคเตอรท่ีคุณตองการจะลบ 

 

 

 

คุณยังสามารถลบอินดิเคเตอรไดดวยการเลือก Delete Indicator ในเมนูท่ีปรากฏข้ึนเม่ือคลิกขวาใน    

หนาตางชารท 
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จะเปลี่ยนคาพารามิเตอร สี และสไตลของอินดิเคเตอรอยางไร (How to change 

parameters/colors/styles of indicators) 

 

หนาตางพารามิเตอรนั้นสามารถเปล่ียนคาตางๆ รวมถึงสี และสไตลของอินดิเคเตอรของคุณได หนา    

ตางพารามิเตอรจะปรากฏขึ้นมาเมื่อคุณแทรกอินดิเคเตอรใหมเขาไป คุณยังสามารถเขาไปปรับแตงไดดวยการ  

คลิกขวาที่หนาตางชารทและเลือก Parameters จากเมนูท่ีเดงข้ึนมา หนาตางพารามิเตอรจะแสดงคาท้ังหมด    

ที่ประกอบอยูใน AFL โคด (ดังนั้นผูใชจึงสามารถปรับคาได) ถึงแมวาอินดิเคเตอรแตละตัวจะมีรายละเอียด     

ตางกัน แตสวนใหญแลวสิ่งที่คุณจะเห็นก็มีดังตอไปนี้ SiamQuant 

 

ฟลดราคา ​- คือขอมูลท่ีใชเพ่ือคํานวณในการสรางอินดิเคเตอร ถาฟลดราคาเปน Close แปลวา      

อินดิเคเตอรตัวนั้นจะใชการคํานวณจากราคาปด ฟลดราคาจะไมรองรับในทุกอินดิเคเตอร เน่ืองจากไมใชเคร่ือง   

มือทุกตัวที่จะยอมใหคุณเปลี่ยนฟลดราคาได (เชน ADLine) 

 

ระยะเวลา  - ใชระบุวาตองการใหระยะเวลาในการคํานวณเปนเทาไหร 

 

สี  - เอาไวระบุและเปล่ียนสีของอินดิเคเตอร  

 

สไตล ​- อนุญาตใหคุณเลือกสไตลของการแสดงผลได (รายละเอียดของสไตลแบบตางๆ จะอยูในสวน     

ของ วิธีการใชสไตลกราฟและสี) 

 

 

จะใสอินดิเคเตอรที่มีสเกลตางกันซอนกันไดอยางไร (How to overlay indicators with 

different scales) 

 

หากในหนึ่งหนาตางจะมีอินดิเคเตอรหลายตัวท่ีมีสเกลตางกัน ใหลากอินดิเคเตอรตัวท่ีสองไปยัง  

อินดิเคเตอรตัวแรก ในหนาตางพารามิเตอร ในสวนของ Style นั้นใหติ๊กถูกท่ีคําวา StyleOwnScale 
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ตัวอยาง: ลาก OBV (On Balance Volume) เขาไปใสในหนาตาง RSI เม่ือเราระบุใหมันแสดงผล         

แบบ StyleOwnScale ผลลัพธท่ีไดก็คืออินดิเคเตอรท่ีแสดงผลออกมาอยางถูกตอง 

 

 

จะสรางอินดิเคเตอรใหมโดยอางอิงบนอินดิเคเตอรอื่นอยางไร(How to create an 

indicator based on another indicator) 

 

AmiBroker สามารถใหคุณสรางอินดิเคเตอรท่ีอางอิงคาจากอินดิเคเตอรตัวอ่ืนไดโดยงาย ท่ีคุณตองทํา   

ทั้งหมดก็คือ คลิกซายคางไวบนช่ืออินดิเคเตอรท่ีตองการ ลากมันมาใสใน หนาตางอินดิเคเตอรปลายทาง แลว     

ปลอย จากนั้นอินดิเคเตอรตัวใหมก็จะปรากฏในหนาตางอินดิเคเตอรอันเดิม ในหนาตางพารามิเตอร ในสวน    

ของ ฟลดราคา (Price field) จะเลือกคาของอินดิเคเตอรอันเดิมมาใชในการคํานวณ 

 

ตัวอยาง: ในการคํานวณเสน Simple Moving Average จากขอมูลในอดีตของ RSI ก็เพียงแคลาก        

อินดิเคเตอร MA เขาไปใสในหนาตางของ RSI ในสวนของฟลดราคาก็จะถูกกําหนดไวดังเดิม ดังน้ัน เสนคา       

เฉลี่ยที่เราเพิ่งเพิ่มเขาไป มันก็จะคํานวณมาจากคาของเสน RSI(15) ดังรูป 

 

  

 

หมายเหตุ : เนื้อหาในสวนดานลางจะประกอบไปดวยขอมูลเชิงเทคนิคสําหรับผูใชแบบข้ันสูง 

ผูที่เพิ่งเริ่มตนอาจขามสวนนี้ไปก็ได 
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การใชคําสั่ง Param(), ParamColor(), ParamToggle(), ParamStyle() (Using 

Param(), ParamColor(), ParamToggle(), ParamStyle() functions) 

 

ฟงกชั่นเหลานี้เมื่อใชงานจะสามารถทําใหเปล่ียนการตั้งคาของอินดิเคเตอรไดโดยตรง แทนท่ีการต้ังคา  

ผานหนาตางพารามิเตอร 

 

Param(“name”, defvalue, min = 0, max = 100, step = 1, sincr = 0) 

วิธีการเพิ่มหรือปรับคาพารามิเตอรตางๆ สามารถเขาถึงไดดวยข้ันตอนตอไปน้ี 

 

“name” - คือ พารามิเตอรท่ีใหเรากําหนดไดวาอยากใหช่ือท่ีแสดงเปนช่ืออะไร 

defvalue - กําหนดคาพ้ืนฐานของพารามิเตอรนั้น 

min, max - กําหนดคาตํ่าสุด และ สูงสุดของพารามิเตอร 

step - ระบุไดวาตองการใหพารามิเตอรขยับเพ่ิมทีละเทาไหรจากการเล่ือนแตละคร้ัง 

sincr - เปนการระบุวาตองการใหอินดิเคเตอรอีกอันหนึ่งท่ีเพ่ิมเขามาตอนหลัง มีคาเพ่ิมข้ึนอีกเทาไหร    

จากอินดิเคเตอรอันแรกซึ่งเปนชนิดเดียวกัน ตัวอยางเชน ถาคุณใสเสนคาเฉล่ียสองเสนไวในหนาตางเดียวกัน   

ถาเสนแรกใช Period อยูที่ 15 อีกเสนหนึ่งก็จะมีคาอยูท่ี 25 (defvalue = 15 + sincr = 10) 

 

ParamColor(“name”, defaultcolor) 

“name” - คือพารามิเตอรท่ีใหเรากําหนดไดวาอยากใหช่ือท่ีแสดงเปนช่ืออะไร 

defaultcolor - กําหนดสีท่ีตองการใหปรากฏ 

 

ฟงกชั่น ParamColor อนุญาตใหคุณใช ColorCycle เปนสีพ้ืนฐานได เม่ือคุณใช ColorCycle       

สีพื้นฐานนั้นจะไลสีไปตั้งแต แดง, เขียว, เขียวขุน, ทอง, มวง, เขียวออน, ดําเขม ตามลําดับ ของอินดิเคเตอร          

ที่คุณใสเขาไปในหนาตางเดียวกัน 

 

 

ParamStyle(“name”, defaultval = styleLine, mask = maskDefault)  
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เปนฟงกชั่นที่อนุญาตใหคุณเลือกรูปแบบการพลอตกราฟได นอกเหนือไปจากเวอรช่ันกอนหนาแลว   

ยังมีอีกสองสไตลที่เพิ่มเขามา ไดแก 

 

styleHidden - เปนการผสมระหวาง styleNoDraw และ styleNoRescale 

styleDashed - เสนประ 

 

สวนลิสตตอไปนี้คือสไตลท่ีจะแสดงในหนาตางของพารามิเตอร ซึ่งข้ึนอยูกับคา mask ท่ีคุณกําหนด  

 

maskDefault - จะโชวแบบหนา, แบบเสนประ, ซอน และ แบบท่ีใชขนาดของตัวเอง (OwnScale)        

(นี่เปนคามาตรฐานที่ถูกตั้งคาไวของ ParamStyle) 

maskAll - แสดงสไตลท้ังหมด 

maskPrice - แสดงแบบหนา, แบบซอน, ขนาดของตัวเอง, แทงเทียน, และแบบแทง 

maskHistogram - แสดงฮิสโทแกรม, แบบเสนหนา, ซอน, ขนาดของตัวเอง, แบบพ้ืนท่ี 

 

ParamField(“name”, field = 3) - คําส่ังนี้จะยินยอมใหคุณสามารถเลือกฟลดของราคาอันใด      

ก็ตามมาคํานวณในอินดิเคเตอรได (ฟลดจะถูกใชในการคํานวณคาของอินดิเคเตอร) ฟงกช่ันน้ีจะเปนการระบุ   

ขอมูลที่เราตองการใช ซึ่งคา Default value = 3 จะเปนการใชราคาปดมาคํานวณ และ สวนใหญคาของฟลด         

จะเปนดังนี ้

 

-1 - ตัว ParamField จะสงคาของอินดิเคเตอรตัวแรกกลับมา หรือ เปนราคาปดแทนหาก       

ไมมีอินดิเคเตอรกอนหนา 

0​ - สงกลับ  ราคาเปด 

1​ - สงกลับ  ราคาสูงสุด 

2​ - สงกลับ  ราคาต่ําสุด 

3​ - สงกลับ  ราคาปด  (คามาตรฐาน) 

4​ - สงกลับ  ราคาเฉลี่ย  = (ราคาสูงสุด + ราคาตํ่าสุด + ราคาปด) / 3 

5​ - สงกลับ  ปริมาณการซ่ือขาย 

6​ - สงกลับ  สถานะคงคาง 
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7, 8, 9, … ​- สงกลับคาของอินดิเคเตอรท่ีใสไวในหนาตางน้ัน 

 

ParamToggle(“name”, “values”, defaultval = 0) - ฟงกช่ันน้ีจะยินยอมใหคุณใชคําส่ังบูลีน       

(Yes/No) ในพารามิเตอรได สยามควอนท 

 

“name” - คือช่ือของพารามิเตอร 

“values” - คาของพารามิเตอร (คั่นดวยตัว | ยกตัวอยางเชน “No|Yes” - ขอความแรกจะ 

เปนคา False และขอความสองจะเปนคา True) 

defaultval - คามาตรฐานของพารามิเตอร 

 

ยกตัวอยาง : อินดิเคเตอรท่ีอยูดานลางนี้ จะแสดงใหคุณเห็นวาโคดท่ีเขียนข้ึนมาน้ัน จะทําให     

พารามิเตอรทํางานอยางไร คุณสามารถเปล่ียนการตั้งคาไดจากหนาตางของพารามิเตอร 

 

Buy = Cross(MACD(), Signal() );  

Sell = Cross(Signal(), MACD() );  

 

pricefield = ParamField("Price Field", 2);  

Color = ParamColor("color",colorRed);  

style = ParamStyle("style",styleLine,maskAll);  

arrows = ParamToggle("Display arrows", "No|Yes",0);  

Plot(pricefield,"My Indicator",Color,style); ​SiamQuant 

 

if(arrows)  

{ 

PlotShapes(Buy*shapeUpArrow+Sell*shapeDownArrow,IIf(Buy,colorGreen,color

Red) ); 

}  
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คําสั่งพิเศษ : อธิบายคําส่ัง SECTION_BEGIN, _SECTION_END, _SECTION_NAME,      

_DEFAULT_NAME, _PARAM_VALUES (สําหรับผูใชข้ันสูงเทานั้น) 

 

เมื่อคุณลากสูตรวางในหนาตางชารท ตัว AmiBroker เองจะใสโคด _SECTION_BEGIN(“name”)     

และ _SECTION_END() ไวที่หัวและทายของโคดตามลําดับโดยอัตโนมัต ิ

 

ดังนั้น จากโคดเดิมท่ีเปนแบบนี ้

 

P = ParamField("Price field",-1); 

Periods = Param("Periods", 15, 2, 200, 1, 10 ); 

Plot( MA( P, Periods ), _DEFAULT_NAME(), ParamColor( "Color",colorCycle ), 

ParamStyle("Style") ); 

 

ก็จะถูกเปลี่ยนโดย AmiBroker ใหเปนแบบนี ้

 

_SECTION_BEGIN("MA"); 

P = ParamField("Price field",-1); 

Periods = Param("Periods", 15, 2, 200, 1, 10 ); 

Plot( MA( P, Periods ), _DEFAULT_NAME(), ParamColor("Color", colorCycle ), 

ParamStyle("Style") ); 

_SECTION_END(); 

 

AmiBroker อนุญาตใหคุณแยก _SECTION_BEGIN/_SECTION_END ในแตละคําส่ัง และ ปรับแตง      

มันในภายหลังได 

 

นอกจากนี้ โปรดแนใจวาคุณใสมันอยางถูกตอง การใชช่ือเดียวกัน ในพารามิเตอรน้ันจะสงผลใหโคด    

บางสวนถูกรบกวนซึ่งกันและกันได ยกตัวอยางเชน ถาคุณลากเสนคาเฉล่ียใสลงไปสองเสน โคดจะเปนดังน้ี 
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_SECTION_BEGIN("MA"); 

P = ParamField("Price field",-1); 

Periods = Param("Periods", 15, 2, 200, 1, 10 ); 

Plot( MA( P, Periods ), _DEFAULT_NAME(), ParamColor( "Color", colorCycle ), 

ParamStyle("Style") ); 

_SECTION_END(); 

  

_SECTION_BEGIN("MA1"); 

P = ParamField("Price field",-1); 

Periods = Param("Periods", 15, 2, 200, 1, 10 ); 

Plot( MA( P, Periods ), _DEFAULT_NAME(), ParamColor( "Color", colorCycle ), 

ParamStyle("Style") ); 

_SECTION_END(); 
 

เพิ่มเติม ชื่อพารามิเตอรในสองสวนนั้นสามารถตั้งใหเหมือนกันได โดยท่ีมันจะไมทํางานรบกวนกัน   

ตองขอบคุณชื่อของแตละสวนท่ีทําใหไมเกิดปญหานี้ นั่นเพราะวา AmiBroker จะระบุแตละสวนดวยช่ือของ    

มัน ดังนั้นแลว หากชื่อของแตละสวนไมเหมือนกัน พารามิเตอรท่ีอยูในสวนนั้นก็จะไมซ้ํากับท่ีอยูในสวนอ่ืน เม่ือ     

คุณลากอินดิเคเตอรตัวใหมเขามาใส AmiBroker จะตรวจสอบโดยอัตโนมัติ และ จะกําหนดหมายเลขใหหาก     

ชื่อในสวนทั้งสองนั้นซํ้ากัน ชื่อของสวนนั้นจะปรากฏดังรูป SiamQuant 
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สุดทายแตไมทายสุด : คุณไมควรลบ _SECTION_BEGIN / _SECTION_END ออกจากสูตร       

ถาคุณทําแบบนั้น AmiBroker จะไมสามารถรับรูถึงพารามิเตอร และ ส่ิงอ่ืนท่ีอยูในสวนน้ันได และจะทําให      

รบกวนการทํางานของสวนอื่นๆ ดวย 

 

_SECTION_NAME คือฟงกช่ันท่ีใชกําหนดช่ือของฟงกช่ัน (ใสตอจากคําส่ัง _SECTION_BEGIN) 

 

_DEFAULT_NAME เปนคําส่ังท่ีใชกําหนดช่ือเร่ิมตนของรูปแบบการพลอต ช่ือเร่ิมตนน้ันประกอบ   

ดวยชื่อของสวนตางๆ และคั่นดวยเคร่ืองหมายจุลภาค ยกตัวอยางดังโคดนี ้

 

_SECTION_BEGIN("MA1"); 

P = ParamField("Price field"); 

Periods = Param("Periods", 15, 2, 200, 1, 10 ); 

Plot( MA( P, Periods ), _DEFAULT_NAME(), ParamColor( "Color", colorCycle ), 

ParamStyle("Style") ); 

_SECTION_END(); 

 

_DEFAULT_NAME จะถูกกําหนดเปน "MA1(Close,15)" 
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_PARAM_VALUES ทํางานเหมือนกับ _DEFAULT_NAME ยกเวนเพียงแตจะไมรวมช่ือเขาไปดวย  

(มีเพียงแตคาของพารามิเตอรเทานั้น) ดังนั้นแลวจากตัวอยางขางบน _PARAM_VALUES จะถูก    

กําหนดคาเปน "(Close, 15)" 

 

คําถามที่พบบอยเกี่ยวกับฟงกช่ันลากและวาง (Frequently Asked Questions about 

drag & drop functionality) 

 

คําถาม : อะไรคือความตางระหวางคําสั่งแทรกและแทรกแบบเช่ือมโยงจากตัวเลือกในเมนูชารท? 

 

คําตอบ : คําสั่ง แทรก (Insert) จะเปนการทําสําเนาจากโคดตนฉบับแลววางไวในโฟลเดอร      

drag-drop ซึ่งถูกซอนเอาไว และจะไมไดรับผลกระทบจากการเปล่ียนแปลงใดๆ ท่ีทําบนหนา Overlay ของ      

ชารท การดับเบิ้ลคลิกบนชื่อสูตรท่ีอยูในหนาตางดานซายจะเทากับการเลือกคําส่ัง แทรก จากในเมนู ในอีก     

ดานหนึ่ง คําสั่ง แทรกแบบเชื่อมโยง (Insert Linked) จะไมสรางสําเนาของสูตรไว การแทรกมันเขาไปใน หนา        

ตางชารทจะเปนการเชื่อมโยงกับสูตรตนฉบับโดยตรง ดวยวิธีนี้เมื่อมีการแกไขคาตางๆ ในหนา Overlay    

จะทําใหโคดตนฉบับเปลี่ยนไปดวย 

 

คําถาม : ฉันไมเห็นลูกศร ซ้ือ/ขาย ในระบบของฉันเลย 

 

คําตอบ : ลูกศรซื้อขายจะปรากฏในหนาตางชารททุกหนา (ยกเวนชารทราคาในตัว) อยางไรก็ตาม     

โดยมาตรฐานแลวลูกศรจะถูกปดเอาไวไมใหแสดงผล ในการเปดใชงานคุณตองเปดผานหนาตางพารามิเตอร  

เลือกที่แทบ “Axes & Grid” และเลือกเมนู “Show trading arrows” แลวเปล่ียนตัวเลือกเปน “Yes” 

 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 

 

http://www.siamquant.com/thai-amibroker-manual


 

 

 

- 40 - 

 

 

คําถาม : ขอความที่วา “Automatic Analysis formula window is now drag&drop 

target too (you can drag formulas and AFL files onto it)” หมายความวาอยางไร? 

 

คําตอบ : หมายความวาคุณสามารถลากสูตรจากหนาตางดานซายก็ได หรือเปดจากไฟล .AFL ผาน      

Windows Explorer และ ลากมาใสในหนาตางการวิเคราะหแบบอัตโนมัติ (Automatic Analysis : AA)        

ซึ่งจะถูกโหลดใสไวในหนาตาง AA นี่จะทําใหคุณสามารถโหลดสูตรผานการกดปุม “Load” ในหนาตาง AA      

ไดอีกทางหนึ่ง 

 

คําถาม : ฉันสามารถสรางทางลัดในหนาตางสูตรไดหรือไม? 

 

คําตอบ : ทําไมได คุณสามารถทําไดเพียงการลากและวางไฟลโดยสวนขยายของ .AFL เทาน้ัน (เมนู       

ลัดใน Windows มีสวนขยาย) 

 

คําถาม : ฉันสามารถเพ่ิมสูตรของตัวเองในเมนูท่ีอยูหนาตางดานซายไดหรือไม? 

 

คําตอบ : สามารถทําไดงายๆ เพียงแคเซฟไฟล .AFL ของคุณใสในโฟลเดอร Formulas ท่ีอยูใน        

โฟลเดอรรวมของ AmiBroker ซึ่งจะปรากฏอยูในเมนูดานซาย ​(กด View > Refresh All ดวย เพราะบางที          

เมื่อคุณเซฟไฟลแลวอาจจะตองอัพเดตใหระบบอานอีกคร้ัง) 
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คําถาม : ฉันเพิ่มไฟลใหมเขาไปในโฟลเดอร Formulas แตมันไมแสดงไฟลใหมน้ัน ในเมนูเลย 

นอกจากจะปดโปรแกรมแลวเปดใหม มีวิธีอื่นอีกไหมในการรีเฟรชเมนู? สยามควอนท 

 

คําตอบ : คุณสามารถรีเฟรชเมนูไดโดยการเลือก View > Refresh All 

 

คําถาม : ถาฉันปรับแตงสูตรท่ีมาพรอมกับ AmiBroker ต้ังแตแรก มันจะถูกเขียนทับอีกคร้ัง 

หรือไม ในการอัพเกรดครั้งตอไป? 

 

คําตอบ : ใชแลว มันจะถูกเขียนทับ ถาคุณตองการปรับแตงโคดแบบด้ังเดิมซ่ึงมาพรอมกับ 

AmiBroker ใหเซฟไฟลในชื่อใหมหรือจะดีกวาถาเซฟไฟลไวในโฟลเดอรสวนตัว 

 

คําถาม : ฉันเห็นวามันมีปุม Reset All ในหนาตางพารามิเตอรท่ีจะรีเซ็ตคา ของพารามิเตอร 

ทั้งหมดใหเปนคาเริ่มตน มันพอมีวิธีบางไหม หากตองการรีเซ็ตเพียงแค คาของพารามิเตอรตัวใดตัวหน่ึง 

เทานั้น? 

 

คําตอบ : ตอนนี้ยังไมมี แตในอนาคตเราจะเพ่ิมมันในรุนทดลอง 

 

คําถาม : ฉันลาก RSI ใสในหนาตางราคาและเห็นเสนสีแดงอยูดานลางสุดของหนาตาง มีอะไรผิด 

ปกติหรือ? 

 

คําตอบ : ทันทีที่คุณลากอินดิเตเตอรสองตัวมาใสรวมกัน ซึ่งท้ังสองตัวมีคาท่ีแตกตางกันอยางส้ินเชิง    

คุณจําเปนตองปรับตัว Style ใหเปนแบบ OwnScale สําหรับอินดิเคเตอรตัวใดตัวหน่ึง คุณสามารถเลือก      

Style ไดผานหนาตางพารามิเตอร เมื่อทําแลวจะมั่นใจไดเลยวาอินดิเคเตอรแตละตัวน้ันสามารถเห็นไดอยาง   

ชัดเจน ไมอยางนั้นแลวกราฟที่แสดงผลก็จะเปนแบบแบนอยางท่ีคุณไดพบ 

 

คําถาม : คําสั่ง AFL อยางเชน _SECTION_BEGIN และอื่นๆ น้ันมันมีสีเทาออนซ่ึงมองยากมาก        

เพราะพื้นหลังของฉันนั้นก็เปนสีเทา ฉันสามารถเปลี่ยนสีของคําสั่งเหลาน้ีไดหรือไม? 
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คําตอบ : ในตอนนี้ยังไมได แตพวกเราจะใสการตั้งคาใหสามารถเปล่ียนสีไดในเวอรช่ันถัดไป 

 

คําถาม : เมื่อฉันลากอินดิเคเตอรมาใสแลว หนาตางพารามิเตอรกลับไมโชวคาพารามิเตอร 

ของตัวอื่น ฉันทําถูกหรือเปลา? SiamQuant 

 

คําตอบ : ถูกแลว มันเปนแบบนั้นละครับ ไอเดียท่ีซอนอยูนั้นมันงายมาก เม่ือคุณลากอินดิเคเตอรตัว      

ใหมเขามาใส AmiBroker จะปรากฏหนาตางพารามิเตอรเพียงแคอินดิเคเตอรลาสุดเทาน้ัน น่ันทําใหแนใจ    

ไดวาพารามิเตอรที่ปรากฏนั้นเปนของอินดิเคเตอรตัวลาสุด และ ผูใชใหมจะไดไมตองงมเข็มกับพารามิเตอร   

เปนสิบๆ ตัวจากอินดิเคเตอรท่ีสรางมากอนหนานี้ แตในอีกมุมหนึ่ง หากคุณคลิกเลือก “Parameters” จาก      

เมนูผานการคลิกขวาที่หนาตางชารท พารามิเตอรท้ังหมดจะโชวข้ึนมา และ คุณสามารถปรับแตงมันท้ังหมดได    

ในภายหลัง 
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ธีมของชารท 

(Chart themes) 

 

AmiBroker 5.52 ไดนําเสนอธีม 6 แบบท่ีสามารถเปล่ียนไดจาก  
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1. ธีมพื้นฐาน ( Basic Theme​)​SiamQuant 
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2. ธีมแบบงาย( Nature Simple Theme) 
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3. ธีมแบบมีสี ( Nature Gradient Theme​) 
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4. ธีมสีเทา ( Gray Theme​) 
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5. ธีมสีเทาเขม ( Dark Gray Theme​) 
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6. ธีมสีดํา ( Black Theme​)​SiamQuant 
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การปรับแตงหนาจอผูใช 

(User interface customization)​สยามควอนท 

 

ในเวอรชั่นใหมนี้เรามีการปรับแตงหนาจอผูใชหลายอยางท่ีนาประทับใจและควบคุมมันไดอยางสมบูร

ณมากกวารูปลักษณของ AmiBroker แบบเดิมๆ SiamQuant 

 

การเอากลุมบางอันออก / การซอนแท็บ (Advanced nested docking / tear-off tabs) 
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ในการเอาหนาตางหรือแทบออกไปไวพ้ืนท่ีใดๆของโปรแกรม ทําไดโดยการคลิกตรงแถบบนของหนา  

ตางนั้นๆแลวลากมัน ทันทีท่ีคุณลากจะมีปุมปรากฏข้ึนมาเพ่ือใหคุณเลือกวา จะเอาหนาตางน้ันๆไปวางไว   

ตรงไหนไดงายขึ้น ดังรูปดานลาง 

 

 

 

คุณยังสามารถลากมันออกมาแลวใหหนาตางนั้นเปนหนาตางแยกตางหากได ดวยวิธีน้ีคุณสามารถ  

จัดการแยกหนาตางทั้งหมดเปนหนาตางแยก หรือ รวมกันใหเปนหมวดหมูได คุณยังสามารถลากมันไดอยาง    

อิสระ และ วางไวตรงไหนก็ไดดวยการกดปุม Ctrl คางเอาไว 

 

การซอนหนาตางอัตโนมัติ (Sliding Auto-hide panes) 

 

อีกความสามารถที่มีประโยชนก็คือการซอนหนาตางจากหนาจอไดโดยอัตโนมัติ ในการเปดปดคําส่ังน้ี  

จะอยูตรงปุมเข็มหมุดที่อยูมุมบนขวาของแตละหนาตาง ถาคุณยกเลิกการปกหมุด หนาตางจะถูกซอนอัตโนมัติ   

เมื่อเราไมไดใชงานมัน SiamQuant 

 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 
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- 53 - 

การปรับแตงแถบเครื่องมือ เมนู และปุมลัดข้ันสูง (Advanced customizable toolbars, 

menus and keyboard shortcuts) 

 

ความสามารถใหมนี้สามารถทําใหผูใชสามารถควบคุมลักษณะท่ีปรากฏได การแสดงผล และ ตําแหนง    

ตางๆ ของแถบเครื่องมือทั้งหมด ปุม และเมนู ซึ่งอนุญาตใหคุณเพ่ิมปุมของคุณเอง ลบและจัดเองใหมได รวม       

ถึงคุณสามารถกําหนดหรือแกปุมลัดไดเองดวย ความสามารถในการปรับแตงท้ังหมดน้ีมีอยูในเมนู Tools >    

Customize หรือจะเขาจากลูกศรท่ีอยูใตแท็บก็ได 

 

 

 

เครื่องหมายลูกศรที่วานั้นเปนลูกศรเล็กๆ ท่ีอยูตรงดานลางสุดของขอบแถบเคร่ืองมือ เจาส่ิงน้ีไดซอน   

เครื่องมืออื่นๆ ของแถบเมนูไวโดยอัตโนมัติ ตลอดจนคําส่ังในการปรับแตงแถบเมนู SiamQuant 

 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 
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เมนูยอย Add or Remove Buttons จะแสดงแถบปุมเคร่ืองมือหรือซอนตามท่ีคุณตองการ      

ในโหมดการปรับแตง (เมื่อคุณเขาโดยไปท่ี Tools > Customize) คุณยังสามารถยายปุมไปรอบๆ เพ่ือเปล่ียน       

ลําดับการแสดงผลได และคุณยังสามารถปรับขนาดของสวนนั้น รวมไปถึงรวมปุมใหอยูในสวนเดียวกันได (เชน    

สวนที่ไวเลือกชื่อหุน) ดวยการคลิกท่ีรายการท่ีเราตองการ และปรับขนาดเมื่อเลือกเสร็จแลว 

 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 
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คุณสามารถทําไดแมกระท่ังการออกแบบปุมของคุณเองดวยโปรแกรมแกไขรูปภาพท่ีมีมาให 

 

 

 

ธีมที่ปรากฏ ( Themed appearance​)​SiamQuant 

 

Amibroker อนุญาตใหคุณเปล่ียนหนาตาของโปรแกรมท่ีปรากฏตามท่ีรสนิยมของคุณไดเชนกัน 

 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 
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- 56 - 

 

แท็บ MDI (multiple document interface) (MDI (multiple document interface) 

tabs) 
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AmiBroker นั้นมีฟงกช่ันการแสดงผลแบบหลายหนาตาง (MDI) ความหมายงายๆ ก็คือเจาส่ิงน้ี     

ทําใหคุณสามารถเปดและทํางานหลายหนาตางไดในเวลาเดียวกัน หากตองการขอมูลเพ่ิมเติมวา MDI คืออะไร    

คุณอาจจะอยากเขาดูเนื้อหานี้  http://en.wikipedia.org/wiki/Multiple_document_interface 

 

สําหรับตอนนี้แท็บ MDI (ดังรูป) เปนอีกทางเลือกในการเปล่ียนหนาตางเพ่ือใชงาน (นอกเหนือจาก     

การเขาผานเมนู Window ที่ซึ่งจะแสดงหนาตางท่ีสามารถใชงานได) สยามควอนท 

 

เปนเรื่องสําคัญที่จะตองเขาใจวาแท็บ MDI นั้น “ผูใชไมสามารถรเจาะจงแท็บได” หรืออีกแงก็ คือไม      

สามารถเปลี่ยนชื่อไดตามใจตองการ ไมเหมือนกับหนาตางชารท (ท่ีสามารถระบุได) ช่ือของแท็บจะถูกกําหนด    

โดยชื่อของหนาตางหรือเอกสารนั้นเอง สําหรับหนาตางชารทนั้นช่ือจะถูกตั้งดวยรูปแบบ : ตัวยอ - ช่ือเต็ม      

เสมอ, หนาตางสําหรับการเขาเว็บไซตจะใช HTML Title เปนช่ือของหนาตาง (ซ่ึงถูกกําหนดไวแลวในโคดของ      

HTML), หนาตางจัดการบัญชี จะใชช่ือไฟลบัญชีจริงๆ (ซึ่งคุณสามารถกําหนดไดตอเม่ือคุณเซฟ) 

 

แท็บ MDI นั้นไวใชสําหรับการสลับหนาตาง (เหมือนกับ Taskbar ดานลางของ Windows) และ        

มันถูกควบคุมโดยอัตโนมัติจาก AmiBroker เมื่อคุณเปดหรือปดหนาตาง และ แนนอนวามันทํางานแบบ     

เดียวกับ Taskbar ของ Windows เลย มาเปรียบเทียบกันดูดีกวา 

 

เมื่อคุณใช Taskbar ของ Windows 

 

- คุณเปดโปรแกรม - ปุมใหมในแถบ Taskbar จะปรากฏข้ึน 

- และคุณสามารถสลับหนาโปรแกรมท่ีเปดไวอยูไดผานปุมเหลานั้น 

- คุณไมสามารถเปลี่ยนช่ือปุมไดเพราะมันแสดงช่ือของโปรแกรมอยู 

- และคุณจําเปนตองระวังเมื่อคุณเปดหลายโปรแกรมมากไป 

เพราะโปรแกรมที่เปดข้ึนมาจะดึงทรัพยากรระบบมาใช (ใหการกระบวนการทํางานชาลง) 

 

คราวนี้ เรามาดูแท็บ MDI ของ AmiBroker กันบาง SiamQuant 
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- คุณเปดเอกสาร (window) > ปุมใหมปรากฏข้ึน (แท็บ) 

- คุณสามารถสลับหนาตางดวยปุม (แท็บ) 

- คุณไมสามารถเปลี่ยนช่ือหุนไดเพราะมันแสดงผลช่ือของเอกสาร / หนาตางอยู 

- และคุณจําเปนตองระวังเมื่อเปดหลายๆ เอกสาร / หนาตาง พรอมกัน 

เพราะทุกหนาที่คุณเปดจะเปนการดึงทรัพยากรระบบมาใช 

 

คุณสามารถปดแท็บ MDI ไดดวยการเอาเคร่ืองหมายถูกในสวนของ “Show MDI tabs” ท่ีปรากฏ       

อยูใน Tools > Customize ออกไป ดังตัวอยางดานลาง 

 

 

 

หมายเหตุสําหรับเวอรช่ันเกา : ในเวอรช่ันกอน 4.90 การเปล่ียนหนาเอกสารน้ันคุณตองใชผานเมนู     

Window แตในตอนนี้มีอีกทางเลือกหนึ่ง ก็คือคุณสามารถใชแท็บได แตฟงกช่ันน้ีสามารถทําไดเพียงแค    

อํานวยความสะดวกสบายเทานั้น S​สําหรับขอมูลเพ่ิมเติมโปรดดูท่ี http://en.wikipedia.org/wiki/Tabbed_D

ocument_Interface (โปรดจําไววาวิกิพีเดียล้ิงกนี้อธิบายเร่ือง TDI / MDI หรืออะไรบางอยางท่ีลาสมัยไปแลว      

และ AmiBroker ไดรวมทั้งวิธีการแบบ TDI และ MDI ไวดวย SiamQuant 
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สําหรับขอมูลเพิ่มเติม ดูไดท่ีเอกสารนําเสนอของการประชุมท่ี Houston 

http://www.amibroker.com/docs/Houston1.pdf​ (ไฟล PDF)  

http://www.amibroker.com/docs/Houston1.html​ (ไฟล Flash) 

 

การใชงานหนาชารทและหนาตาง Layout 

(Working with chart sheets and window layouts) 

 

AmiBroker มีการจัดการชารทหลายๆหนาตาง และหนาตาง Layout หลายๆ หนาดวยความสามารถ      

ที่รวดเร็วในการโหลดและเซฟ ความสามารถนี้ทําใหคุณสามารถเปล่ียน หรือ สลับอินดิเคเตอรท่ีคุณต้ังไว    

ไดอยางรวดเร็ว และ ประหยัดเวลาไดอยางมาก 

 

หนาชารทและรูปแบบ (Chart sheets and templates) 

 

หนาชารทจะถูกตั้งไวอยูในชุดของ Chart Pane (พรอมอินดิเคเตอร) ซ่ึงแสดงผลอยูในหนาเดียว 

คุณสามารถสลับระหวางหนาแตละหนาดวยการคลิกท่ีแท็บซึ่งอยูดานลางสุดของหนาตางโปรแกรม 

AmiBroker ตามรูปภาพดานลาง 

 

 

 

คุณยังสามารถเปลี่ยนช่ือของแท็บไดดวยการคลิกขวาท่ีแท็บ ดังรูปน้ี 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 
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คุณสามารถเปลี่ยนชื่อแท็บท้ังส่ี (แตละแท็บ) เพ่ือรายละเอียดท่ีมากข้ึนได (และเก่ียวของกับเน้ือหาใน    

หนานั้น) 

 

คุณสามารถเลื่อนแท็บไดดวยลูกศรและยังสามารถเล่ือนการจัดเรียงไดดวยการลาก (คลิกท่ีแท็บคางไว 

แลวลากไปยังจุดที่ตองการ ลูกศรท่ีปรากฏข้ึนจะแสดงตําแหนงท่ีไดวางไว) 

 

 

 

คุณยังสามารถเขาถึงหนาใดๆ ดวยความรวดเร็ว ผานการคลิกขวาบนลูกศร เพ่ือใหมีเมนูเดงข้ึนมา    

และ รายการที่อยูในเมนูนั้นคือช่ือแท็บท้ังหมดซึ่งอนุญาตใหคุณเขาถึงไดแบบทันทีดวยเพียงแคคุณคลิก (โดยไม   

ตองเลื่อน) 
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ขั้นตอนตอไปคือการตั้งคาหนาตางๆ ใหแสดงผลไดตามตองการ เพียงแคใชในสวนของ เพ่ิม/ลด    

จากแตละหนา ดวยวิธีนี้คุณสามารถตั้งคาอินดิเคเตอรไดสูงสุดถึง 60 ตัว และ สามารถเรียกใชมันใหมอีกคร้ัง      

ไดอยางรวดเร็วผานการคลิกท่ีแท็บ สวนการกําหนดจํานวนหนาของแท็บนั้นสามารถกําหนดไดท่ี Tools >    

Preferences > Charting > “Number of chart sheets”​SiamQuant 

 

การตั้งคาแบบสมบูรณแลวเราเรียกมันวา “เทมเพลต” และ คุณสามารถต้ังใหมันเปนแบบถาวร    

ไดเพียงแคคลิกขวาที่ชารทและเลือกเมนูดังนี้ Template  >Save, Template, Save as default 

 

เทมเพลตพื้นฐานนั้นใชเมื่อคุณสรางหนาตางใหมข้ึนมา (Window > New) 

 

คุณยังสามารถโหลดเทมเพลตท่ีเซฟไวไดดวยการเลือก Template > Load จากเมนูผานการคลิกขวา     

ที่หนาตางชารท 

 

นอกจากนี้ สมมติวาเทมเพลตเกาจะถูกเซฟใหมดวยไฟลนามสกุล .chart ซ่ึงน่ันจะไมเพียงแคบันทึก    

ขนาด และ สูตรอางอิงของชารทเทานั้น แตยังรวมถึงโคดของตัวมันเองดวย ดังน้ัน ทุกอยางท่ีคุณตองการจะอยู      

ในไฟลเดียว (เทมเพลตชารท, ไฟล .chart แบบสมบูรณ) และถาคุณคัดลอกไฟลน้ีไปเปดท่ีคอมพิวเตอรอ่ืน      

ชารทจะถูกสรางใหมดวยสูตรเดิมของมัน 

 

การเซฟชารทใสรูปแบบใหมใหทําตามข้ันตอนนี้ 
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1. คลิกขวาบนชารทและเลือก Template > Save… 

2. ในหนาตางโตตอบท่ีเดงข้ึนมา “File of type” ท้ังคูใหเลือก “Chart Template, Complete 

(*.chart)” 

3. ตั้งชื่อไฟล แลวเลือกเซฟ 

 

สวนการโหลดชารทกอนหนาท่ีเซฟเสร็จแลวใหทําตามนี ้

 

1. คลิกขวาบนชารทแลวเลือก Template > Load… 

 

2. ในหนาตางโตตอบ เลือกไฟล *.chart ท่ีเซฟไวกอนหนานี้ แลวกด “Open” 

 

หมายเหตุ : ขั้นตอนท่ี AmiBroker ทําอยูภายในจะเปนดังนี้ : เมื่อคุณเซฟไฟลชารทในรูปแบบใหม 

มันจะมีการเซฟไฟล XML ไวดวยดังนี ้

 

a) ชื่อของหนาทั้งหมด หนาตาง ขนาด ตําแหนงและการตั้งคาอ่ืนๆ 

b) โคดทั้งหมดที่เชื่อมโยงกับทุกหนา 

c) โคดของตัวมันเอง 

 

เมื่อคุณโหลดชารท AmiBroker ในคอมพิวเตอรเคร่ืองใหม 
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a) ตั้งคาหนา / หนาตางตามท่ีไดกําหนดไวในไฟล 

b) สําหรับแตละสูตรที่ถูกเก็บไวในไฟล จะถูกเช็ควาตรงกับสูตรท่ีอยูในคอมพิวเตอรอีกเคร่ืองหรือไม 

- ถาไมมีไฟลอยู - ระบบจะสรางข้ึนมาอีกอัน 

- ถามีไฟลอยูและเนื้อหาในไฟลเหมือนกัน ไฟล .chart จะไมทําอะไร 

- ถามีไฟลอยูแตเนื้อหาในไฟลตางกัน ระบบจะสรางสูตรใหมข้ึนมาโดยมี _imported.afl ตอทาย  

  (ดังนั้นไฟลเกาจะไมถูกนํามาใช) และจะอางอิงสูตรกับหนาตางดวยสูตรท่ีมี _import.afl ตอ 

  ทายแทน 

 

เรื่องสําคัญ : ถาคุณใชคําส่ัง #include ใดๆ ก็ตาม AmiBroker จะเก็บเน้ือหาของไฟลน้ันเอาไวในไฟล        

ชารท และจะพยายามสรางไฟลใหมในคอมพิวเตอรอีกเคร่ือง โปรดจําไววาในกรณีน้ีจะมีการเช็คไฟลวาตางกัน   

หรือไม ถาทั้งสองไฟลมีความตางกัน โปรแกรมจะมีการถามวาตองการใหสรางไฟลทับหรือไม ถาคุณเลือก    

ใหสรางไฟลทับไปเลย ไฟลจะถูกสรางทับและถูกสํารองเอาไวอีกอันหนึ่ง กลับมาท่ีเร่ืองสวนขยาย ถาคุณใชไฟล    

ใดๆ ก็ตามในฐานะ “standard include files” และดึงพวกมันมาดวยเคร่ืองหมาย <> AmiBroker        

จะสําเนาไฟลเก็บไวในโฟลเดอร Standard Include ซึ่งอยูในคอมพิวเตอรเคร่ืองท่ีเปด (แมวาโฟลเดอร     

Standard Include นั้นมีสวนท่ีไมเหมือนกันกับเคร่ืองตนฉบับก็ตาม) SiamQuant 

 

ไฟล .chart รูปแบบใหมนี้มีวัตถุประสงคเพ่ือใชระหวางคอมพิวเตอรท่ีแตกตางกัน สวนการจัดเก็บรูป    

แบบและเทมเพลตบนคอมพิวเตอรเคร่ืองหลักคุณควรจะใชการจัดรูปแบบอันเกาซ่ึงมันกินความจํานอยกวา 

(พวกมันจะเก็บเพียงแคการอางอิงเทานั้น ไมรวมถึงโคดของมันเอง) แตถึงอยางน้ันก็ตาม การใชการจัดรูปแบบ    

อันใหมเพื่อจุดประสงคในการเก็บสูตรและการอางอิงท้ังหมดไวในไฟลเดียวก็เปนส่ิงท่ีสะดวกมากในการสํารองข

อมูล 

 

ชื่อหลักทรัพยและการเช่ือมโยงภายใน (Symbol and Interval Linking) 

 

คุณสามารถที่จะเชื่อมโยงหนาตางชารทแตละอันดวยสัญลักษณ และ/หรือ ไทมเฟรม ในการเช่ือม    

โยงชารทนั้นใหใชปุม Linking ซึ่งอยูตรงดานลางสุดของชารท ดังรูปภาพตอไปน้ี 
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ปุม S และ i ที่เปนสีเทานั้นหมายถึงไมมีการเช่ือมโยงใดๆ ถาเปนสีอ่ืน (แดง, เขียว, ฟาออน, เหลือง,          

ชมพู, ขาว, นํ้าตาล, เขียวเขม, นํ้าเงิน) จะหมายถึงมันมีการเช่ือมโยงระหวางชารทดวยการกําหนดสีไวแลว      

หนาตางทุกอันที่มีสีลิ้งกเหมือนกันจะมีการเปล่ียนสัญลักษณ และ/หรือ การเปล่ียนแปลงภายในไปพรอมๆ กัน 

 

การแยกหนาตาง (Floating windows) 

 

ถาคุณมีหลายหนาจอ คุณสามารถใชมันเพ่ือแสดงผลชารท AmiBroker ในหลายหนาจอได การทําวิธี     

นี้ก็งายมาก AmiBroker ตั้งแตเวอรช่ัน 5.10 ไดนําเสนอวิธีการท่ีเรียกวา “Floating” ซ่ึงใชแยกหนาตางชารท       

ออกจากกัน โดยปกติแลวชารททุกหนาท่ีเปดจะอยูในหนาโปรแกรม AmiBroker ถาคุณตองการแยกชารทออก    

จากหนาโปรแกรม คุณก็เพียงดึงมันออกจากหนาตางหลัก ดังนั้นคุณสามารถลากมันไปท่ีอ่ืนได ยกตัวอยางเชน    

ใสไวในหนาจออื่น สยามควอนท 

 

คุณสามารถสลับระหวางโหมดปกติและโหมดแยกหนาตางไดดวยวิธีการดังรูป 
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วิดีโอตอไปนี้จะสาธิตการใชงานวาจะแยกหนาตางออกจากกันและเช่ือมโยงสัญลักษณไดอยางไร 

http://www.amibroker.com/video/FloatAndLink.html 

 

โครงสรางของหนาตาง (Window layouts) 

 

โครงสรางของหนาตางนั้นจะถูกตั้งคาใหเปดหลายหนาตางโดยท่ีแตละอันจะเปนช่ือสัญลักษณท่ีตางกัน

เอาไวแลว ตางกันทั้งการแสดงผลภายใน ขนาดท่ีตางกัน และการตั้งหนาชารทท่ีตางกันดวย 

 

ภาพดานลางนี้จะแสดงใหเห็นโครงสรางของ 4 หนาตาง ท่ีมีความแตกตางท้ังการต้ังคา และ 

อินดิเคเตอร ดานซายคุณจะเห็นหนา “Layouts” ซึ่งเปนพ้ืนท่ีสําหรับแสดงผลช่ือของไฟลท่ีเก็บไวใน Local 

layouts และ Global layouts 
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ถาคุณใช AmiBroker ตั้งแตเวอรช่ัน 4.20 ข้ึนไป คุณสามารถปรับแตงไดไมจํากัด การใชงานแมแบบ       

หลายอันสามารถทําไดดวยการสลับ เพียงแคดับเบิ้ลคล้ิกช่ือของ Layout ท่ีต้ังไวซ่ึงอยูในแท็บ “Layouts”  

 

คุณสามารถ เปด, บันทึก, ลบ Layout ดวยการคลิกท่ีพ้ืนท่ีวางของหนา Layout ดวยการคลิกขวา        

และ เลือกที่รายการ “Save As” เพ่ือบันทึก Layout ปจจุบันดวยช่ือใหม 

 

Local layouts จะอยูในแตละฐานขอมูลเทานั้น ในขณะท่ี Global layouts จะสามารถเห็นไดจาก       

ทุกฐานขอมูล SiamQuant 

 

ขอมูลที่ถูกบันทึกใน Layout จะประกอบไปดวย : ขนาดของหนาตางและการจัดตําแหนง, การยอ      

และ ขยายของหนาชารทในแตละหนา (ซึ่งแยกกันแตละหนา), บารท่ีเลือกเอาไว, สัญลักษณท่ีเลือกเอาไว,     

หนาชารทที่เลือกเอาไว 
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Layout ที่ใชลาสุดจะถูกเซฟเมื่อปดและฐานขอมูลจะสลับใหอัตโนมัติ (ต้ังคาท่ี Tools > Preferences 

> Miscellaneous “Save on exit: Layouts”) 

 

หมายเหตุ : ตั้งแตเวอรช่ัน 4.90 เปนตนมา การใชงานหลายหนาตางสามารถเปล่ียนไดไมเพียงแตรูป 

แบบเกาที่เขาผานเมนู Window เทานั้น แตยังรวมถึงการใชแท็บ MDI ดวย ขอมูลเพ่ิมเติมเก่ียวกับแท็บ MDI 

เขาไปดูไดที่บทกอนหนา 

 

การใชงาน Layers 

(Using layers) 
 

Layers คืออะไร (What layers are) 

 

Layers เหมือนกับชิ้นสวนของพลาสติกใส คุณสามารถวาดบนเจาส่ิงน้ีได เลเยอรยังสามารถทําใหมอง    

เห็น หรือ มองไมเห็นไดดวย ส่ิงนี้อนุญาตใหคุณ แสดง/ซอน ส่ิงท่ีวาดบนเลเยอรไดโดยจะไมมีผลกับเลเยอร      

อื่นๆ 

 

Layers ทํางานอยางไร(How to work with layers) 

 

กอนอื่น ทําใหแนใจวาพ้ืนท่ีใชงานนั้นสามารถมองเห็นได (Window > Layers) จากน้ัน เปล่ียนไป       

ที่แท็บ “Layers” ในตอนนี้คุณจะเห็นช่ือของเลเยอรท่ีกําหนดไวแลว ชองทําเคร่ืองหมายท่ีอยูดานซายของ    

แตละเลเยอรนั้นไวควบคุมการแสดงผล ถาชองนั้นถูกติ๊กไวแปลวาเลเยอรนั้นสามารถมองเห็นได แตถาไมมีการ   

ติ๊กไว เลเยอรนั้นจะมองไมเห็น ในเบื้องตนนั้นเลเยอร 5 อันแรกจะถูกล็อกไว 

 

เลเยอรที่วานี้ประกอบดวย 
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Default Layer - จะถูกมองเห็นตลอดเวลา 

Intraday Layer - จะเห็นตอเมื่อดูชารทแบบ Intraday เทานั้น 

Daily Layer - จะเห็นตอเมื่อดูชารทแบบรายวันเทานั้น 

Weekly Layer - จะเห็นตอเมื่อดูชารทแบบรายสัปดาหเทานั้น 

Monthly Layer - จะเห็นตอเมื่อดูชารทแบบรายเดือนเทานั้น 

 

เลเยอรที่ถูกล็อกเอาไวจะมองเห็นโดยอัตโนมัติเมื่อคุณเปล่ียนรายละเอียดภายในและคุณไมสามารถเป

ลี่ยนการมองเห็นผานการติ๊กชองดานซายได  

 

เลเยอรที่เหลืออยูนั้นไมสามารถล็อกและพวกมันสามารถกําหนดการมองเห็นไดผานการต๊ิกท่ีชองดาน

ซาย 

 

ในการวาดเครื่องมือตางๆ ลงบนเลเยอร สามารถทําไดโดย 

a) เลือกเลเยอรที่ตองการ (คลิกท่ีช่ือจนข้ึนไฮไลต) 

b) วาดเครื่องมือเหมือนอยางเคย 

 

เมื่อคุณเลือกเปดเลเยอรอ่ืน ทุกเคร่ืองมือวาดท่ีคุณวาดไวจะอยูบนเลเยอรท่ีเลือกน้ันดวย หลังจากท่ี   

วาดแลวคุณสามารถกําหนดมันใหอยูในเลเยอรอ่ืนไดผานการเลือก Object Properties Box 

 

เมนูยอย (Context menu) 

 

ถาคุณเลือกที่ชื่อเลเยอรดวยการคลิกขวา คุณจะเห็นเมนูยอยปรากฏข้ึนมาและมีรายการดังน้ี 

 

Add layer 

Remove layer 

Show all layers 

Hide all layers 
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Toggle 

Unlock built-in layers 

Lock built-in layers 

Properties 

 

การเพิ่ม/ลบเลเยอรสามารถทําไดเอง แตโปรดจําไววาคุณไมสามารถลบเลเยอร 5 อันแรกได (ท่ีถูกต้ัง     

มาไวแตแรก) 

 

Show all/ Hide all ​- แสดงและซอนเลเยอรท้ังหมดท่ีไมไดล็อกไว 

 

Toggle​ - สลับการมองเห็นของเลเยอรท้ังหมดท่ีไมไดล็อกไว 

  

Unlock/Lock built in layers ​- อนุญาตใหคุณปลดล็อก/ล็อก 5 เลเยอรแรกได (ท่ีถูกติดต้ังมา)         

แตละครั้งที่ล็อก การมองเห็นจะไมถูกเปล่ียนแปลงอัตโนมัติเมื่อเราเปล่ียนไทมเฟรม และคุณสามารถแสดง/   

ซอนดวยตัวคุณเองได 

 

Properties - การเปดตัวเลือกนี้อนุญาตใหคุณสามารถเปล่ียนช่ือเลเยอร และ    

ตัดสินใจไดวาอยากใหเลเยอรน้ันควรหรือไมควรล็อกการแสดงผล 

 

ถาคุณติ๊ก “Lock visibility to select interval” เลเยอรนั้นจะแสดง/ซอนอัตโนมัติข้ึนอยูกับวา       

รายละเอียดภายในนั้นกําลังแสดงผลอะไรอยู คุณสามารถกําหนดการมองเห็นของแตละเลเยอรไดดวยปุม  

“Interval” รวมกับปุม “Show/hide automatically” โปรดจําไววามันเปนการแยกการมองเห็นในแตละอัน     

หนาตางคุณสมบัติของเลเยอรนั้นจะตั้งคาเปนการแสดงผลแบบกราฟรายเดือนเสมอ แตคุณสามารถต้ังคา และ   

ตั้งการปรับการมองเห็นได ในการล็อกเลเยอรนั้นคุณจําเปนตองตั้งคาการมองเห็นสําหรับทุกๆเลเยอรใน  

Interval Combo-box งายๆ เพียงแคเลือกไทมเฟรมท่ีตองการถาเลเยอรน้ันควรจะถูกแสดงผล หรือ     

ไมแสดงผล จากนั้นเลือกไทมเฟรมอันใหมและทําแบบเดิมอีกคร้ัง จนกระท่ังคุณกํานดไทมเฟรมท้ังหมด 
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การใชงานหนาตางการวิเคราะหแบบใหม 

(Using New Analysis window) 

 

เกริ่นนํา (Introduction) SiamQuant 

 

หนาตางการวิเคราะหแบบใหมถูกนํามาใชในเวอรช่ัน 5.50 เปนตนมา (จริงๆแลวคร้ังแรกมีอยูในเวอร    

ชั่นทดลอง 5.41.0) มาดูกันดีกวาวามีความสามารถอะไรบาง  

 

● การเชื่อมโยงหลายการทํางานอยางรวดเร็ว หนาตาง Analysis จะใช CPU/แกนประมวล     

ผลทั้งหมดท่ีวางอยูในการประมวลผลสูตรจากหลายๆการเช่ือมโยงพรอมกันเพ่ือเรงความเร็ว 

ใหเต็มที่ ยกตัวอยางเชน ใน CPU Intel i7 แบบ 4 แกนสามารถเรงไดสูงสุดถึง 8          

การเชื่อมตอ มันสามารถประมวลผลไดเร็วกวาหนาตางการวิเคราะหแบบเดิมถึง 8 เทา    

แนนอนวาความเร็วท่ีเพ่ิมข้ึนนั้นจะข้ึนอยูกับความซับซอนของสูตรดวย (ย่ิงซับซอนเทาไหร  

ยิ่งเปนไปไดท่ีจะมีการเรงความเร็ว) และจํานวนของขอมูลท่ีใชในการประมวลผล (การใช   

RAM อาจจะไมสามารถเพ่ิมความเร็วไดเหมือน CPU ดังน้ันมันเปนไปไดท่ีความเร็วจะถูก    

จํากัด) 

● ไมปดกั้นการทํางาน ​ในตอนนี้คุณสามารถดู เล่ือนและจัดลําดับผลลัพธของการวิเคราะหใน   

ระหวางที่มันกําลังประมวลผลอยูได ดังนั้นแลวหนาจอผูใชจะไมถูกใชไปกับการประมวลผล  

เพียงอยางเดียว ชารทและอ่ืนๆ ยังสามารถใชงาน และ ตอบสนองไดมากกวาการประมวล     

ผลเวอรชั่นกอนหนา 

● วิเคราะหหลายอยางพรอมกัน S​คุณสามารถประมวลผลขอมูลไดมากกวาขอมูลเดียวในเวอรช่ั

นใหมนี้ ดังนั้นคุณสามารถ Scan / Backtest / Explore และ Optimize         

ไดพรอมกันโดยท่ีไมตองรอใหอยางใดอยาง หนึ่งเสร็จกอนเลย 

● หนาตาโปรแกรมท่ีเรียบงาย S​หนาตางการวิเคราะหเวอรช่ันใหมน้ีคุณสามารถใชงานได 

เหมือนกับแท็บของเอกสารได สามารถยาย สามารถจัดเรียงปุมไดดวย ดวยวิธีน้ีคุณจะมีท่ีวาง    
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สําหรับแสดงผลลัพธมากกวาเดิม ขอมูลเพ่ิมเติมเกี่ยวกับการประมวลผลน้ันจะถูกแสดงใน  

แท็บ “Info” ดังนั้นผลลัพธการเทสแบบ Walk-Forward ตอนน้ีจะถูกแสดงอยูในหนา     

วิเคราะหซึ่งดูวุนวายนอยลง 

  

หนาจอผูใช (User interface) 

 

คุณสามารถเปดหนาจอ Analysis ไดตามข้ันตอนนี้  

 

1. คลิกที่ปุมเพิ่มแท็บ (+) และเลือก New Analysis 

 

 

 

หรือ 

2. เขาเมนู File > New > New Analysis 

 

หรือ 

3. เขาเมนู Analysis > New Analysis 

 

หรือ 

4. คลิกขวาที่สูตรในหนาชารท และเลือก Analysis 
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หรือ 

 

5. จากในหนา Foumular Editor กดท่ีปุม Send to Analysis 

 

 

 

โดยพื้นฐานแลวหนาตาโปรแกรมของหนา Analysis นั้นจะมีการใชงานหคลายกับเวอรช่ันเกาดังน้ี 

สยามควอนท 
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การทํางานพื้นฐาน (Basic operations) 

 

เลือกหลักทรัพยที่ตองการเพ่ือใชในการวิเคราะห 

 

เลือกที่เมนูแบบ Drop down จากในสวนของ Apply to เพ่ือเลือกโหมดท่ีจะใชในการทํางาน : All 

symbols / Current / Filter​SiamQuant 
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ระบุตัวกรอง (Defining Filter) 

 

ถาใน Apply to เราเลือกเปนท่ีกรองไว หนาการวิเคราะหจะทํางานดวยสัญลักษณท่ีเรากรอง     

ไวตามเงื่อนไขของเราจากหนาตาง Filter Setting ในการเปดหนาตาง Filter Setting ใหกดปุมกรอง  

กําหนดชวงวันและเวลา (Defining date/time Range) 

 

คลิกที่เมนูแบบ Drop down ในสวนของ Range และเลือกโหมดท่ีตองการ : All quotes / N           

recent bas(s) / N recent day(s) / ตั้งแตวันท่ีกําหนด 

 

 

 

N นั้นแสดงถึงตัวเลขใดๆ ก็ตาม ยกตัวอยางเชนในการระบุชวงเวลา 15 วันลาสุด การเลือก 1 recent         

day(s) ในขั้นแรกและพิมพเลข 15 จากนั้นกด Enter คุณจะเห็นขอความเปล่ียนเปน 15 recent day(s)         

โดยอัตโนมัติ โปรดจําไววาคุณไมจําเปนตองพิมพอะไรเลย พิมพแคตัวเลขอยางเดียวก็เพียงพอแลว 

การดูผลรายงาน / เปดหนา Report Explorer (Viewing reports / Running 

Report Explorer) 

ในการดูรายงานผลจากการทดสอบระบบลาสุดใหคลิกท่ีปุม Report สวนการเปดหนา Report    

Explorer ใหคลิกที่เมนูแบบ Drop down ในสวนของ Report และเมนูจะโชวดานลาง 
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เปลี่ยนการตั้งคา / ตัวเลือก (Changing settings / options) 

 

การเปลี่ยนตั้งคาการทดสอบระบบ คลิกท่ีปุม Settings เพ่ือเปดปดตัวเลือกอยางเชน 

 

● เชื่อมกับชารทที่เลือก 

● รอการทํางาน 

● สแกนและคนหาซํ้าอัตโนมัต ิ

● ไทมเฟรมซํ้าอัตโนมัติ 

 

คลิกเลือกที่เมนู Drop down ในหมวด Setting และจะแสดงผลตามภาพดานลาง 

 

 

 

การตั้งคาไทมเฟรมซํ้าสามารถแกไขไดจากฟลด Interval โปรดจําไววาตัวเลขเปลาๆ (เชน 5)     

จะหมาย ถึงมีหนวยเปนนาที หากคุณตองการหนวยเปนวินาทีจําเปนตองพิมพ 5sec หรือ 5s แลวกด Enter 

ใชการเทสแบบ Walk Forward (Running Walk forward Test) 

 

คลิกที่ลูกศรตรงปุม Optimize เพ่ือใหมันแสดงเมนูตามรูปภาพ จากน้ันเลือก Walk-Forward 
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ผลลัพธของการทดสอบ Walk forward จะแสดงผลอยูในแท็บ Walk Forward (อยูดานลางของหนา 

Analysis) 

แสดงผลการ Optimize แบบชารท 3 มิติ (Displaying 3D optimization chart) 

 

ถาตองการใหแสดงผลการ Optimize แบบสามมิติ ข้ันแรกใหรันการ Optimize ซ่ึงแนนอนวาจะ      

ประกอบไปดวยพารามิเตอรสองตัว จากนั้นคลิกท่ีลูกศรตรงคําวา Optimize เพ่ือใหแสดงเมนูแบบภาพกอน    

หนา และเลือก 3D Optimization Chart 

 

สงออกและนําเขาผลลัพธ (Exporting and importing result list) 

 

ในการสงออกขอมูลไปสูไฟล CSV หรือไฟล HTML ใหใชเมนู File > Export HTML/CSV (จากเมนู          

ในหนาหลัก) สวนการนําเขาไฟล HTML ท่ีสงออกกอนหนานี้ใหใชเมนู File > Import HTML…        

เหมือนกับรูปที่แสดงอยูดานลาง จําไววาเมนูเหลานี้จะปรากฏก็ตอเมื่อเปดหนา New Analysis ไวอยู 
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การจัดการ Watch List  

(Working with watch lists) 

 

การ เพิ่ม/ลบ Watchlist (Adding / removing watch lists) 

 

คุณสามารถที่จะ  เพิ่ม/ลบ watch list ไดโดยการไปท่ี Symbol->Watch List->New Watchlist 

ในกรณีที่คุณตองการสราง watch list ใหม หรือไปท่ี Symbol->Watch List->Delete Watch list menu 

หากคุณตองการลบ watch list  

หมายเหตุ : หากคุณไดทําการปรับแตง แถบเมนูใดๆก็ตามลงไปแลว ส่ิงท่ีคุณตองทําเพ่ือใหแถบ     

เมนูกลับมาเปนเหมือนเดิมก็ คือ ไปท่ี Tools->Customize และเลือก"Menu Bar" จากน้ันกดปุม "Reset"        

เพื่อใหแถบเมนูกลับไปเปนเหมือนเดิม SiamQuant 
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การนํา tickers เขาสู watch lists (Adding tickers to watch lists) 

 

ใหคุณเขาไปที่ Watch List->Add selected symbol 

 

 

 

หลังจากทําตามตัวอยางขางตน หนาตางของ รายการwatch list จะปรากฏข้ึนตามรูปขางลาง : 

 

 

 

ตรงนี้ใหคุณเลือก watch list ท่ีคุณตองการจะเพ่ิมหลักทรัพยนั้นๆเขาไป(เลือก watch list ท่ีตองการ       

เพิ่มชื่อหลักทรัพยเขาไป) หมายเหตุ : คุณสามารถท่ีจะเพ่ิมช่ือหลักทรัพยหน่ึงช่ือ ไปยังหลายๆ watch list       
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พรอมๆกันได โดยการกดปุม CTRL คางไวและเลือก watch list ท่ีคุณตองการจะเพ่ิมลงไป หลังจากน้ันกดปุม        

OK หลักทรัพยที่คุณเลือกไวก็จะมีรายอยูไปแสดงอยูใน watch list ท่ีคุณไดทําการเลือกไว : สยามควอนท 

 

 

 

นอกจากนี้คุณยังสามารถพิมพช่ือหลักทรพยเพ่ือนําเขาสู watch list ไดโดยตรงโดยใช    

Symbol->Watch list->Type-in หากคุณตองการเพ่ิมช่ือหลักทรัพยมากกวาหน่ึงช่ือในคร้ังเดียว คุณตองใส    

เครื่องหมาย , ระหวางชื่อของหลักทรัพย 

 

การเรียงลําดับ tickers in a watch list ( Sorting tickers in a watch list) 

 

คุณสามารถจัดเรียงช่ือใน watch list ตามลําดับตัวอักษรไดโดยการ - คลิกขวาใน watch และ เลือก 

"Sort Alphabetically" 

 

การลบ tickers ออกจาก watch list( Removing tickers from watch lists) 

 

การลบรายชื่อหลักทรัพยออกจาก watch list นั้นงายพอๆกับการเพ่ิมรายช่ือหลักทรัพยเขาไปใน 

watch list แคเพียงคลิกขวาบนรายช่ือหลักทรพยท่ีคุณตองการจะลบ และเลือก Remove from watch 

list(s)  

SiamQuant 
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การลบ watch list หรือ ลางรายช่ือที่อยูใน watch list ของคุณ( Erasing watch lists) 

 

บางครั้งคุณอาจตองการลาง (หรือลบ) watch list ของคุณ ส่ิงท่ีคุณตองทําก็แคเพียงเลือก Symbol 

-> Watch list -> Erase (empty) 

 

ซอน/ปดการซอน watch list ตางๆที่วางเปลา (Hiding/Unhiding empty watch lists) 

โดย default แลว watch lists ท่ีวางเปลา จะแสดงใหเห็นไวอยูแลว แตคุณสามารถทําการซอน        

watch list เหลานั้นไดโดย การคลิกขวาท่ีหนาตาง watch list และ เลือก"Hide Empty Watchlists" และ           

หากคุณตองการที่จะปดการซอนของมันคุณก็เพียงแคคลิกปุมเดิมอีกคร้ังหนึ่ง 

 

การใช watch lists ในหนาตาง Automatic analysis ( Using watch lists in 

Automatic analysis window) 

  

Amibroker ชวยใหคุณทํางานไดงายข้ึน ในการจัดเก็บผลการสแกน ผลการ backt และ ผลการ       

exploration เก็บไวใน watch list ดวยเพียงแคคลิกเดียว แคเพียงคุณรัน AFL formula ตามปกติ และ          

คลิกที่รายการผลลัพธที่ออกมา เพ่ือใหเมนูดานลางนี้แสดงข้ึนมา : 
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เมื่อคุณเลือก Add all/selected results to watch list watch list ท่ีคุณเลือกน้ันจะ          

มีรายชื่อของหลักทรัพยในหนาตางผลลัพธของคุณท้ังหมด(ไมวาจะสแกน หรือ backtest อะไรก็แลวแต)    

นอกจากนี้คุณสามารถที่จะใชตัวเลือก Replace watch list with the results/selected results        

หากคุณใชตัวเลือกนี้รายชื่อหลักทรัพยท่ีอยูใน watch list นั้นท้ังหมดจะถูกแทนท่ีดวยผลลัพธท่ีคุณได 

 

จะ นําเขา/นําออก watch list จาก/ไปยัง ไฟล ไดอยางไร  SiamQuant 

  

การนําเขา watch list จากไฟลใดๆ (IMPORT WATCH LIST FROM FILE) 

 

1. เลือก Symbol->Watch List->Import menu หรือ คลิกขวาท่ี watch list และเลือก Import 
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2.  เลือกที่อยูของ watch list 

3.  ในหนาจอแสดงผลจะแสดงเฉพาะไฟลท่ี มีนามสกุลดังตอไปนี้เทานั้น TLS, .LST, .TXT หรือ .CSV  

4. คลิก OK 

นําออก WATCHLIST ไปยังไฟล ( EXPORT WATCHLIST TO FILE) 

1.  เลือก Symbol->Watch List->Export menu. 

หรือ คลิกขวาที่ watch list และ เลือก Export 

  

2. เลือก source watch list และเปล่ียนไปท่ี "External data source" 

  

3. ในไฟลโตตอบใหเลือกไฟลท่ีจะทําการ export ไฟลจะถูกสรางโดยเปนไฟล ASCII ดวยหน่ึง ticker 

symbol ตอหนึ่ง line 
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จะ นําเขา watch list จากฐานขอมูลภายนอก หรือ จะนําออก watch list 

ไปสูฐานขอมูลภายนอกไดอยางไร (How to import/export watch list from/to 

external database) 

 

การนําเขา Family จาก Fasttrack (IMPORT FAMILY FROM FASTTRACK) 

 

1.  เลือก Symbol->Watch List->Import เมนู หรือ คลิกขวาท่ี watch หลังจากน้ันเลือก Import 

 

 

 

2. เลือกที่ตั้งของ watch list และเปล่ียนไปท่ี "External data source" 
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3.ในกลองขอความโตตอบจะปรากฏจะ unfold อยูหนึ่ง category จากนั้นใหเลือก family 

จากที่ที่คุณตองการที่จะนําเขา symbols  

 

 

 

4. คลิก OK 
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 การนําออก Family ไปยัง Fasttrack (EXPORT WATCHLIST TO FASTTRACK 

FAMILY) 

 

1.  เลือก Symbol->Watch List->Export เมนู SiamQuant 

หรือคลิกขวาที่ watchหลังจากนั้นเลือก Export 

  

2. เลือก source ของ watch list และ เปล่ียนไปท่ี "External data source" 

 

 

 

3. ตอนนี้พิมพชื่อ personal family ท่ีเราตองการ ลงใน "New user family" (และใสคําอธบาย          

เพิ่มเติมลงในชองถัดไปดานขวามือ) หรือ เลือก personal family จาก list ท่ีมีอยูเดิม 
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ทําความเขาใจวา AFL นั้นทํางานอยางไร 

(Understanding how AFL works) 

 

บทนํา (Introduction) 

 

หนึ่งในสวนที่สําคัญท่ีสุดของ AFL ก็คือ มันเปนภาษาท่ีมีการประมวลผลอยางหลากหลาย มันทํางาน     

อยูบน อารเรย (หรือแถว / เวกเตอร) ของขอมูล วิธีการทํางานของมันนั้น คอนขางท่ีจะคลายคลึงกับการ        

ทํางานของสเปรดชีตที่เปนที่นิยมตางๆ (เชน Microsoft Excel) ถาหากคุณคุนเคยกับใชงาน MS Excel       

อยูแลว คุณก็จะทําความเขาใจการใชงาน AFL ไดอยางรวดเร็ว - ในความเปนจริงตัวอยางในบทความน้ี      

ถูกสรางขึ้นทั้งหมดโดยใช MS Excel 
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อารเรย คือ อะไร? (What is an Array? ) 

 

อารเรย คือ รายการ/แถว อยางงายของคาตางๆ ในหนังสือบางเลมก็อาจจะเรียกมันวาเวกเตอร     

ตัวเลขที่อยูหนาแถวแตละแถวนั้นเปนตัวแทนของแตละอารเรย Amibroker จะเก็บฐานขอมูล 6 อารเรยตอ     

symbol หนึ่งอัน ซึ่งใน 6 อารเรยนี้ก็จะประกอบไปดวย 1.ราคาเปด 2. ราคาต่ําสุด 3.ราคาสูงสุด 4. ราคาปด           

5.โวลุม 6.จํานวนสถานะคงคางเขียน หรือจะเขียนเปนตัวยอท่ีเราคุนเคยในรูป O, L, H, C, V, OI 

 

 

 

รูปแสดงตัวอยางของ อารเรยของราคาเปด  

 

โดยอารเรยอื่นๆนอกเหนือจากนี้ ก็จะถูกคํานวณจาก 6 อารเรยน้ี โดยใชสูตรท่ีสรางข้ึนใน AFL      

(อารเรยเหลานี้จะไมเก็บไวในฐานขอมูล แตจะมีคํานวณในกรณีท่ีจําเปนตองใช) 

แตละคาในอารเรยมีวันท่ีเกี่ยวของกับมัน S​เมื่อคุณยายเคอรเซอรไปท่ีกราฟแทงเทียนรายวัน 

(Preferences -> Miscellaneous Tab - > Price data tool tips) ส่ีเหล่ียมเล็ก ๆ สีเหลืองปรากฏ AFL              

จะเเสดงคา Open high low Close volume 

 

การทํางานของอารเรย - ทําไม AFL ถึงทํางานไดรวดเร็วมากนัก(Processing arrays - why 

is AFL so fast?) 

 

 

การทํางานของคําสั่งมีการทํางานดังตอไปนี้:  

MyVariable = ( High + Low )/2; 

 

เมื่ออยูระหวางการประเมินคําส่ังดังตัวอยาง (High + Low) / 2 Amibroker ไมจําเปนตองตีความ        

รหัสนี้ในแตละ bar จริงๆแลวมันเรียกใชอารเรย High และ อาเรย Low แลวทําการคํานวณเพ่ือสราง        
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ตัวแปรใหมในขั้นตอนเดียว การทํางานบนอารเรยในคร้ังเดียวนั้นจะมีการดําเนินการดวยความเร็วเต็มรูปแบบ 

 

ลองมาดูรายละเอียดใหมากข้ึนดีกวา - ดูท่ีรูปขางลาง .. เมื่อ AFL อานคา (High + Low) / 2            

ในครั้งแรก มันจะใชคาของอารเรย High (1) และ อารเรย Low (2) จากนั้นจึงประมวลผล (ในข้ันตอนเดียว)          

เปน อารเรยชั่วคราว (3 ) และ จากนั้นก็จะสรางอารเรยสุดทาย (4) ดวยการหารอารเรยช่ัวคราวดวยสอง        

ผลที่ไดนี้จะถูกใสไวในตัวแปร myVariable 

 

 

 

Moving averages เงื่อนไขของคําสั่ง (Moving averages, conditional statements) 

 

 โปรดพิจารณาโคด ดังตอไปนี้:  

 

Cond1 = Close > MA( Close, 3 ); 

Cond2 = Volume > Ref( Volume, -1 ); ​SiamQuant 

Buy = Cond1 AND Cond2; 

Sell = High > 1.30; 

 

โคดนี้จะซื้อเมื่อราคาปดมากกวา Moving average 3 วัน เเละ Volume มากกวาวันท่ีเเลว เเละ         

ขายเมื่อราคาสูงสุดในวันสูงกวา 1.3 สยามควอนท 

 

ถาหากใน AFL โคด คุณตองเห็นเมื่อ ราคาปดของวันสูงกวา simple moving average 3 วัน AFL           

จะทํางานโดยผานอารเรยของราคาปด โดยสรางอารเรยใหมท่ีเรียกวา MA(close,3) ข้ึนมาเพ่ือ symbol     

จะไดทําการวิเคราะหได ในแตละเซลลของอารเรยใหม สามารท่ีจะทําการเปรียบเทียบหน่ึงตอหน่ึงกับอารเรย   
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ของราคาปดไดเลย ยกตัวอยางเชน อารเรยท่ีช่ือวา Cond1 จะถูกสรางโดยวิธีการน้ี ในแตละเซลลท่ีราคาปด      

นั้นสูงกวาอารเรย MA(close,3) คาในเซลล ของอารเรยใหมท่ีช่ือวา Cond1 จะมีคาเทากับ 1 และถาหากคา        

ของราคาไมอยูสูงกวา คาในเซลล ของอารเรยใหมท่ีช่ือวา Cond1 จะมีคาเทากับ 0 

 

AFL ยังสามารถมองไปขางหนาหรือถอยหลังจํานวนชองของเซลลในอารเรย โดยใชฟงกช่ัน Ref (จาก     

ภาพดานลาง ดูแถว 6 ที่อารเรยช่ัวคราวจะถูกสรางข้ึนโดยใชโวลุมจากวันกอนหนา) 

 

ในแถว 9 อารเรยใหมท่ีเรียกวา Cond2 ไดถูกสรางข้ึนโดยการเปรียบเทียบคาของแตละเซลล     

ในอารเรย Volume หากตรงกับการตั้งคาในเซลล Cond2 ก็จะเเสดง '1' ถาเปนจริงและ '0' ถาเปนเท็จ 

 

แถวที่ 10 แสดงใหเห็นวาอาเรยท่ีเรียกวา 'Buy' ท่ีสรางข้ึนโดยเปรียบเทียบคาใน Cond1 เเละ Cond2        

ถา Cond1 มีคา '1' และ สอดคลองกันกับ Cond2 แลวอารเรยนี้จะเเสดงคา 1 เเตหากไมสอดคลอง หรือ           

สอคลองกันในกรณี 0 , 0 ก็จะใหคาเปน 0 

 

 

 

ลองเพิ่มความซับซอนเขาไปอีกหนอย (Getting little bit more complex) 

 

ตัวอยางขางตนนั้นเปนตัวอยางอยางงาย ตอนนี้เราจะมาอธิบาย 3 ส่ิงท่ีดูเหมือนจะสรางความ    

สับสนใหแกผูใชดูกวา 
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·  referencing selected values (SelectedValue, BeginValue, EndValue, 

LastValue) 

·  IIF function 

·  AMA function 

 

อยางที่เขียนในในหัวขอ Tutorial: Basic charting guide แลว คุณสามารถท่ีจะเลือก quote        

ไหนก็ไดจาก chart และคุณสามารถเลือก From-To range ได บารท่ีถูกเลือก โดยแสนแนวต้ังน้ัน        

จะถูกเรียกวา"selected" bar ในขณะท่ี start และ end bar ของชวงท่ีถูกเลือกดังกลาวจะถูกเรียกวา "begin"         

และ "end" bar โดย AFL จะมีฟงกชันพิเศษท่ีสามารถอางอิงคาของอารเรยท่ีถูกเลือกได ฟงกชันน้ีถูกเรียกวา       

SelectedValue, BeginValue และ EndValue นอกจากนี้มันยังมีอีกหน่ึงฟงกชันท่ีเรียกวา LastValue      

ซึ่งจะไดคาอารเรยของบารสุดทาย ท้ัง 4 ฟงกชันนี้ใชองคประกอบของอารเรยท่ีบารท่ีถูกเลือก และ return      

SINGLE NUMBER ของคาอารเรยในจุดท่ีถูกเลือกนั้น ส่ิงนี้จะชวยในการคํานวณสถิติบางประการเก่ียวกับจุดท่ี    

ถูกเลือกนั้นๆ  

 

ยกตัวอยางเชน: 

 

EndValue( Close ) - BeginValue( Close ) 

 

มันจะใหคาที่เปลี่ยนแปลงไปของราคาปดจากชวงท่ีคุณเลือกไว 

 

เมื่อมีตัวเลขถูกดึงคา จากฟงกชันเหลานี้ มันจะถูกนําไปเปรียบเทียบกับ array หรือ ตัวเลขใดๆท่ีเก่ียว      

ของกันทางคณิตศาตร และ array จะถูกดําเนินการดวยตัวมันเอง คลายกับ ตัวเลขท่ีถูกวัดดวย องคประกอบ       

ทั้งหมด ดานลางนี้ คือ ตารางตัวอยาง (แถว 2, 6, 7) สีเขียวหมายถึง "begin" bar และ สีแดงหมายถึง "end"              

bar และสุดทายนี้ bar ที่ถูกเลือกจะเปนสีนํ้าเงิน 
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IIF(condition, truepart, falsepart) ฟงกชัน 

มันจะเเสดงผลของคา truepart หรือไมก็ falsepart ตามเง่ือนไขท่ีกําหนด จากท่ีเราเห็นในเเถวท่ี 8       

เมื่อเงื่อนไขถูกตองจะไดคาเปนราคา Close แตถาเง่ือนไขนั้นผิดจะใหคาของราคา Open ในเคสน้ี IIF      

function จะใหคาไม Close ก็ Open 

 

หมายเหตุ ทั้งอารเรย truepart และ falsepart พวกมันจะไดรับการประเมินโดยไมคํานึงถึงสภาพ      

(ดังนั้นนี้ไมไดเปน IF-ELSE ธรรมดาท่ัวไป แตมันเปนฟงกชันท่ี return คาเปนอารเรย) 

 

 AMA( array, factor) ฟงกชัน 

เปนฟงกชันที่ดูเหมือนวาจะมีปญหามากท่ีสุดในการทําความเขาใจ แตในความเปนจริงมันเปนเร่ืองงาย  

มาก มันทํางานในลักษณะของการเรียกซํ้า (recursive) ก็หมายความวามันจะใชคากอนหนามาเปนสวนหน่ึงใน    

การคํานวณคาปจจุบันดวย เพ่ือใหเขาใจมากข้ึนมาดูตัวอยางการคํานวณคาของ AMA ในคอลัมนท่ี 3     

มันจะใชคา Close จากคอลัมน 3 (1,23) คา Factor (0,4) และคาของตัวมันเองกอนหนาซ่ึงก็คือ AMA          
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(1,0363) คูณดวย (1-Factor = 0,6) จะมีการคํานวณดังนี้ (ปดเลขทศนิยม 4 ตําแหนง) 1,23 * 0,4 +             

1,0363 * 0,6 = 1,1138  

 

ถาคุณดูที่ตัวเลขในแถวท่ี 12 คุณอาจพบวาคาเหลานี้มีลักษณะเหมือนคา moving average ของ      

ราคาปด ซึ่งมันเปนความจริง เราจึงนําเสนอวิธีการคํานวณ EMA โดยใชฟงกช่ัน AMA 

 

 

การสรางลูปใหม (New looping) 

 

Amibroker รุน 4.40 นําความสามารถในการวนของโคด โดยใช  For และ while loop และใชคําส่ัง 

IF-else เพื่อควบคุมการทํางานของการไหล ซึ่งสามารถทําได 2 วิธีดวยกัน  วิธีแรก คือ ตามท่ีไดกลาวไวกอน 

หนาดานบน สวนอีกวิธีหนึ่งก็คือการสราง LOOPS เพ่ือการทํางานท่ีซับซอนมากย่ิงข้ึน ในตัวอยางดังตอไปน้ี 

จะเปนการสราง ตัวแปร exponential averaging เหมือนตัวอยางดานบน แตคราวน้ีจะใชวิธีการ LOOPS 

แทน โดยใชโคดตอไปนี้ 

  

  

Period = ... การคํานวณบางอยาง 

vaexp[ 0 ] = Close[ 0 ]; // คาเร่ิมตนคาแรก 

 for( i = 1; i < BarCount; i++ ) 

{ 

// คํานวณคาตัวแปรของ เฟคเตอรการปรับใหเรียบ (smoothing factor) 

 Factor = 2/(Period[ i ] + 1 ); 

  

//คํานวณคาของ i-th ท่ีเปนองคประกอบของอารเรย 

// ใชราคาปดของบารนั้นๆ ( close[ i ] ) และคาเฉล่ียของบารกอนหนา ( vaexp[ i - 1 ] ) 

vaexp[ i ] = Factor * Close[ i ] + ( 1 - Factor ) * vaexp[ i - 1 ]; 

} 
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มันจะคลายกับการเขียนโปรแกรมภาษาอ่ืนๆ เชน C / Pascal ดังนั้นคนท่ีมีประสบการณเก่ียวกับการ      

เขียนโปรแกรมมาบาง อาจพบวามันงายท่ีจะเขาใจ 

  

ถาคุณเปนมือใหมผมขอแนะนําใหคุณเรียนรู การประมวลผลท่ีหลากหลายกอนท่ีจะ ใชการวนลูปท่ีซับ   

ซอนมากขึ้น SiamQuant 

  

หากคุณกําลังมีปญหาในการเขียนโปรแกรม ผมขอแนะนําใหคุณสรางอารเรยในตัวอยาง ใน Excel    

เพื่อตัวคุณเอง หากเปนปญหาอีก ลองรับความชวยเหลือจากเพ่ือนคุณสิ - โดยเฉพาะอยางย่ิงถาเพ่ือนของคุณ     

เปนนักบัญช ี

 

--- ขอบคุณคุณ Geoff Mulhall เปนอยางสูงสําหรับหัวขอ​ original article in the newsletter          

ซึ่งนํามาใชเปนพื้นฐานของคูมือฉบับนี้--- 

 

สรางอินดิเคเตอรดวยตัวคุณเอง 

(Creating your own indicators) 

 

มีสองวิธีในการสราง indicators ของคุณเอง: 

 

1) ใชอินเตอรเฟซการลากและวาง 

 

2) โดยการเขียนสูตรของคุณเอง 

 

วิธีแรก  ใชอินเตอรเฟซการลากและวางนั้นเปนเร่ืองท่ีงายมาก ๆ 

วิธีที่สอง ​เกี่ยวของกับการเขียนสูตรใน AFL (Amibroker Formular Language) ในตัวอยางน้ีเราจะกําหนด       

"Indicator" ที่จะแสดงกราฟปริมาณเสน (line volume) (ตรงขามกับตัวปริมาณกราฟแทง) 
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เพียงทําตามขั้นตอนเหลานี้ 

 

1.  เลือก Analysis->Formula Editor จากแถบเมนูท่ีแสดงดานลาง: 

 

 

 

2.  คุณจะเห็นหนาตางขอความดังท่ีแสดงในรูปดานลาง บนจอของคุณ : 

 

 

 

 

3.  ตอนนี้คลิกหนึ่งคร้ัง ในชองสีเหลืองดังรูปดานลางเพ่ือใสช่ือของ Indicator ท่ีคุณกําลังจะสราง: 
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ตอนนี้คุณสามารถที่จะแกไขช่ือของ Indicator ของตัวคุณเองไดแลวในท่ีน้ีใชช่ือวา  "My own 

indicator" หลังจากที่คุณกด ENTER ช่ือจะทําการอัพเดต ดวยช่ือใหมท่ีคุณต้ัง แสดงดังรูปดานลาง: 

 

 

 

4.  ที่นี้เขียนโคดดังตอไปนี้: 

 

Plot( Volume, "My volume chart", colorGreen ); 

  

สูตรนี้จะสั่งให Amibroker พล็อตในตัวอารเรย Volume พารามิเตอรท่ีสองระบุช่ือ Indicator 

ที่จะทําการพล็อต และ พารามิเตอรท่ีสามกําหนดสี  

ภาพดานลางแสดงแกไขสูตรหลังจากโคด: 
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5. คลิก Apply (หรือ เลือก Tools->Apply indicator เมนู) 

ตอนนี้ Indicator ที่คุณไดเขียนจะแสดงผลออกมาเปนกราฟ นอกจากมันยังจะเก็บ Indicator 

ของคุณไวเปนสูตรอีกดวย สยามควอนท 
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สามารถเเกไขสูตรไดโดย การคลิกขวาบน pane ของกราฟ และเลือก Edit Formula (หรือแคกด 

Ctrl+E) 

 

 

 

และ ปรับปรุงสูตรโดยการ: 

  

Plot( Volume, "My volume chart", ParamColor("Color", colorGreen ), 

ParamStyle("Style", 0, maskAll ) ); 

 

หลังจากนั้นเลือก Apply indicator เพ่ือใหมันแสดงผลใหม เพ่ืออัพเดตสูตรท่ีเราไดทําการแกไข 

 ตอนนี้คลิกขวาที่ pane ของกราฟอีกคร้ัง และเลือก Parameters (หรือ กด Ctrl+R) 
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ในแท็ป "Axes & Grid" คุณจะสามารถเปล่ียนการตั้งคาสําหรับแกนในสวนน้ี และ การใชกราฟท่ี       

แสดงผลในลักษณะตางๆดังนี้ styles, colors, title และ parameter ใน Indicator น้ันๆ 
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การใชปรับใช styles, colors, titles และ 

parameters ในกราฟ   Indicator  SiamQuant 

(Using graph styles, colors, titles and parameters in 

Indicators) 

 

Amibroker สามารถท่ีจะปรับแตงรูปแบบตางๆ และ ปรับสีของกราฟในตัวช้ีวัดท่ีกําหนดเองได    

คุณสมบัติเหลานี้นั้น ชวยเพ่ิมความยืดหยุนในการออกแบบตัวช้ีวัดของคุณไดมากเลยทีเดียว บทความน้ีจะ   

อธิบายวิธีการใชรูปแบบและสี ดังนี ้

 

Plot() function  

 

เปนฟงกชั่นที่ใชในการพล็อตกราฟ มันประกอบดวย argument ท้ังหมดถึง 9 argument ดวยกัน       

โดยที่ argument ที่จําเปนตองใส คือ 3 อันดับแรก สวนอีก 6 argument ท่ีเหลือ ข้ึนอยูกับความตองการของ           

ผูใช 

 

Plot (Array, “Name”, “Color”, style = StyleLine , MINVALUE = Null, MAXVALUE = Null, XShift               

= 0 ZOrder = 0 width = 1 ) 

- array parameter มายถึง ขอมูลท่ีจะใชในการ plot 

- name parameter หมายถึง ช่ือของของ indicator น้ี 

- color หมายถึง สีของ indicator นี ้

- style หมายถึง รูปแบบของ Chart ใน indicator น้ี ถาไมกําหนด 

จะแสดงผลเปนกราฟเสนโดยอัตโนมัต ิ

- minvalue and maxvalue หมายถึง คาตํ่าสุด สูงสุด ของ indicator น้ี 

- XShift หมายถึง การเล่ือนแผนภูมิ 
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- ZOrder หมายถึง กําหนดตําแหนงแกน Z ของการพล็อตท่ีกําหนด 

- width หมายถึง ความหนาของ Chart 

 

 

ตัวอยาง 

 

Plot( RSI(14), "My RSI", colorRed ); 

  

 

 

การกําหนดคาของสี (Color Constants) 

 

สีที่กําหนดเองนั้นหมายถึง สีท่ีผูใชเปนผูกําหนดเอง ซึ่งสามารถทําไดโดยไปท่ี Tools->Preferences->Colors 

 

colorCustom1 = 0 

colorCustom2 = 1 

colorCustom3 = 2 

colorCustom4 = 3 

colorCustom5 = 4 

colorCustom6 = 5 

colorCustom7 = 6 

colorCustom8 = 7 

colorCustom9 = 8 

colorCustom10 = 9 

colorCustom11 = 10 

colorCustom12 = 11 
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colorCustom13 = 12 

colorCustom14 = 13 

colorCustom15 = 14 

colorCustom16 = 15 

  

colorBlack = 16 

colorBrown = 17 

colorDarkOliveGreen = 18 

colorDarkGreen = 19 

colorDarkTeal = 20 

colorDarkBlue = 21 

colorIndigo = 22 

colorDarkGrey = 23 

  

colorDarkRed = 24 

colorOrange = 25 

colorDarkYellow = 26 

colorGreen = 27 

colorTeal = 28 

colorBlue = 29 

colorBlueGrey = 30 

colorGrey40 = 31 

  

colorRed = 32 

colorLightOrange = 33 

colorLime = 34 

colorSeaGreen = 35 

colorAqua = 35 
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colorLightBlue = 37 

colorViolet = 38 

colorGrey50 = 39 

  

colorPink = 40 

colorGold = 41 

colorYellow = 42 

colorBrightGreen = 43 

colorTurquoise = 44 

colorSkyblue = 45 

colorPlum = 46 

colorLightGrey = 47 

  

colorRose = 48 

colorTan = 49 

colorLightYellow = 50 

colorPaleGreen = 51 

colorPaleTurquoise = 52 

colorPaleBlue = 53 

colorLavender = 54 

colorWhite = 55 

SiamQuant 

ในตัวอยางตอไป จะทําการโคด MACD ท่ีพล็อตเปนสีเขียวเมื่อมันอยูเหนือศูนย และ มีสีแดงเม่ือมัน      

อยูตํ่ากวาศูนย สยามควอนท 

 

dynamic_color = IIf( MACD() > 0, colorGreen, colorRed ); 

 Plot( MACD(), "My MACD", dynamic_color  ); 
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นอกจากการเปลี่ยนสีตามเง่ือนไขท่ีเรากําหนดไดแลวนั้น เรายังสามารถเปล่ียนลักษณะการพล็อตของ 

MACD ใหเปน histogram แทนการพล็อตเปนเสนไดอีกดวย 

 

dynamic_color = IIf( MACD() > 0, colorGreen, colorRed );  

Plot( MACD(), "My MACD", dynamic_color, styleHistogram | styleThick  ); 

 

 

 

หากคุณตองการที่จะพล็อตกราฟแทงเทียน คุณสามารถทําไดโดยใชฟงกชัน styleCandle ไดเลยดัง    

ตัวอยาง 

 

Plot( Close, "Price", colorBlack, styleCandle ); 

 

การพล็อตแบบดั้งเดิมท่ีมีการใชสี (ราคาข้ึนบารสีเขียวและราคาลงบารสีแดง) ท่ีเราตองทําก็เพียงแค   

ระบุสี ตามเงื่อนไขที่คุณกําหนด 

 

Plot(Close, "Price", IIf(Close > Open, ColorGreen, ColorRed), StyleBar|StyleThick); 

 

การกําหนดรูปแบบของกราฟ (Style) (Style Constants) 

 

Style สามารถที่จะกําหนดดวยตัวแปรหลายตัวแปร เชนคุณอาจจะอยากใหกราฟเสนออกมาใน   

รูปแบบของกราฟเสนที่มีความหนา คุณก็จําเปนท่ีจะตองใชคําส่ัง 2 คําส่ังประกอบเขาดวยกัน 

  

styleLine = 1 - กราฟเสนปกติ (เปนคา default) styleHistogram = 2 -กราฟ  histogram  

styleThick =4 - เพิ่มลักษณะใหมีความหนา 

styleDots = 8 - กราฟจุด 
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styleNoLine = 16 - กราฟไมมีเสน 

styleDashed = 32 - กราฟเสนประ  

styleCandle = 64 - กราฟแทงเทียน 

styleBar = 128 - กราฟบาร 

styleNoDraw = 256 - ไมพล็อตกราฟ (แสดงแคเฉพาะแกนของกราฟ)  

styleStaircase = 512 - ลักษณะการพล็อตคลายๆข้ันบันได  

styleSwingDots = 1024 - ใชเปนจุดแบงกลางสําหรับรูปแบบ staircase 

styleNoRescale = 2048 - ไมมีการเปล่ียนสเกล 

styleNoLabel = 4096 - ไมมีปายแสดงคาตางๆของกราฟ 

stylePointAndFigure = 8192 - พล็อตรูปแบบ point and figure  

styleArea = 16384 - พล็อตกราฟใหเปนพ้ืนท่ี (เปรียบเทียบไดกับกราฟ histogram ท่ีมีความกวาง        

มากๆ) 

styleOwnScale = 32768 - พล็อตกราฟดวยสเกลของตัวมันเอง (เปนอิสระตอกันกับกราฟอ่ืนๆ) 

styleLeftAxisScale = 65536 - พล็อตโดยใชสเกลของแกนดานซาย (เปนอิสระของแกนดานขวา      

axis) 

 styleNoTitle = 131072 - ไมแสดงคาของกราฟนี้ดวย หัวขอท่ีเปน string 

styleCloud = 262144 - วาดกราฟลักษณะคลายเมฆ "cloud" (ดูไดจากตัวอยางดานลาง) 

styleClipMinMax = 524288 - พล็อตแยกพ้ืนท่ีระหวาง ระดับ Min และ ระดับ Max (หมายเหตุ:           

style รูปแบบนี้มักใชกับการพล็อตสวนใหญไมได) 

styleGradient - (ใหมตั้งแตเวอรช่ัน 5.60) - การไลระดับของกราฟ สีของการไลระดับดานบน       

ถูกระบุไวในพารามิเตอรของสี ในฟงกช่ัน Plot() การไลระดับของสีของสวนลางก็เชนกัน สีของพ้ืนหลัง     

สามารถกําหนดไดโดย SetGradientFill ฟงกช่ัน styleGradient สามารถใชรวมกับ styleLine ไดเปนอยางดี 
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สูตรของ pane ตรงกลางท่ีเปนสีเรนโบว มีตัวอยางโคดแสดงดังนี้ SiamQuant 

 

side = 1; 

increment = Param("Increment",2, 1, 10, 1 ); 

for( i = 10; i < 80; i = i + increment ) 

{ 

up = MA( C, i ); 

down = MA( C, i + increment ); 

  

if( ParamToggle("3D effect?", "No|Yes", 1 ) ) 
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side =  IIf(up<=down AND Ref( up<=down, 1 ), 1, 0.6 ); 

 PlotOHLC( up,up,down,down, "MA"+i, ColorHSB( 3*(i - 10), Param("Saturation", 128, 0, 

255), side * Param("Brightness", 255, 0, 255 ) ), styleCloud | styleNoLabel); 

} 

 

สูตรของ pane ดานลางเปนดังนี้ โดยใชการประยุกตของฟงกชัน styleClipMinMax เขามาชวยเพ่ือ      

แบงระดับของกราฟ ใหเปลี่ยนสีใหเปนไปตามเง่ือนไขตองการ  

 

SetChartOptions(0,0,ChartGrid30 | ChartGrid70 );  

r = StochK(14); 

Plot( r, "StochK", colorBlack ); 

PlotOHLC( r,r,50,r, "", IIf( r > 50, colorRed, colorGreen ), styleCloud | styleClipMinMax, 

30, 70); 

 

X-shift feature​SiamQuant 

 

XShift เปนพารามิเตอรท่ีสามารถท่ีจะทําใหคุณ Shift กราฟได สามารถทําไดโดยโดยระบุเปน     

จํานวนบารที่เราตองการ Shift เรามาลองดูตัวอยางการ Shift ท่ีใชกับ Moving average กัน 

 

Periods = Param("Periods", 30, 2, 100 ); 

Displacement = Param("Displacement", 15, -50, 50 ); 

  

Plot( MA( C, Periods ), _DEFAULT_NAME(), ColorCycle, styleLine, 0, 0, Displacement ); 

 

PlotForeign() function 
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ดวยฟงกชันนี้จะเปนเร่ืองงายท่ีจะสรางกราฟของราคาของหุนหลายๆตัวพรอมกันโดยใชฟงกช่ัน 

PlotForeign: 

 

PlotForeign( tickersymbol, name, color/barcolor, style = styleCandle | styleOwnScale, 

minvalue = {empty},maxvalue = {empty}, xshift = 0) 

 

โดยใน argument เเรกจะบอกถึงช่ือ ticker ท่ีเราตองการนํามาพล็อต argument ท่ี 2 คือ ช่ือท่ีเรา          

ตองการจะตั้ง argument ที่ 3 คือสี argument ท่ี 4 คือ style ท่ีเราตองการจะพลอต argument ท่ี 5,6 คือ               

คา min max เเละ สุดทายคือ การ shift ตัวอยางการ plot เชน 

 

PlotForeign( "^DJI", "Dow Jones", colorRe ); 

PlotForeign( "^NDX", "Nasdaq 100", colorBlue );  

PlotForeign( "^IXIC", "Nasdaq Composite", colorGreen ); 

 

การพล็อตกราฟหลายๆอันดวยสเกลที่ตางกัน (Multiple plots using different scaling) 

 

ใชคําสั่ง styleOwnScale เเละ styleLeftAxisScale ทําใหสามารถพลอต 2 กราฟหรือมากกวาน้ันได  

 

minimum = LastValue( Lowest( Volume ) );  

maximum = LastValue( Highest( Volume ) ); 

  

Plot( Close, "Price", colorBlue, styleCandle ); 

 */ ตัวอยางการพล็อตท้ังสองอันดานลางนี้จะใชฟงกชัน OwnScale 

แตในสวนของสเกลท่ีแสดงจะเปนสเกลปกติเนื่องจากเราไดกําหนดคา min และ max ของแกน Y 

ไว*/ 

Plot( Volume, "Volume", colorGreen, styleHistogram | styleThick | styleOwnScale, 

minimum, maximum ); 
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Plot( MA( Volume, 15 ), "MA volume", colorRed, styleLine |styleOwnScale, minimum, 

maximum ); 

  

 

ถาหากเปลี่ยนมาใช : styleLeftAxisScale = 65536 - 

จะสามารถที่จะพล็อตกราฟมากกวาหนึ่งกราฟไดโดยใชสเกลปกติ แตจะตางกันท่ีสเกลของแกนดานขวา (right 

axis) 

 

ตัวอยาง : การพล็อต ราคา โวลุม และ moving average : SiamQuant 

 

// พล็อตราคา และ moving average ของตัวมันเอง 

Plot( Close, "Price", colorWhite, styleCandle ); 

 Plot( MA( Close, 20 ), "MAC", colorRed ); 

  

// พล็อตโวลุม และ moving average ของตัวมันเอง โดยใชสเกลทางดานซายมือ 

Plot( Volume , "Volume", colorBlue, styleLeftAxisScale | styleHistogram | styleThick ); 

Plot( MA( Volume,15), "MAV", colorLightBlue, styleLeftAxisScale ); 

  

การสรางพารามิเตอรใหมๆข้ึนมาเพ่ิม เพ่ือใหงายเวลาพล็อต Ribbon ยกตัวอยางเชน: 

 

Plot( Close, "Price", colorBlue, styleCandle ); 

Plot( 2, /* กําหนดความสูงของ ribbon ในหนวยของ %ความกวางของ pane*/ "Ribbon", IIf( up, 

colorGreen, IIf( down, colorRed, 0 )), /* เลือกสี */ 

styleOwnScale|styleArea|styleNoLabel, -0.5, 100 ); 
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การใชการกําหนดพารามิเตอรดวยตนเอง (Using custom defined parameters) 

 

Amibroker ชวยใหผูใช สามารถท่ีจะกําหนดการสรางพารามิเตอรเองได โดยพารามิเตอรจะสามารถ    

ปรับใชกับ indicator ไดอยางสะดวกและรวดเร็ว สยามควอนท 

 

·  Param( "name", default, min, max, steps, incr = 0 ); 

·  ParamStr( "name", "default" ); 

·  ParamColor( "name", defaultcolor ); 

·  ParamStyle(''name'', defaultval = styleLine, mask = maskDefault ); 

 

ฟงกชันเหลานี้จะทําใหคุณสามารถกําหนดคาพารามิเตอรใน indicator ของคุณไดเอง และ เม่ือคุณใช 

ฟงกชั่น Param พารามิเตอรตางๆท่ีคุณตองการท่ีจะแกไขสามารถทําไดโดยเพียงแคการคลิกขวาบน pane 

ของกราฟ หรือ กด Ctrl + R เทานั้น ไมจําเปนตองเขามาแกในโคด  

 

ตัวอยาง อยางงายที่สุดในการใช ฟงกชันดังตอไปนี้: 

  

period = Param("RSI period", 12, 2, 50, 1 ); 

Plot( RSI( period ), "RSI( " + period + ") ", colorRed ); 

 

คลิกขวาที่ chart และ เลือก "Parameter" จากนั้นเล่ือนลงมาคุณจะเห็น RSI พล็อตดวยระยะเวลาท่ี 

แตกตางกัน (กําหนด Period ตางกัน) 

 

โคดตัวอยางดานลางแสดงใหเห็นถึงวิธีการใช ParamStr เพ่ือใชกับ ticker และ ParamColor เพ่ือใช 

กับสีของกราฟ 

 

ticker = ParamStr( "Ticker", "MSFT" ); sp = Param( "MA Period", 12, 2, 100 ); PlotForeign( 

ticker, "Chart of "+ticker, 
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ParamColor( "Price Color", colorBlack ), styleCandle ); Plot( MA( Foreign( ticker, "C" ), 

sp ), "MA", ParamColor( "MA Color", colorRed ) ); 

 

ตัวอยางงายๆของ formula โดยการพล็อตจุดสูงสุด ตํ่าสุดของ กราฟ sine: 

 

Cycle = Param("Cycle Months", 12, 1, 12, 1 )*22;//264==12 เดือน,22==1เดือน  

xfactor = Param("Stretch",1,0.1,2,0.1);//1==1 ป ,2==2 ป 

xshift = Param("slide",0,-22,22,2)/3.1416^2;//slide curve 1==5 วัน 

  

x = 2*3.1416/Cycle/xfactor; y = sin(Cum(x)-xshift); 

  

Plot(C,"Daily Chart", colorBlack, styleCandle | styleNoLabel);  

Plot(y, "cycle =" + WriteVal(Cycle*xfactor/22,1.0)+"months", 

colorBlue,styleLine|styleNoLabel|styleOwnScale); 

  

คลิกขวาบน Chart และ เลือก "Parameters" จากนั้นลองเลือกเปล่ียนคาพารามิเตอรบางอยาง      

คุณจะเห็นการเปลี่ยนแปลงของกราฟไดทันที 

 

สําหรับใครอยากศึกษาเกี่ยวกับ Parameter เพ่ิมเติม คุณสามารถท่ีจะศึกษาเพ่ิมเติมไดท่ี Tutorial:     

Using drag-and-drop interface 

 

การพล็อตขอความตัวหนังสือลงบนกราฟ (Plotting texts at arbitrary positions on 

the chart) 

  

PlotText( "text", x, y, color, bkcolor = colorDefault ) โดยท่ี 

x - คือ x-coordinate ในหนวยของบาร (เหมือนกับ LineArray) 

y - คือ y-coordinate ในหนวยของราคา 
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color คือ สีของตัวหนังสือ , bkcolor คือ สีของพ้ืนหลัง ถา bkcolor ไมไดระบุไว (หรือใหคาเทากับ           

colorDefault) ตัวหนังสือที่แสดงจะถูกเขียนลงบนพ้ืนหลังท่ีเปนพ้ืนหลังแบบ TRANSPARENT(พ้ืนหลังแบบไม   

มีสี หรือโปรงใส) SiamQuant 

ตัวอยางเชน 

 

Plot(C,"Price", colorBlack, styleLine );  

Plot(MA(C,20),"MA20", colorRed ); 

  

Buy=Cross( C, MA(C,20 ) ); 

Sell= Cross( MA( C, 20 ), C ); dist = 1.5*ATR(10); 

for( i = 0; i < BarCount; i++ ) 

{ 

if( Buy[i] ) PlotText( "Buy\n@" + C[ i ], i, L[ i ]-dist[i], colorGreen );  

if( Sell[i] ) PlotText( "Sell\n@" + C[ i ], i, H[ i ]+dist[i], colorRed, colorYellow ); 

} 

  

PlotShapes( Buy * shapeUpArrow + Sell * shapeDownArrow, IIf( Buy, colorGreen, 

colorRed ) ); 

  

การใสสีแบบไลระดับลงบนพื้นหลัง (Gradient fill of the background) 

 

ฟงกชั่นนี้จะชวยใหคุณสามารถเติมสีพ้ืนหลังโดยการไลระดับสีของ indicator ได ขอใหคุณทราบไว    

วาการไลระดับพื้นหลังดวยวิธีนี้จะมีความเปนอิสระตอ (ไมมีความเกี่ยวของตอกัน) กันจากสีพ้ืนหลังของ Chart    

ที่มีอยูเดิมแลว พารามิเตอรมีดังนี้ : 

 

topcolor - ระบุสีดานบนของการไลระดับสี 

fill bottomcolor -  ระบุสีดานลางของการไลระดับสี 
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titlebkcolor - (เสริม) สีพ้ืนหลังของขอความท่ีแสดงผล ถาไมไดระบุไว สีท่ีกําหนดไวดานบนจะถูกนํา 

มาใชโดยอัตโนมัต ิ

 

ตัวอยาง  

 

SetChartBkGradientFill(ParamColor("BgTop",colorWhite),ParamColor("BgBottom", 

colorLightYellow)); 

 

  

การไลระดับสีบนพื้นที่ของกราฟ (Gradient fill area charts) 

 

การไลระดับสีที่เรียบงาย สามารถแสดงผลไดโดยใช : 

 

Plot( C, "C", colorDefault, styleGradient | styleLine ); 

  

ในกรณีที่ตองการควบคุมรายละเอียดของการไลระดับของสีมากกวาปกติ คุณควรท่ีจะเรียกใช ฟงกช่ัน   

นี้กอนเปนอันดับแรก SetGradientFill( topcolor, bottomcolor, baseline, baselinecolor )กอนท่ีคุณ       

จะไปใชฟงกชั่นพล็อต  Plot() 

 

สวนพารามิเตอรที่ใชเปนตัวเลือกของคุณคือ baseline/baselinecolor น้ันสามารถใหสีของกราฟมี   

การไลระดับที่ยอนกลับได(เชนกราฟของ underwater equity) และประกอบดวย 3 สีดวยกันคือในสวนของ      

top->baseline->bottom นอกจากนี้ คุณสามารถดูโคดของกราฟ Underwater Equity เพ่ือใชเปนกรณี      

ศึกษาการไลระดับของสีแบบยอนกลับได(โดยท่ีมี baseline อยูบนจุดสูงสุด) พารามิเตอร Baseline น้ันจะ      

เปนการระบุคา คาหนึ่งบนแกน Y ในสวนของ พารามิเตอร baselinecolor น้ันจะเปนการระบุสีของการไล       

ระดับ ที่ใชในแตละสวน ถาคุณไมไดระบุสีของ baselinecolor จะมีการไลระดับของสีแคเพียง 2 สวนเทาน้ัน       

คือ การไลระดับจาก topcolor->bottomcolor SiamQuant 
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ยกตัวอยางเชนหนาจอแสดงผลของการไลระดับของ three-color gradient Rate Of Change จะใช       

สีเขียว ที่จุด "top" สําหรับคาท่ีเปนบวก สีของพ้ืนหลังเหมทอนกับสีของ"baseline" และ สีแดงเปนจุด       

"bottom" สําหรับคาที่เปนลบ การระบุเง่ือนไขขางตนสามารถเขียนโคดออกมาไดดังตัวอยางดานลาง: 

 

การสีไลระดับของสีดานบน จะถูกระบุโดยอารกิวเมนต topcolor และ การสีไลระดับของสีดานลาง     

จะถูกระบุโดยอารกิวเมนต botttomcolor พารามิเตอรท่ีไมจําเปนตองใสไวก็ไดก็คือ (baselinecolor)    

สําหรับการใชงานตัวอยางของการไลระดับสี Chart ยอนกลับ (มีพ้ืนฐานท่ีดานบน) พารามิเตอรพ้ืนฐานระบุ     

ตําแหนงแกน Y ของพื้นฐาน Chart พารามิเตอร baselinecolor ระบุสีของการไลระดับสีท่ีจะนํามาใชใน       

ระดับที่วา หาก baselinecolor ไมไดระบุแลวเทานั้นการไลระดับสี 2 สีคือพล็อต (topcolor ->        

bottomcolor) 

 

ยกตัวอยางเชนในการแสดงสามสีไลระดับสีอัตราการเปล่ียนแปลงท่ีจะใชสีเขียวเปน "ดานบน" สีสํา   

หรับคาบวกสีพื้นหลังเปน "พื้นฐาน" สีและสีแดงเปน "ดานลาง" สีคาลบก็พอท่ีจะเขียน 

 

SetGradientFill( colorGreen /*ดานบน*/, colorRed /*ดานลาง*/, 0 /*ระดับของ baseline*/,        

GetChartBkColor() /*สีของ baseline*/); 

Plot( ROC( C, 14), "ROC", colorLightOrange, styleLine | styleGradient, Null, Null, 0, -1); 

 

 

 

หรือ ถาในกรณีที่ใชธีมสีดํา 
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การทําใหกราฟมีความหนา (Super thick charts) 

  

Plot( C, "Close", colorDefault, styleBar, Null, Null, 0, 1, -20 /* เสนของกราฟจะมีความหนา            

ในหนวยของ%ของบาร*/ ); 

  

ตอนนี้คุณสามารถรับสายหนาสุดท่ีแสดงในตัวอยางดานลางนี้ (เสนกราฟท่ีมีความหนา10 พิกเซล): 

 

Plot( C, "Close", colorRed, styleLine, Null, Null, 0, 1, 10 /*หนา 10 พิกเซล*/); 

 

จิปาถะ (Miscellaneous) SiamQuant 

 

Variable Usage Applies to 

Title กําหนดช่ือหัวขอดวยตัวหนังสือ (text) หากคุณใชตัวแปร   

title คุณสามารถระบุสีตางๆใน string นั้นๆได เราแนะนํา     

ใหคุณใชฟงกช่ัน AFL EncodeColor เพราะมันเปนวิธี    

การท่ีงายกวาการใช การโคดตามปกติ EncodeColor   

(ColorNumber) และ คุณสามารถเขียนตัวอยางขางตนได   

ดังนี้ สยามควอนท 

  

Title = "This is written in " + EncodeColor(         

colorViolet ) + "violet color " + EncodeColor(        

Indicators 
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colorGreen ) + "and this in green";  

  

สามารถใสคําบรรยายใตเสนหลายๆอัน ไดโดยเพียงใช \ n    

ในการแบงคําบรรยาย ตัวอยางเชน: 

Title = "This is 1st line\nThis is second line"; 

  

เพ่ือความครบถวนสมบูรณ: สีนอกจากนี้ยังสามารถระบุโดย  

ใชลําดับ Espace แตก็ไมแนะนําเพราะ เปนเร่ืองยากท่ีจะ    

เขียนและยากท่ีจะอาน \\ ลําดับ cXX XX ซ่ึงเปน 2       

หลักหมายเลขดัชนีการระบุสี \\ C38 - กําหนดสีมวงมีลําดับ     

พิเศษ \\ C-1 ท่ีจะเร่ิมตนรีเซ็ตสีแกน 

 

ตัวอยางเชน 

 

เพ่ือความครบถวนสมบูรณ : การกําหนดสีตางๆสามารถทํา   

ไดโดย การใชวิธีการโคดแบบปกติ(การเรียงลําดับ) แตเราไม   

แนะนําใหทําอยางนั้น เพราะมันยากท่ีจะเขียน และ ยากท่ี    

จะอาน \\cXX เปนการเขียนเรียงลําดับ เมื่อ XX คือเลข 2       

หลักท่ีใชระบุสีของดัชนี\\c38 - กําหนดใหเปนสี violet    

\\c-1 คือการ resets ไปสูคา default ของสีของแกน 

ยกตัวอยางเชน 

 

Title = "This is written in \\c38violet color \\c27and         

this in green"; 

Tooltip ลาสมัยในเวอรช่ัน 5.40. 

การใชหนาตางของขอมูล แทนท่ีจะใชฟงกชัน Plot() ดวย    

styleHidden  

ถาคุณตองการท่ีจะเพ่ิมคาท่ีคุณกําหนดดวยตัวเองไปยัง data  

tooltip สามารถทําไดดังตัวอยางดังตอไปนี้  

 

Indicators 
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Plot( my_value, "MyValueForTooltip", colorBlack, 

styleHidden ); 

GraphXSpace วาหนดวาควรจะมีพ้ืนท่ีวางเทาไหรอยูเหนือ/ใตกราฟ(ในหนว

ย %) 

ตัวอยางเชน: 

 

GraphXSpace = 5; 

เพ่ิมพ้ืนท่ีวาง 5% ท้ังบนและลางของกราฟ เม่ือเราไมไดกํา 

หนดคาของ GraphXSpace คา default ของมันจะเทากับ 

2% 

Indicators 

 
  

GraphLabelD

ecimals 

(ใหมในเวอรช่ัน 5.90) 

เปนการควบคุมตําแหนงของทศนิยมในกราฟ (เชน หากคุณ 

ใช GraphLabelDecimals = 2; คาตางๆท่ีแสดงบนหนา 

กราฟจะมีคาทศนิยม 2 ตําแหนง) 

Indicators 

GraphZOrder ตัวแปร GraphZOrder จําชวยใหคุณเปล่ียน ลําดับของ 

การพล็อตลงบนกราฟได เมื่อ GraphZOrder ไมไดถูก 

กําหนดคาไว หรือมีคาเปนศูนย(false) - คําส่ังลําดับเกา 

ท่ีสุดจะถูกใชกอน (last to first)และเมื่อ GraphZOrder 

เทากับ 1 (true) - จะเปนการเรียงลําดับในทางตรงกันขาม 

Indicators 
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คุณจะสรางตัว Exploration ดวยตัวเองไดอยางไร 

(How to create your own exploration) 

 

เครื่องมือ Exploration นั้น ถือไดวาเปนอีกหนึ่งเคร่ืองมือ ท่ีมีประโยชนมากๆใน Amibroker      

มันมีลักษณะคลายๆกับการ Scan แตตางกันตรงท่ี ผลลัพธของกระบวนการจะไมไดโชวแตสัญญาณการซ้ือขาย    

เพียงเทานั้น แตยังสามารถนําไปใช Screen ขอมูลตามท่ีผูใชตองการไดอีกดวย ซ่ึงใหมันไดผลลัพธของขอมูล     

มากกวาการ Scan แบบปกติ 

 

การทํางานของ Exploration นั่นงายมาก เพียงแคเราใสคําส่ัง filter ซ่ึงเปนตัวคัดกรองวาขอมูลไหน      

ตรงตามเกณฑที่เราตองการ หากขอมูลนั้นตามเกณฑของเรา มันจะถูก Assign เลข 1 และ แสดงบนรีพอรท        

ของเรา 

 

ตัวอยางเชน ถาหากเราจะตองการคนหาเคร่ืองหมาย (หุน) ท่ีมีราคาปดมากกวา 50 บาท ก็ใหเขียน       

โคดดังนี้ 

 

filter = close > 50; 

 

(หมายเหตุ: หากจะเขียนโคดใหมใหเปด Formula Editor โดยการไปท่ี Analysis->Formula Editor       

menu พิมพโคดลงไป และ เลือก Tools->Send to Analysis menu ใน Formula editor) 

 

การ Explore นั้น หากผูใชเลือก "All quotations" ขอมูลท้ังหมดท่ีตรงตามเกณฑของผูใชก็จะข้ึนมา       

ในรีพอรท หากคุณตองการใหมันสแกนเฉพาะเพียง bar ลาสุดก็ใหเลือกใช "1 recent bar(s)" 

 

ผูใชยังสามารถสราง Column ใน Exploration เพ่ือนําออกไปยังท่ีอ่ืนๆได (จากผูแปล : เชนหากคุณ        

จะนําไปวิเคราะหตอใน excel) โดยการใชคําส่ัง AddColumn (พิมพลงในโคดของการ Explore) SiamQuant 
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AddColumn( Close, "Close" ); 

 

ขอมูลแรกในคําสั่ง AddColumn คือ “array” ท่ีผูใชตองการ สวนขอมูลตัวท่ีสองคือ “ช่ือ” ของชอง        

column ที่ผูใชตองการจะตั้ง 

 

ถาหากคุณกดปุม Explore คุณจะพบกับรูปแบบรีพอรทดังนี้ 

 

 

สังเกตไดวาจะมีอยู 3 คอลัมน ท่ีช่ือ  Ticker, Date/Time และ Close (array ท่ีผูใชตองการจะ explore) 

 

หากคุณกดปุม Export ไฟลจะถูกเปล่ียนเปนไฟลสกุล CSV(comma separated values) ซ่ึง       

สามารถนําไปเปดบน Excel ได 

 

คําสั่ง AddColumn ยังสามารถกําหนดรูปแบบคอลัมนท่ีหลากหลายไดมากข้ึน กวาตัวอยางขางตนได    

อีก ฟงกชั่นเต็มๆของมันประกอบดวยขอมูลดังนี้ (ขอมูลท่ีคุณจําเปนตองกรอกน้ันมีเพียงแค 2 ขอมูลแรกเทา     

นั้น) สยามควอนท 
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AddColumn( array, name, format = 1.2, textColor = colorDefault, bkgndColor =           

colorDefault ) 

 

format - จะกําหนดตัวเลขทศนิยมลงทาย โดย default แลว ตัวเลขจะมีทศนิยม 2 ตําแหนง (1.2)          

ถาหากเปลี่ยนเปน 1.5 คือ ทศนิยม 5 ตําแหนง 1.0 ไมมีทศนิยม ดังนั้น หากคุณเขียนโคด  
 

AddColumn( Close, "Close", 1.4 ); 

 

จะใหราคาปดทศนิยม 4 ตําแหนง 

  

นอกจากนี้ยังมีรูปแบบ Format อีกมากมาย 

 

formatDateTime – ฟอรแมตรูปแบบวันและเวลาตามท่ีผูใชตองการ 

 

AddColumn( DateTime(), "Date / Time", formatDateTime ); 

 

formatChart - สามารถแปรผล ASCII character codes : 

 

ตัวอยางเชน: 

 

Buy=Cross(MACD(),Signal());  

Sell=Cross(Signal(), MACD());  

 

Filter=Buy OR Sell;  

SetOption("NoDefaultColumns", True ); 

AddColumn( DateTime(), "Date", formatDateTime );  

AddColumn( IIf( Buy, 66, 83 ), "Signal", formatChar ); 
 

textColor และ bkgndColor จะปรับเปล่ียนสีบนรีพอรทของผูใช  
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ตัวอยางเชน หากผูใชตองการจะใหตัวเลขราคาปดเปนสีเขียวเมื่อ rate of change เทียบกับ 1 

วันที่แลวมากกวาศูนย ถาหากนอยกวาศูนยใหเปล่ียนเปนสีแดง ใหเขียนโคดดังน้ี SiamQuant 

 

AddColumn( Close, "Close", 1.4, IIF( ROC(C, 1 ) > 0, colorGreen, colorRed ) ); 
 

ตัวอยาง 
 

ผูใชสามารถ export database ไปยัง CSV file โดยเขียนโคดดังนี้  
 

filter = 1; /* ใชคําสั่งนี้กับทุกๆสัญลักษณ */ 

 

AddColumn(Open,"Open",1.4);  

AddColumn(High,"High",1.4);  

AddColumn(Low,"Low",1.4); 

AddColumn(Close,"Close",1.4);  

AddColumn(Volume,"Volume",1.0); 
 

ตัวอยางนี้จะไดผลลัพธออกมาเปน เคร่ืองหมายท่ีมีปริมาณการเทรดจํานวนมาก  

 

filter = volume > 5000000; /* ปรับแตงปริมาณ Volume ตามตองการ 

เพื่อกรองหลักทรัพยที่มีสภาพคลองนอยๆออกไป */ 

 

AddColumn(Close,"Close",1.4);  

AddColumn(Volume,"Volume",1.0); 

 

หรือ ใหเครื่องหมายที่มี volume มากกวา 30% ของ 40-day exponential average 

 

filter = volume > 1.3 * ema( volume, 40 );  

AddColumn(Close,"Close",1.4);  
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AddColumn(Volume,"Volume",1.0); 

 

คุณสามารถ Export มันเพื่อนําไปใชวิเคราะหเพ่ิมติมตามตองการได 

 

filter = close > ma( close, 20 ); /* คัดแตหุนท่ีมีราคาปดสูงกวา MA 20 วัน*/ 

 

AddColumn( macd(), "MACD", 1.4 ); 

AddColumn( signal(), "Signal", 1.4 ); 

AddColumn( adx(), "ADX", 1.4 ); 

AddColumn( rsi(), "RSI", 1.4 ); 

AddColumn( roc( close, 15 ), "ROC(15)", 1.4 ); 

AddColumn( mfi(), "MFI", 1.4 ); 

 AddColumn( obv(), "OBV", 1.4 ); 

AddColumn( cci(), "CCI", 1.4 ); AddColumn( ultimate(), "Ultimate", 1.4 ); 
 

อีกตัวอยางหนึ่งที่ใชลูกเลนกับสีของผลลัพธ 

 

Filter =1; 

 

AddColumn( Close, "Close", 1.2 ); 

AddColumn( MACD(), "MACD", 1.4 , IIf( MACD() > 0, colorGreen, colorRed ) ); 

AddTextColumn( FullName(), "Full name", 77 , colorDefault, IIf( Close 

< 10, colorLightBlue, colorDefault ) ); 
 

กราฟ Scatter (X-Y) พล็อต ใน Exploration (Scatter (X-Y) charts in Exploration) 
 

เวอรชั่น 5.60 มี Feature ใหมคือ scatter X/Y charts เพ่ือนําไปใชหาความสัมพันธของ หลักทรัพย          

แตละตัวในเชิง Correlation, Risk และอ่ืนๆ ซึ่งเปน feature ท่ีพัฒนามาจาก "Risk/yield" map         
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ผูใชสามารถสราง scatter X/Y charts โดยการใส XYChartAddPoint สําหรับคา X,Y ท่ีผูใชตองการท่ีจะใส         

บนกราฟ 

 

ยกตัวอยางเชน คุณตองการจะหาความสัมพันธของ MFE/Profit และ MAE/Profit ก็สามารถใช      

XYChartAddPoint AFL function เพ่ือใชในการชวยหาความสัมพันธดังกลาวได 

 

หากตองการจะสราง risk/yield scatter chart จาก Feature นี้ ใหคุณทําตามข้ันตอนดังตอไปน้ี 

 

1.  File -> New -> Analysis 

 

2.  เลือก "Formulas\Exploration\RiskYield.afl" file (มุมขวาตามในภาพดานลาง) 

 

3. กด Explore บนหนาตาง Analysis window 

 

4. ผูใชจะเห็น "Risk/Yield" tab อยูดานลาง ใหคลิกท่ี tab นั้น โปรแกรมจะแสดงผล ดังภาพดังดานลางน้ี 
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. 

// XY scatter chart  

// นี่คือแผนภาพ Risk-Yield map 

// หมายเหตุ เลือกใชขอมูลรายสัปดาห 

// คํานวณหาผลตอบแทนเฉล่ียรายสัปดาห (yield) 

// และ SD ของผลตอบแทนนั้นๆ(risk) 
 

Filter=Status("lastbarinrange");  

Length = SelectedValue( BarIndex()); 

 Chg = ROC( C, 1 ); // yieldของ1bar// 

yield = MA( Chg, Length - 1); 

risk = StDev( Chg, Length - 1);  

AddColumn(yield,"yield");  

AddColumn(risk,"risk"); 
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Clr = ColorHSB( 2 * Status("stocknum") % 255, 255, 255 ); 

 

XYChartAddPoint( "Risk/Yield", Name(), risk[ Length ], yield[ Length ] , Clr ); 

XYChartSetAxis("Risk/Yield", "Risk[%]", "Yield[%]"); 
 

 

เคล็ดลับสงทาย (Final tip) 
 

คุณสามารถจะเรียงลําดับขอมูลบนรีพอรทของคุณได เพียงแคคลิกท่ี Header ของแตละคอลัมน 

มันจําทําการเรียงขอมูลตามลําดับ SiamQuant 
 

วิธีการเขียนคอมเมนทบนชารท  

(How to write your own chart commentary) 
 

หนึ่งในประโยชนของการใชภาษา AFL นั้น คือการเขียนคอมเมนทบนชารทของผูใช โดยมีหลักการ     

ดังนี้ สยามควอนท 

 

1. แตละคอมเมนทจะประกอบไปดวย 2 สวน สวนท่ีหนึ่งคือ ตัวอักษรธรรมดา (Static Text) และ 

สวนที่สองคือ ภาษา AFL 

2. AmiBroker จะโชวคอมเมนทของหลักทรัพยท่ีผูใชเลือกอยู และ 

ขอความจะเปลี่ยนไปตามวันเวลาท่ีผูใชเลือก (Dynamic Content) 

3. ขอความตัวอักษรธรรมดา และ สวนท่ีเปนภาษา AFL จะออกมาในหนาตางคอมเมนท 

4. ผูใชสามารถพลอตสัญญาณซื้อขายเขาไปในหนาตางไดอีกเชนกัน  

 

Commentaries สามารถเขาถึงไดโดยไปท่ี Analysis->Commentary เม่ือคุณเปดหนาตาง    

Commentary ออกมาคุณจะเห็นแท็บ 2 แท็บ Commentary และ Formula บนแท็บ Formula         
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ผูใชสามารถพิมพภาษา AFL เพ่ือให Amibroker ประมวลผลออกมา สวนในหนาตางแท็บ Commenta       

ในสวนถัดๆไปจะอธิบายขั้นตอนการเขียนคอมเมนทเพ่ิมเติม 

 

การเขียนอักษรธรรมดา (Writing static texts)  
 

ทุกๆครั้งที่ผูใชจะเขียนอักษรธรรมดา จะตองมีเคร่ืองหมายคําพูดคลุมประโยคน้ันไว และลงทายดวย ; 

เสมอ เชน 

 

"This is sample static text statement"; 

 

คุณสามารถเขียนหลายๆประโยคได และ แตละประโยคจะข้ึนเปนบรรทัดใหมบนหนาตาง  

 

"This is first line of text"; "This is second line of text"; 

 

ผูใชลองพิมพประโยคดานบนลงบนหนาตาง Formula และ เปดหนาตาง Commentary จะพบกับ      

ขอความที่ไมมี เครื่องหมายคําพูดหรือ ; ประกบไวอยูเนื่องจาก Amibroker ไดแปลงขอความในเคร่ืองหมาย      

คําพูดเปน String เอาไวและโชวแต String บนหนาตาง Commentary 

 

คําแนะนําสําหรับผูใช คือ ควรจะพิมพ ฟงกชัน printf กอนจะพิมพขอความทุกๆคร้ัง 

 

printf( "This is sample static text statement" ); 
 

ถาหากตองการจะเขียนขอความหลายๆบรรทัดผูใชสามารถใช break sequence ('\n') 

เพื่อเปนตัวเปลี่ยนบรรทัดแทนได : 

 

printf( "This is first line of text\nThis is second line of text\nThis is third line of text" ); 

 

คุณสามารถแบงขอความออกเปนสวนๆได โดยการเขียนโคด ดังนี้ : 
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printf( "This" + " is" + “single"+ ”line" + "of text" ); 
 

 

สีและไสตล (Colors and styles) 
 

ในเวอรชั่น 5.9 ขึ้นไป จะรองรับการเปล่ียนสี และ ไสตลของขอความ หากคุณจะตองการทําใหขอ       

ความ มีความหนา ใหคุณขึ้นตนดวย <b> และ ลงทายดวย </b> เชนเดียวกันกับตัวเอียง <i>และ </i>          

หากจะเปลี่ยนสีใหใชคําสั่ง EncodeColor ดังตัวอยางดานลาง 

 

printf("<b>Bold text</b>\n");  

printf("<i>Italic text</i>\n"); 

printf("Now " + EncodeColor( colorRed ) + "red text\n"); 

printf("and finally " + EncodeColor( colorGreen ) + "green <b>AND bold <i>AND 

italic</i></b>\n"); 

printf(EncodeColor( colorBlack ) + "going back to black"); 
 

ขอความที่แปรไปตามการประมวลผล (Dynamic content)  
 

ขอความที่กลาวไปเม่ือสักครูนี้เปนเพียงขอความตัวอักษรธรรมดา หากผูใชตองการจะใสขอความท่ี  

ผานการประมวลผล ผูใชตองพิมพ Function เขาไป Function 2 ตัวท่ีสําคัญท่ีสุดคือ NumToStr() และ         

WriteIF() ฟงกชัน WriteIF() จะถูกอธิบายในสวนถัดไป เรามาเร่ิมจากฟงกชัน NumToStr() 

 

คูมือ Amibroker กลาวไววา: 

 
SYNTAX NumToStr( NUMBER ); 

NumToStr( ARRAY ); 

RETURNS STRING 

FUNCTION ฟงกชันน้ีใชไดแคบน guru commentary เทาน้ัน 

ไวแสดงคาที่เปนตัวเลขของ NUMBER หรือ ARRAY 
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ยกตัวอยางเชน: 
 

printf( NumToStr( close ) ); 
 

เมื่อคุณเปดหนาตาง Commentary คุณจะพบกับราคาปดซึ่งเปนคาเดียวกันกับBar ท่ีผูใชเลือกเอาไว     

ในกรณีที่ผูใชเลือก Bar อื่น และ กด Refresh ราคาปดจะเปล่ียนไปตามราคาของวันท่ีคุณเลือกเอาไว ดังน้ัน        

NumToStr( close ) จะโชวราคาปด และ ขอมูลอ่ืนๆของ Bar ท่ีผูใชเลือก   

 

printf( NumToStr( macd() ) ); 
 

ผูใชจะเห็นคาของ MACD ของ Bar ท่ีผูใชเลือกเอาไว เราสามารถเขียนสูตรไดดังน้ี 
 

printf( "Closing price = " + NumToStr( close ) + "\n" ); 

printf( "Change since yesterday = " + NumToStr( close - ref( close, 

-1 ) ) + "\n" ); 

printf( "Percent chg. since yesterday = " + NumToStr( roc( close, 1 ) 

) + " %%\n" ); 

printf( "MACD =" + NumToStr( macd() ) + " , Signal line =" + 

NumToStr( signal() ) + "\n" ); 

 

เมื่อเปดหนาตาง Commentary ผูใชจะพบกับ  
: 

Closing price = 17.940 

Change since yesterday = -0.180 

Percent chg. since yesterday = -0.993 %  

MACD = -0.001 , Signal line = 0.063 

 

ผูใชสามารถพิมพ name() date() เพ่ือใหหนาตาง Commentary โชวช่ือหลักทรัพย และ วันท่ีผูใช        

เลือกเอาไว : 
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printf( "Statistics of " + name() + " as of " + date() ); 
 

ผูใชสามารถใชเครื่องหมาย printf flexible % format แทน NumToStr ในการเปล่ียนตัวเลขเปน        

String ตัวอยางเชน การใช %.2f หมายความวาใชแสดงตัวเลขออกมาพรอมกับทศนิยม 2 ตําแหนง %.3f        

แปลวาตัวเลขพรอมทศนิยม 3 ตําแหนง %g แปลวาใหแสดงตัวเลขตามทศนิยมท่ีเกิดข้ึนจริงๆ  

 

ตัวอยางเชน  

 

printf( "Closing price = %.3f\n", close ); 

printf( "Change since yesterday = %.3f\n", close - ref( close, -1 ) ); 

 printf( "Percent chg. since yesterday = %.2f%%\n", roc( close, 1 ) );  

printf( "MACD = %.4f, Signal line = %.4f\n", macd(), signal() ); 
 

คุณจะสังเกตไดวาตัวโคด ส้ัน และ ดูงายข้ึน สวนแรกของฟงกชัน printf คือ String ท่ีแสดงขอความ         

และตัวเลข สวนที่สอง คือ คาท่ีผูใชอยากให Commentary แสดงออกมา มีอีกขอสังเกตหน่ึงคือ หากผูใชตอง        

การจะใสหนวยเปนเปอรเซ็นตจะตองใชเคร่ืองหมาย %% ซํ้ากัน 2 คร้ัง 

 

ในกรณีที่ผูใชตองการให Commentary แสดงขอความเมื่อผานเกณฑใดเกณฑหน่ึงน้ัน จะตองใช    

คําสั่งที่จะอธิบายในลําดับตอไป 

 

เงื่อนไขตางๆของผลลัพธที่มีลักษณะเปนตัวหนังสือ (Conditional text output) 
 

คําสั่ง WriteIF() จะแสดงผลตามเกณฑท่ีผูใชตั้งเอาไว SiamQuant 

 

SYNTAX writeif( EXPRESSION, "TRUE TEXT", "FALSE TEXT" ) 

RETURNS STRING 

FUNCTION ฟงกชันน้ีใชไดแคบน guru commentary เทาน้ัน ถาหาก 

EXPRESSION เปนจริง คาของ TRUE TEXT จะแสดงข้ึนมาบน 
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commentary แตถา EXPRESSION ไมเปนจริง คาของ 

FALSE TEXT จะแสดงข้ึนมาบน commentary 

 

ผูใชสามารถใหหนาตาง Commentary แสดงผลตามท่ีตองการ  

 

เชน 

 

writeif( macd() > signal(), "The MACD is bullish because is is above it's signal line", 

"The MACD is bearish because it is below its signal line" ); 

 

ผูใชสามารถสรางเกณฑตางๆมากข้ึน ดังนี้ 

 

"The current market condition for "+ name() + " is: "; 

 

avgcond1 = ( c > ema( close, 200) ) + 0.1 * ( close > ema( close, 90)) + 0.1 * ( close > 

ema( close , 30 ) ); 

 

avgcond2 = -( c < ema( close, 200) ) - 0.1 * ( close < ema( close, 90) ) - 0.1 * ( close < 

ema( close , 30 ) ); 

 

WriteIf( avgcond1 == 1.2, "Very Bullish",  

WriteIf( avgcond11 == 1, "Bullish",  

WriteIf( avgcond1 == 1.0, "Mildly Bullish", "") ) ) +  

WriteIf( avgcond2  == -1.2, "Very Bearish",  

WriteIf( avgcond2 == -1.1, "Bearish",  

WriteIf( avgcond2 == -1.0, "Mildly Bearish", "") ) ); 
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โคดดานบนจะแสดงผล "The current market condition for {ช่ือหลักทรัพยของคุณ} is: Very         

Bullish"เมื่อราคาปดมากกวา ราคาเฉล่ีย 30, 90, และ 200 วัน ในกรณีอ่ืนๆ Commentary จะแสดงคา          

Bullish, Mildly Bullish, Mildly Bearish, Bearish หรือ Very Bearish ตามเง่ือนไข 

 

โคดอื่นๆสามารถหาไดจาก  AFL formula library​ โดยเฉพาะ  MACD commentary  

ถึงตอนนี้ผูใชก็สามารถสราง Commentary เปนของตัวเองไดแลว 
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การใชงานเคร่ืองมือวาดบนสตร AFL 

(Using studies in AFL formulas) 
 

ตั้งแต AmiBroker เวอรช่ัน 3.52 ข้ึนไป มีระบบการอางอิงเสน หรือ ส่ิงท่ีผูใชวาดดวยตัวเองซ่ึงถือวา        

เปนจุดเดนเมื่อเทียบกับซอฟตแวรอ่ืนๆ  

 

ผมจะสาธิตใหดูวิธีการตรวจสอบวาเสนเทรนดไลนนั้นเบรคหรือยัง ส่ิงเราตองทํา มีเพียงแค 3 ข้ันตอน 

 

1. วาดเทรนดไลน 

2. กําหนด Study ID 

3. เขียนสูตรที่ระบุวา เสนเทรนดไลน จะถูกเบรคอยางไร 

 

การวาดเสนเทรนดไลน (Drawing trend line) SiamQuant 
 

เสนเทรนดไลน คือเสนความชันท่ีลากจากจุดหนึ่งไปยังจุดหนึ่ง 

 

ในตัวอยางนี้เราจะวาดเสนเทรนดไลนขาข้ึน ซึ่งมักจะลากจากจุดตํ่าสุดไปยัง 

จุดตํ่าสุดใกลเคียงของเทรนดขาข้ึน หรือท่ีเรียกกันวาเสนแนวรับ 

 

วิธีการวาดเสนเทรนดไลนนั้น ใหผูใชเลือก "Trend line" tool จาก "Draw" 

 toolbar และหาจุดตํ่า (Troughs) อยางนอยสองจุดเพ่ือลากเทรนดไลน 

กําหนด Study ID (Define study ID) 
 

คุณสามารถดัดแปลงเสนเทรนดไลนท่ีคุณวาดข้ึนมา เพียงคลิกขวาท่ีตัวเสน  

และ เลือก "Properties" ผูใชสามารถระบุจุดกําเนิด และจุดจบของเสนใหมได นอก 

จากนี้ผูใชยังสามารถเลือกสีเสน ไสตล และยืดเสนออกไปไดอีกตามตองการ 
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ในตัวอยางนี้หากผูใชอยากจะศึกษาแนวโนมในอนาคต กใหเลือก right-extended trend line เพ่ือ      

ใหเสนเทรนดไลนนั้นยืดออกไปทางดานขวา 
 

ตั้งแตเวอรชั่น 3.52 ผูใชสามารถกําหนด "Study ID" ได ซึ่งตัว "Study ID" น้ีเอง ท่ีจะทําใหผู           

ใชสามารถตั้งชื่อเสนที่ผูใชวาดข้ึนมาเองได โยท่ีมันจะถูกระบุดวยตัวภาษาอังกฤษสองตัว โดยตัวอักษร Default    

คือ "UP" - uptrend, "DN" - downtrend, "SU" - support, "RE" - resistance, "ST" - stop loss                 

แตอยางไรก็ตามคุณสามารถเรียกเสนท่ีคุณวาดข้ึนมาตามตองการ ภายใตขอจํากัดท่ีวา ใสไดแค 2 ตัวอักษร     

ดังนั้นหากคุณวาดเสนแนวรับในสัญลักษณหลายๆตัวแลวตั้งช่ือมันวา “SU” คุณสามารถนําตัวอักษร 2 ตัวน้ี     

เปนตัวอางอิงในโคดของคุณได 
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ดังนั้นเราจะเรียกเสนเทรนดไลนท่ีเราวาดข้ึนมาวา "SU"  
 

การเขียนโคดเพื่อระบุการเบรคของเสนเทรนดไลน (Write the formula that checks 

trend line break)​สยามควอนท 
 

ในตัวอยางนี้เราจะหาจังหวะที่ราคาปดเบรคเสนเทรนดไลนท่ีเปนแนวรับ ดังน้ี: 

 

sell = cross( study( "SU" ), close, GetChartID() ); 

 

สังเกตไดวา study() function คลุม 2 คําส่ัง : 

 

อยางแรกคือ StudyID ท่ีระบุตัวอักษรภาษาอังกฤษสองตัว อางอิงเสนท่ีผูใชวาด และ อยางท่ีสองคือ       

chart ID ซึ่งคําสั่ง default น้ันคือ GetChartID() ซึ่งจะอางอิง indicator ปจจุบัน ผูใชสามารถศึกษาเพ่ิมเติม          

ในสวนของ Parameter dialog, Axes & Grid: Miscellaneous: Chart ID ได 
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การ Backtest ไอเดียการเทรดของคุณ 

(Back-testing your trading ideas) 

 

  เกริ่นนํา (Introduction) 
 

ผูใชสามารถ Backtest กลยุทธการลงทุนตางๆ กับ ขอมูลในอดีตได ในหนาตาง Analysis ซ่ึงทําใหผู        

ใชสามารถทราบถึงจุดแข็งและจุดออนของระบบการลงทุนกอนลงทุนดวยเงินจริง  SiamQuant 
 

การเขียนกฎการลงทุน (Writing your trading rules) 
 

ขั้นตอนแรกผูใชตองกําหนดเปาหมาย หรือ กฎ ของระบบในการส่ังคําส่ังซ้ือขาย ผูใชตองคิดระบบ     

ขึ้นมาเองใหเหมาะสมกับความเส่ียง ขนาดของพอรตโฟลิโอ การบริหารเงิน และ ปจจัยตางๆของตัวผูใชเอง     

เมื่อไดกฎเหลานั้นแลว นํามาเขียนเปนสัญญาณซื้อขาย ใน AmiBroker Formula Language (รวมไปถึงการ       

Short และ การ Cover) 

 

ในบทนี้เราจะมาดูระบบท่ีใช Moving Average บอกสัญญาณซื้อขายกัน ระบบจะทําการซ้ือหุนเม่ือ     

ราคาปดตัดเหนือเสน ema 45 และขายหุนตัวนั้นเมื่อราคาปดตัดเสน ema45 ลงมา exponential moving        

average ใน AFL คือ EMA ผูใชเพียงแคระบุระยะเวลาเฉล่ียของราคาปดท่ีอยากจะนํามาคํานวณ 

 

ema( close, 45 ); 

 

ตัว close  เปนคา default ใน Amibroker บงบอกถึงราคาปดของเคร่ืองหมายท่ีเราสนใจ 

 

เราจะใชคําสั่ง 

 

buy = cross( close, ema( close, 45 ) ); 
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คําสั่งดานบนเปนกฎการซื้อของระบบ คาท่ีออกมาจะเปน "1" หรือ "true" เม่ือราคาปดตัดเหนือเสน      

ema( close, 45 ) หลังจากนั้นเราสามารถเขียนคําส่ังขาย ซึ่งจะใหคา "1" เมื่อราคาปดตัดเสน ema( close,          

45 ) ลงมาเชนกัน: 

 

sell = cross( ema( close, 45 ), close ); 
 

ขอสังเกตคือเราใชคําส่ัง Cross เพียงแตสลับตัวแปรในนั้น ใหตรงกันขามกัน คําส่ังท้ังสองจะออกมาใน     

รูปแบบดังตอไปนี้ 

 

buy = cross( close, ema( close, 45 ) );  

sell = cross( ema( close, 45 ), close ); 

 

หมายเหตุ : หากจะเปดแผงเขียนโคด Formula Editor สามารถเขาไดจาก Analysis->Formula       

Editor พิมพโคด และ สงคําส่ัง Tools->Send to Analysis 

 

การ Back Test (Back testing) 

 

การ Backtest ระบบนั้นผูใชเพียงกดคําส่ัง Back test ในหนา analysis window ผูใชตองม่ันใจวาได         

ใสคําสั่งของระบบที่มีการกําหนดเง่ือนไขการ ซื้อ และ ขายไวกอนทําการ Backtest เรียบรอยแลว หลังจากน้ัน       

Amibroker จะทําการวิเคราะหเคร่ืองหมายท่ีผูใชเลือกอยู ตามระบบการลงทุน และ ใหผลลัพธออกมา ผูใช      

สามารถ Backtest หลักทรัพยเปนพันๆตัวภายในไมกี่นาที โดยท่ี Amibroker จะคํานวณระยะเวลาโดย      

ประมาณในการ Backtest ใหผูใชไดเห็น หากผูใชตองการหยุดการ Backtest เพียงกดปุม cancel เทาน้ัน 

 

การวิเคราะหผลลัพธ (Analysing results) 

 

เมื่อขั้นตอนการ Backtest เสร็จส้ิน จะมีหนาตางท่ีแสดงผลการจําลองการเทรดตามระบบ ท่ีผูใชได     

สรางขึ้นมา (the Results pane) ผูใชสามารถตรวจสอบสัญญาณซื้อขายเพียงดับเบิ้ลคลิก ตรงรายการ      
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จําลองเทรด ระบบจะแสดงจุดซื้อจุดขายเมื่อตรงตามเง่ือนไข ผูใชสามารถเรียกหนาตางอ่ืนๆเพียงคลิกขวาตรง   

รายการเทรดจําลอง 

 

หากผูใชตองการผลการวิเคราะหผลใหละเอียดข้ึนใหเขาท่ีหนาตาง Report รายละเอียดของคาตางๆ   

จะอยูในสวนของ report window description 

 

การเปลี่ยน Setting (Changing your back testing settings) 

 

ผูใชสามารถเปลี่ยน Setting ของการ Backtest ซึ่งประกอบไปดวย ขนาดของพอรตจําลอง ระยะ       

เวลา จํานวนคาคอมมิชชั่น อัตราดอกเบี้ย Maximum Loss และจุด Take profit ตามตองการ หากเปล่ียน          

Setting แลว ผูใชตองกด Backtest อีกคร้ัง เพ่ือใหคาเปนไปตาม Setting ท่ีเปล่ียนไป 

  

ตัวอยางเชน หาผูใชตองการจะทดสอบขอมูลรายอาทิตยใหเปล่ียน Settings เปน Weekly ในชอง 

Periodicity และกด Back test อีกคร้ัง SiamQuant 

 

คําสั่ง Default (Reserved variable names) 

 

ตัวแปร ความหมาย ใชกับหนาตาง 

buy สั่งใหทําการเขาซื้อแบบ Long Automatic 

Analysis, 

Commentary 

sell สั่งใหทําการขายแบปด Long Automatic 

Analysis, 

Commentary 

short สั่งใหทําการเขาซื้อแบบ Short Automatic 

Analysis 

cover สั่งใหทําการขายแบบปด Short Automatic 

Analysis 
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buyprice ระบุราคาซื้อแบบ Long ตามตองการ( หากไมระบุจะกําหนดตามคา 

default ที่ต้ังไวบน Automatic Analyser settings) 

Automatic 

Analysis 

 

 

sellprice ระบุราคาขายแบบปด Long ตามตองการ( หากไมระบุจะกําหนดตามคา 

default ที่ต้ังไวบน Automatic Analyser settings) 

Automatic 

Analysis 

shortprice ระบุราคาซื้อแบบ Short ตามตองการ( หากไมระบุจะกําหนดตามคา 

default ที่ต้ังไวบน Automatic Analyser settings) 

Automatic 

Analysis 

coverprice ระบุราคาขายแบบปด Short ตามตองการ( หากไมระบุจะกําหนดตามคา 

default ที่ต้ังไวบน Automatic Analyser settings) 

Automatic 

Analysis 

exclude ไมพิจารณาเคร่ืองหมายนั้นๆในโหมด scan/exploration/back test 

มีประโยชนเมื่อผูใชอยากจะโฟกัสการวิเคราะหกับหุนกลุมๆหน่ึงโดยเฉพาะ 

Automatic 

Analysis 

roundlotsize ใชในโหมด backtest เพ่ือระบุหนวยการลงทุน 

(ดูคําอธิบายเพ่ิมเติมดานลาง) 

Automatic 

Analysis (new in 

4.10) 

ticksize กําหนด tick size เพ่ือนําไปเทียบเคียงกับราคาท่ีเกิดข้ึนจาก built-in 

stops โดยท่ีไมสงผลกระทบตอ 

buyprice/sellprice/shortprice/coverprice(ดูคําอธิบายเพ่ิมเติมดานลาง

)) 

Automatic 

Analysis (new in 

4.10) 

pointvalue กําหนด contract point value ของ Future ได(ดูในหมวดหมู 

backtesting​ ​futures​) โดยท่ัวไปแลวจะตั้งคาไวท่ี 1 

Automatic 

Analysis (new in 

4.10) 

margindepos

it 

กําหนด contract margin ของ Future ได (ดูในหมวดหมู  backtesting 

futures​) 
Automatic 

Analysis (new in 

4.10) 

positionsize กําหนดจํานวนเงิน หรือเปอรเซ็นตของเงินทุนท้ังหมดในการเขาซ้ือแตละคร้ัง 

(ดูคําอธิบายเพ่ิมเติมดานลาง) 

Automatic 

Analysis (new in 

3.9) 
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คอนเซประดับสูง (Advanced concepts ) 
 

Amibroker นั้นมีคําสั่งท่ีซับซอน ซึ่งจะกลาวถึงในบทถัดๆไป ผูใชควรจะทําความเขาใจคอนเซปการ 

Backtest เบื้องตนกอนเนื้อหาท่ีจะกลาวถัดไป 

 

เมื่อคุณพรอมแลว เราจะมาแนะนําคําส่ังท่ีไดกลาวถึงเมื่อกี ้

 

a) AFL scripting host for advanced formula writers (ข้ันตอนสําหรับนักเขียนโคดท่ีมีประสบการณ) 

b) enhanced support for short trades (การ Short) 

c) the way to control order execution price from the script (การกําหนดราคาเขาซ้ือขาย) 

d) various kinds of stops in back tester (การวาง Stop loss ) 

e) position sizing (การกําหนด Position Size) 

f) round lot size and tick size (จํานวนหุนท่ีจะซื้อขาย) 

g) margin account (บัญชี Margin) 

h) backtesting futures​ (อื่นๆ) 

 

AFL scripting host เปนคําส่ังท่ีซับซอนและจะถูกพูดถึงในหมวดหมูถัดๆไป เราจะมาแนะนําตัวอ่ืนๆ     

กัน 

 

การชอรท (Short trade support) 
 

 เวอรชั่น 3.59 ขึ้นไปสามารถสงคําส่ัง short ไดและคําส่ังอ่ืนๆ: สยามควอนท 

 

buy - "true" หรือมีคาเทากับ 1 ใหเปด long  

sell - "true" หรือมีคาเทากับ 1 ใหปด long  

short - "true" หรือมีคาเทากับ 1 ใหเปด short 

cover - "true" หรือมีคาเทากับ 1 ใหปด short 
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หากผูใชตองการใชกลยุทธ stop-and-reverse system ใหแทนคําส่ังซื้อขายดังกลาว SiamQuant 

 

short = sell;  

cover = buy; 

 

ปจจุบัน Amibroker สามารถสงคําส่ัง long และ Short ไดดวยกัน 

 

// กฎการเชาซื้อและออกของ  long trade:  

 

buy = cross( cci(), 100 ); 

sell = cross( 100, cci() ); 

 

// กฎการเชาซื้อและออกของ  short trade:  

 

short = cross( -100, cci() ); 

cover = cross( cci(), -100 ); 

 

ในกรณีนี้หาก CCI อยูระหวาง -100 และ 100 คุณจะออกจากตลาด 
 

การกําหนดราคาซื้อ (Controlling trade price) 
 

AmiBroker สามารถใหผูใชกําหนดราคาซื้อขายตามตองการ: buyprice, sellprice, shortprice และ 

coverprice 

 

ผูใชสามารถควบคุมราคาซื้อขายได 

 

BuyPrice = IIF( dayofweek() == 1, HIGH, CLOSE ); 

//สงคําสั่งซื้อตอนวันจันทร ใหซื้อราคา High วันอ่ืนๆใหซื้อราคา Close 
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สามารถเขียนคําสั่ง Stop-Order: 

 

BuyStop = ...ใสคําส่ังของ ระดับ Buy Stop;  

SellStop = ... ใสคําส่ังของระดับ Sell Stop; 

 

// ถาหากราคายืนเหนือระดับ Buy Stop 

//(high>buystop) ซ้ือเมื่อราคาถึง buystop level  

 

Buy = Cross( High, BuyStop ); 

// ถาหากราคาอยูตํ่ากวาระดับ Sell Stop  

//( low< sellstop )ขายเมื่อราคาตํ่ากวา Sellstop level 

Sell = Cross( SellPrice, SellStop); 

 

BuyPrice = max( BuyStop, Low ); //ใหมั่นใจวาราคาซื้อไมตํ่ากวา ราคาต่ําสุด 

SellPrice = min( SellStop, High ); //ใหมั่นใจวาราคาขายไมสูงไปกวา ราคาสุงสุด 

 

AmiBroker ระบุ buyprice, sellprice, shortprice และ coverprice เปนคําส่ัง Default  

 

ขณะ back-testing AmiBroker จะเช็ควาราคา buyprice, sellprice, shortprice, coverprice        

อยูในกรอบของ high-low ของแตละวันหรือไม แล ะจะปรับราคาซื้อขายเหลาน้ัน ใหเปน high price        

เมื่อราคาสูงกวา ราคาที่สูงที่สุด และ ใหเปน low price เมื่อราคาตํ่ากวา ราคาต่ําท่ีสุดในวันน้ัน 
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การตั้ง Stop (Profit target stops) 

 

ดังที่เห็นกันบนภาพดานบนของ Setting สําหรับ Profit Target Stop น้ัน ระบบจะทําการ Take          

Profit เมื่อ ราคาสูงที่สุดของวันนั้นอยูเหนือ Stop Level ท่ีตั้งกันเอาไว ซ่ึงอาจจะอยูในรูปของ Percent        

จากราคา ซื้อ โดยทั่วไป Stop จะถูกดําเนินการตามราคา Sell และ ราคา Cover ท่ีผูใชต้ังเอาไว ซ่ึงสามารถ           

ปรับเปลี่ยนบน "Exit at stop" feature ได 
 

"Exit at stop" ​SiamQuant 
 

ตัวอยางเชนเมื่อคุณเลือก Exit Stop แลวตั้งคาไวท่ี +10% จากราคาซ้ือ 50 ตัว stop order จะทํา 

งานเมื่อราคาขึ้นไปสู 55 ถึงแมวาคุณจะกําหนดราคาขายดวยตัวเลขอ่ืนก็ตาม (เชนราคาปดท่ี 56)  
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Maximum loss stops ก็ทํางานเชนเดียวกัน Stop จะทํางานเมื่อราคาต่ําท่ีสุดของวันน้ัน ต่ํากวาจุด 

Stop ที่ตั้งเอาไว 
 

Trailing stops 
 

การ Stop ชนิดนี้จะเปนตัว Stop ท่ีเคล่ือนท่ีตามราคา New High ของแตละวัน ทําใหตัวจุด Stop          

เองไมอยูนิ่ง หากเมื่อราคาลงมาตํ่ากวา trailing stop ท่ีเคล่ือนท่ีตามราคา new high ลาสุด Stop จะทําการ          

ทันที ดังภาพตัวอยางดังกลาว (10% Trailing Stop)  
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ตัว Stop ที่กลาวมานั้นสามารถปรับเปล่ียนจาก Automatic analysis' Settings window หรือ ผูใช         

สามารถโคดเอาเองได ผาน ApplyStop function: สยามควอนท 

 

ตัวอยางเชน : 

 

ApplyStop( 2, 1, 10, 1 ); // 10% trailing stop, percent mode, exit at stop ON 

 

หรือเขียนในรูปแบบ 

 

 ApplyStop( stopTypeTrail, stopModePercent, 10, True ); 

 

Trailing stops ยังสามารถในรูปแบบของ points (dollars) และ percent of profit (risk)          

สําหรับขอมูลตัวที่สองนั้นหากผูใชตั้ง Stop ไวท่ี 20% percent ของ profit (risk) ตัว stop จะทํางานเม่ือ           

โอกาสทํากําไรคือ $100 แตผลกําไรนั้นตกไปเหลือ $80 
 

Dynamic stops 
 

ฟงกชั่น ApplyStop() ใหผูใชสามารถเลือกลักษณะของ Stop ตอแตละการ Trade ได ซ่ึงผูใชอาจจะ        

สราง volatility-based stop ตางๆ ข้ึนมาเองก็เปนได 

 

ตัวอยางเชน การสราง Stop ที่จะปรับเปล่ียนตาม 10 day average true range: 

 

ApplyStop( 0, 2, 2 * ATR( 10 ), 1 ); 

 

หรือ  

 

ApplyStop( stopTypeLoss, stopModePoint, 2 * ATR( 10 ), True ); 
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จะทําให ตัว Stop อยูหางจากราคาเขาซื้อ ลงมา 2 เทาของ 10 Days ATR 

 

เมื่อ ATR เปลี่ยนจากการเทรดในแตละคร้ัง Stop level จะมีลักษณะท่ี dynamic และ เปล่ียนตาม         

เชนกัน ขอสังเกตคือ Parameter ท่ี 3 ของฟงกชัน ApplyStop (the amount) ข้ึนอยูกับราคา Entry และ            

จะอยูจนกวาการ trade ครั้งนั้นจะจบส้ิน ดังนั้นในตัวอยางท่ีเราตั้งคา Stop ไวตาม ATR(10) จากวัน entry         

หากผูใชปรับแตง ATR จะไมมีผลตอ Stop ท่ีตั้งเอาไว 

 

ดูรายละเอียเพิ่มเติมไดท่ี APPLYSTOP  
 

การเขียนโคดสรางจุด Stop (Coding your own custom stop types) 
 

ผูใชสามารถตั้งโคด ApplyStop ข้ึนมาเองตามตองการ  SiamQuant 

 

ตัวอยางเชน  

 

/* ตัวอยางการตั้ง Profit-target stop บน AFL: */ 

 

Buy = Cross( MACD(), Signal() ); 

priceatbuy=0; 

 

for( i = 0; i < BarCount; i++ ) 

{ 

if( priceatbuy == 0 && Buy[ i ] ) priceatbuy = BuyPrice[ i ]; 

 

if( priceatbuy > 0 && SellPrice[ i ] > 1.1 * priceatbuy ) 

{ 

Sell[ i ] = 1; 

SellPrice[ i ] = 1.1 * priceatbuy; 
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priceatbuy = 0; 

} 

else 

Sell[ i ] = 0; 

} 
 

Position sizing 
 

เวอรชั่นใหม 3.9 ปรับปรุงการออกแบบ Position sizing  

 

PositionSize = <size array> 

 

ผูใชสามารถคุมจํานวนเงินลงทุน ตามจํานวนหรือ % ของ portfolio ตอแตละการเทรดได  

 

ระบุจํานวนเงินตามตองการ trade  

ยกตัวอยางเชน:  

 

● PositionSize = 1000; // ลงทุน $1000 ในทุกๆการเทรด 

● ตัวเลขติดลบบงบอกถึงหนวยท่ีเปน % เชน -100..-1 มีหนวยเปน %: 

-100 คือ 100% ของ portfolio size, 

-33 คือ 33% ของ equity เปนตน: 

 

PositionSize = -50; /* ลงทุนแคคร่ึงหนึ่งของ equity */ 

 

หรือ แมแต สยามควอนท 

 

 PositionSize = - 100 +RSI(); 
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คา RSI เปลี่ยนจาก 0..100 คา RSI ท่ีตํ่าทําใหคุณลงทุนมากข้ึน 

 

หากคุณไมไดลงเงินทั้งหมด 100% เงินท่ีเหลือจะนําไปทบตามดอกเบี้ยท่ีผูใชต้ังเอาไว 

 

นอกจากนี้ผูใชสามารถเลือกคําส่ัง "Allow position size shrinking" ใน Setting กรณีท่ี position         

size เกินจํานวนเงินที่ถืออยู เม่ือผูใชเลือกคําส่ังนี้ position ในการเขาลงทุนจะลดตาม Cash ท่ีเหลืออยู 

 

หากตองการจะดู position sizes ใหผูใชเลือก "Trade list with prices and positionsize" ใน           

report mode บน AA settings window 

 

กอนจะจบในสวนนี้ นี่คือตัวอยางของ Position size ท่ีเปล่ียนไปตามคา ATR : 

 

Buy = <ใสเงื่อนไขของการซื้อของคุณท่ีนี่>  

Sell = 0; //ขายเฉพาะเมื่อถึง Stop 

 

TrailStopAmount = 2 * ATR( 20 ); 

Capital = 100000; /* หมายเหตุ: ใหตั้งคานี้บนหนาตาง Setting ในชอง Initial Equityดวย*/ 

 Risk = 0.01*Capital; 

PositionSize = (Risk/TrailStopAmount)*BuyPrice;  

ApplyStop( 2, 2, TrailStopAmount, 1 ); 

 

สรุปใจความไดดังนี้ : total equity ตอ 1 การลงทุนคือ $100,000, และ ต้ังระดับความเส่ียงไวท่ี 1%           

ของ total equity ระดับความเส่ียหรือ Risk level ถูกกําหนดโดยเง่ือนไขดังน้ี ถาหาก trailing stop ของหุน           

ที่ราคา $50 stock อยูที่ $45 (คาของ 2 ATR ตามท่ีเซ็ทไวใน Trilling Stop), ระดับขาดทุน $5 น้ันจะถูก              

นําไปหารดวย $1000 risk และไดจํานวนหุนท่ีควรจะซื้อตามความเส่ียงท่ีรับไดท่ี 200 หุน ดังน้ันความเส่ียง       

ของการลงทุนในครั้งนี้ถูกตั้งข้ึนไวท่ี $1000 แตการกระจายความเส่ียงนั้นข้ึนอยูกับการซ้ือหุน 200 หุน x      

$50/หุน หรือ $10,000 สรุปคือ เราใชเงินเพียง 10% ของ Equity ในการลงทุนแตมีความเส่ียงท่ีจะเสียเงินลง         

ทุนเพียงแค $1000 
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จํานวนหนวยการลงทุน และ การเคล่ือนไหวของราคา (Round lot size and tick size) 

Round lot size  

ผลิตภัณฑทางการเงินทุกชนิดยอมมีหนวยในการลงทุน Amibroker สามารถใหผูใชเลือกไดวา การลง    

ทุนในแตละครั้งจะตอซื้อผลิตภัณฑนั้นๆกี่หนวยเชน ในหลัก 10s หรือ 100s (จากผูแปล : เชน ในตลาดหุนไทย         

ขั้นตํ่าคือตองซื้อ 100 หุน) 

 

คุณสามารถเลือก หนวยการลงทุน ตอแตละหลักทรัยไดในหนาตาง Symbol -> Information page       

(รูปที่. 3) จํานวนศูนยหมายถึงไมระบุหนวยลงทุน และ จะถูกตั้งเปนคา "Default round lot size" (การต้ังคา          

สากล) จาก Automatic Analysis settings page (รูปท่ี 1) ในกรณีนี้ผูใชสามารถใหระบบเขาซ้ือผลิตภัณฑ         

ทางการเงินนั้นดวยหลัก เศษสวน (fractional number) เชนกัน 

 

ผูใชสามารถเขียนโคดระบุ lot size ผาน AFL formula ดวยฟงกชัน RoundLotSize  

 

ตัวอยางเชน: 

 

RoundLotSize = 10; 
 

Tick size  

Tick Size ระบุการเคล่ือนไหวของราคาท่ีตํ่าท่ีสุด (minimum price move) ผูใชสามารถระบุได       

ทั้งหมดหรือ แคหุนรายตัว บนคําส่ัง Symbol->Information page (รูปท่ี 3) เลข 0 จะหมายความวาต้ังคา          

"default tick size" บนหนา Settings page (รูปท่ี 1) ซึ่งหมายความวาไมระบุคาต่ําสุดของการเคล่ือนไหว         

ของราคา 

 

ผูใชสามารถเขียนโคดระบุ tick size ผาน AFL formula ดวยฟงกชัน TickSize ตัวอยางเชน: 

 

TickSize = 0.01; 
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tick size setting จะมีผลตอเทรดท่ี Exit โดยใช built-in stops หรือ ApplyStop() เทาน้ัน ตัว            

backtester นั้นจะอนุมาน tick size requirements ท่ีมากับตัวราคาเองอยูแลว ดังน้ันการเปล่ียนคา tick        

size จะมีผลตอแคการเทรดที่มีการตั้ง built-in stops ทําใหจุด exit points น้ันเปล่ียนแปลงตาม tick size          

ที่ผูใชระบุ ตัวอยางเชน ที่ประเทศญี่ปุน ผูใชตองตั้งคา ticksize = 1 ทําใหการ exit น้ันจะ exit ในจุดท่ีเปน            

จํานวนเต็ม สยามควอนท 

 

บัญชี Margin (Margin account) 

 

Account margin ระบุ % ของ margin requirement สําหรับ entire account คา Default ของ             

Account margin จะอยูที่ 100 ซึ่งหมายความวาผูใชจะตองลงเงิน 100% จํานวนเต็มในการลงทุน เวอรช่ันน้ี        

Amibroker ใหผูใชสามารถตั้งคา Margin ได ซึ่งก็คือเงินท่ียืมมาเพ่ือใชในการลงทุน ตัวอยางเชน ถากฎ       

ระเบียบปจจุบันอนุโลมใหใชเงิน Margin 50% ของการลงทุน หากเงินเร่ิมตนของคุณคือ 10000 คุณจะมีกําลัง       

ในการซื้อถึง 20000 ทําใหผูใชสามารถลงทุนไดมากข้ึน เงิน Margin นี้ไมเก่ียวของกับการเทรด Futures       

แตอยางใด ผูใชสามารถจําลองการเทรดหุนโดยใชเงิน Margin ท่ีวานี้ 

 

Setting อื่นๆ (Additional settings) 

 

● "Reverse entry signal forces exit" check box ใน Backtester settings 

เมื่อปรับคาเปน ON (default) หมายความวาถาผูใชเปด Position ตรงขามจะหักลาง Position       

กอนหนานี้ ถาตั้งคาเปน OFF การเปด Position ตรงขามจะไมมีผลตอ Position ท่ีเปดคางเอาไว 

 

● "Allow same bar exit (single bar trade)" ทางเลือกใน Settings 

เมื่อปรับคาเปน ON (default)  ผูใชสามารถเขา และ ออก Postitionใน Bar เดียวๆกันท้ัง entry 

และ exit ถาตั้งคาเปน Off หมายความวา การ exit จะเกิดข้ึนใน bar ถัดๆไป เทาน้ัน 
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● "Activate stops immediately"เหมาะสําหรับผูใชท่ีตั้งราคาซื้อเปนราคา Open เพราะปญหาใน     

เวอรชั่นเกาที่ backtester อนุมานวาผูใชจะเขาซื้อในราคาปด ถาหากผูใชไมเลือกชองน้ี ระบบจะ     

อนุมาน Normal Exit ซึ่งก็คือ Sell ในราคา open ของ bar ถัดไป SiamQuant 

 

ผูใชอาจจะสงสัยวาทําไมไมเลือก buyprice หรือ shortprice ในกรณีท่ีเทากับราคาเปด เปนเพราะ  

วันที่เกิด doji ระบบไมสามารถแยกแยะไดวาการ Trade เขาตอนราคาปดหรือเปด  

 

● "Use QuickAFL" QuickAFL(tm)  เปน Feature ท่ีทําให AFL คํานวณตัวเลขไดเร็วข้ึนในบางสภาพ 

สําหรับเวอรชั่น 5.14 ข้ึนไปสามารถใชในหนาตาง Automatic Analysis ได 

 

จุดเริ่มตนของ Feature นี้เกิดข้ึนเพ่ือใหระบบคํานวณและวาด Chart ไดเร็วข้ึน หนาตาง automatic       

analysis window สามารถใชประโยชนจากคําส่ังนี้เมื่อ parameter ของขอมูลน้ันนอยกวา“All     

quotations" 

 

คําอธิบายอยางละเอียดของ Feature นี้อยูในลิงคดังกลาว: 

http://www.amibroker.com/kb/2008/07/03/quickafl/ 

 

Feature นี้สามารถใชงานไดท้ังใน backtester, optimization, exploration และ scan 

สามารถดูในไดในหัวขอ : 

 

Portfolio-level backtesting  

 

Backtesting systems for futures contracts​ APPLYSTOP function description 

Using AFL editor section of the guide. 

 

Insider guide to backtester (newsletter 1/2002) 
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Portfolio-level backtesting 
 

สําคัญ: โปรอานคูมือนี้มากอนl:  Backtesting your trading ideas article 

 

Backtest ตัวใหมนี้สามารถใชงานไดในระดับพอรตโฟลิโอ ซึ่งอางอิงกับ Portfolio Equity น่ันก็คือ      

จํานวนเงินทั้งหมดที่เหลืออยูรวมกับ Position ท่ีเปดเอาไว portfolio backtester ทําใหผูใชสามารถผสม      

ผสาน กลยุทธการลงทุน money management และ การควบคุมความเส่ียงในระดับพอรตโฟลิโอ เสมือน       

การเทรดจริง Position size ก็จะปรับระดับตามพอรตโฟลิโอเชนกัน 

 

ขั้นตอนการติดตั้ง (HOW TO SET IT UP ?) 
 

มีเพียง 2 ขั้นตอนในการ Setup  

 

1. ผูใชตองมีโคดที่ระบุ buy / sell / short /cover signals ดังท่ีอธิบายไวใน " Backtesting your trading 

ideas​"  
 

2. ผูใชตองระบุจํานวนในการเทรดและ Position size ของการเทรดในแตละคร้ัง  
 

การตั้งจํานวน position สูงสุดในการเทรดหนึ่งคร้ัง (SETTING UP MAXIMUM NUMBER 

OF SIMULTANEOUSLY OPEN TRADES) 
 

มี 2 วิธีในการตั้งคา จํานวนการเขาเทรดท่ีสูงท่ีสุด 

 

1. เขาไปยังสวนของ Settings เลือกหนา Portfolio และ ใสตัวเลขลงไปในชอง Max. Open Positions  

 

2. หรือระบุจํานวนผานโคด โดยระบุฟงกช่ัน SetOption : 

 

SetOption("MaxOpenPositions", 5 );  
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// ในตัวอยางคือการตั้งคาใหซื้อไดมากท่ีสุด 5 position 
 

การตั้งขนาดการเทรดตอหนึ่งการเทรด (SETTING UP POSITION SIZE) 
 

สําคัญ: หากตองการใหระบบเขาเทรดมากกวา 1 ตัวผูใชตองตั้งคา Positionsize ตามกลยุทธ และ       

นอยกวา 100% สําหรับการลงทุนในแตละตัว มิฉะนั้นจะไมเหลือเงินใหลงทุนในหุนตัวอ่ืนๆ เชน 

 

PositionSize = -25; // ในการลงทุนหนึ่งคร้ังใชจํานวนเงิน 25% ของ Portfolio Equity 

หรือ 

 

PositionSize = 5000; // ในการลงทุนหนึ่งคร้ังใชจํานวนเงิน $5000 

 

วิธีการตั้งคา positionsize และ max. open positions ใหสอดคลองกันนั้นสามารถเขียนโคดไดดังน้ี  

 

PosQty = 5; // ระบุจํานวน positon ท่ีอยากเขาเทรด SetOption("MaxOpenPositions", 

PosQty ); 

PositionSize = -100/PosQty; // ลงทุน 100% ของ portfolio equity หารดวย by 

max.position count 

 

คุณสามารถเลือกใช กลยุทธของ Position size ท่ีมีความซับซอนข้ึน ตัวอยางเชน Position Size        

ที่ขึ้นอยูกับ  

 

Volatility ของหุน (Van Tharp-style) : 

 

PositionSize = -2 * BuyPrice/(2*ATR(10)); 

 

ผูใชจะลงทุนดวยเงิน 2% ของ PORTFOLIO equity และหารดวย 2*ATR factor 
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การใช Position Score (USING POSITION SCORE) SiamQuant 
 

ในกรณีที่ entry signals นั้นมีมากกวาจํานวนเงินท่ีตั้งไวในการเขาซ้ือ ผูใชสามารถต้ัง Position      

Score เพื่อใหระบบใหความสําคัญกับหุนตามท่ีผูใชระบุได ดังโคดดังกลาว เปนกกลยุทธ MA crossover      

system และ ใหความสําคัญกับหุนท่ีมี RSI ตํ่า เมื่อเกิดสัญญาณซื้อท่ีมากกวาจํานวนเงินท่ีผูใชถืออยู ระบบ       

จะคัดกรองหุนตาม RSI หุนท่ีมี RSI ตํ่าท่ีสุดจะเขาเทรดกอนตัวอ่ืนๆ ผูใชสามารถตรวจสอบเบื้องหลังการ      

ทํางานของระบบเพียงคลิกชอง "Detailed log" บนหนา report ใหเปน on 

 

โคดดานลางดังกลาว ใชระบบเพ่ือหาจํานวน open positions ท่ีเหมาะสมท่ีสุด (Optimal) 

 

/***** 

** โหมด REGULAR PORTFOLIO 

** ตัวอยาง optimization นี้ จะหาจํานวน position ท่ีควรเปดพรอมกันในการเทรด 

** 

****/ 

 

SetOption("InitialEquity", 20000 );  

SetTradeDelays(1,1,1,1);  

RoundLotSize = 1; 

 

posqty = Optimize("PosQty", 4, 1, 20, 1 );  

SetOption("MaxOpenPositions", posqty); 

 

// position size ที่ตองการคือ 100% ของ portfolio equity 

// หารดวย PosQty positions PositionSize = -100/posqty; 

// ระบบนี้ไมมีความซับซอน 

//เราสามารถทําการ optimize parameters ของ MA เชนกัน 
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p1 = 10; 

p2 = 22; 

 

// MA crossover อยางงาย 

Short=Cross( MA(C,p1) , MA(C,p2) ); 

Buy=Cross( MA(C,p2) , MA(C,p1) ); 

 

Sell=Short; 

Cover=Buy; 

 

// หากมีสัญญาณเขาซื้อมากกวาเงินลงทุนใหสราง Score ข้ึนมา 

 

PositionScore = 100-RSI();  

 

// ใหความสําคัญกับหุนท่ีมี low RSI อันดับแรก; 

 

BACKTEST MODES 
 

AmiBroker เวอรชั่น 5.0 ใหเลือกวิธีการ backtest ถึง 6 วิธี: 

 

● regular mode (backtestRegular) 

● regular raw mode (backtestRegularRaw) 

● regular raw + multiple positions mode (backtestRegularRawMulti) 

● regular raw2 mode (backtestRegularRaw2) 

● regular raw2 + multiple positions mode (backtestRegularRaw2Multi) 

● rotational trading mode (backtestRotational) 
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โหมด "regular"ทุกตัวใชสัญญาณเขาออกตาม buy/sell/short/cover signals ในขณะท่ีโหมด     

"rotational" mode (aka "ranking / switching" system) ใช position score อยางเดียวซ่ึงจะถูกอธิบาย           

ไวในสวนตอไป สยามควอนท 

 

ผูใชสามารถเปลี่ยนโหมดการ Backtest ไดผานฟงกช่ัน SetBacktestMode() AFL function 

 

ความแตกตางของ "regular" modes แตละตัวข้ึนอยูกับการทําการตอสัญญาณเขาซ้ือ ของระบบ     

("redundant" หรือ "extra") สัญญาณซื้อท่ี "extra" เกิดหลังจากท่ีมีการเปด Position หน่ึงไวแลว แต         

Position นั้นยังไมถูกปด  ตัว Extra Position คือ ตัวท่ีเกิดระหวาง 2 จุดนั้น  

 

ในโหมดของ regular ซึ่งเปนโหมด Default นั้น redundant entry จะถูกตัดออกไปทันที        

ดังภาพดานลาง (กลองที่ 2 ) 
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ดังที่คุณเห็นกันในภาพ หาก BUY เจอกับ SELL จะเรียกวาการ TRADE หากระบบไมสามารถ BUY         

เนื่องจาก Rank ตํ่า (ตามที่ตั้งไวใน Position Score) เงินไมพอ หรือ ถือ Position ตามจํานวน Max Open             

Position ไวแลว การ Entry หุนตัวใหมจะเกิดข้ึนก็ตอเมื่อมีสัญญาณ Exit ของหุนตัวเกาเกิดข้ึน กระบวนการ        

ของการตัด Excess Signal ที่วานี้สามารถเรียกโดยใชฟงกช่ัน ExRem() อยางไรก็ตาม ลักษณะท่ีกลาวมาจะอยู       

ใน Backtest โหมดแบบ Default อยูแลวดังนั้นผูใชไมตองเรียกฟงกช่ัน SetBacktestMode ข้ึนมาเพ่ือต้ังคา       

ดังกลาวเอง SiamQuant 

 

หากผูใชตองการใหระบบตอบสนองตอสัญญาณซื้อทุกๆ S​ตัวผูใชตองปรับโหมดเปน S​backtestRegular

Raw โดยใสโคดดังกลาว 
 

// ใชโหมด signal-based backtest โดยท่ี redundant (raw) signals 

ไมไดถูกตัดออกไปแตเขาเคร่ืองหมายละ 1 position เทานั้น 

 

SetBacktestMode( backtestRegularRaw ); 
 

โหมดดังกลาวไมตัด redundant entry signals และ จะตอบสนองตอ ทุกๆ Entry Signal ท่ีมี          

Score สูงตามที่ตั้งไวใน Position Score แตตัวระบบจะเขาเพียง 1 position ตอ หุน 1 ตัวเทาน้ัน หมาย            

ความวาถาระบบเขาซื้อหุนตัวนั้นไปแลว จะไมเขาซื้อเมื่อเกิดสัญญาณ redundant entry จะเขาซ้ือหลังจาก     

Sell signal เทานั้น อยางไรก็ตามผูใชสามารถใชคําส่ัง sigScaleIn/sigScaleOut เพ่ือเพ่ิม/ลด ขนาดของ       

Position ทั้งนี้คาใน Report จะโชวเพียงบรรทัดเดียวเทานั้น (ไมระบุการเขาแยกออกจากกัน) 

 

ถาผูใชตองการจะตอบสนองตอทุกๆ Entry Signal และให Report โชวการเขาซ้ือแยกออกจากกันให      

ใชคําสั่ง backtestRegularRawMulti ตามโคดดังกลาว 
 

SetBacktestMode( backtestRegularRawMulti ); 
 

ในโหมดนี้ ระบบจะเปด MULTIPLE positions ตอหุนเมื่อมีสัญญาณเกิดข้ึน และมีเงินสดเหลืออยู      

หากผูใชใสคําสั่ง Scale-In/Out จะมีผลตอทุกๆ open positions  
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หมายเหตุ : เนื้อหาถัดไปเหมาะสําหรับผูมีประสบการณตอการเขียนระบบ 

 

โหมด Raw2 เปนโหมดพิเศษสําหรับผูใชท่ีจะทํา custom backtest หากผูใช ใชแคเพ่ือการ       

Backtest แบบธรรมดาไมควรตั้งคาโหมดนี้ ดวยเหตุผลท่ีวาจะมี performance hit ท่ีไมเหมือนโหมดปกติ      

และ กินที่ memory มากกวา 

 

ความเหมือนระหวางโหมด Raw และ Raw2 คือท้ังสองโหมดไมตัดสัญญาณ excess entry signals        

ออก ความแตกตางคือ โหมด Raw จะตัด excess EXIT signals แตโหมด Raw2 จะไมตัดออก 

 

โหมด Raw2 จะเก็บสัญญาณ Excess exit signals ในกรณีท่ีผูใชอยากใชกลยุทธท่ีขามสัญญารออก       

ตัวแรกไปออกสัญญาณถัดๆไป สมมติวาผูใชอยากใหระบบ exit ตามเง่ือนไขใดเง่ือนไขหน่ึง แตเง่ือนไขน้ันกลับ     

อยูภายใตเงื่อนไขอีกตัว เชน ภายในระยะเวลาหนึ่ง หลังจากจํานวนบารตามท่ีกําหนด หรือมีเง่ือนไข Portfolio      

equity ผูใชสามารถเลือใชโหมด Raw2 ดังกลาวได  

ดังนั้นการ Backtest ในโหมดนี้จะใชเวลามากกวาปกติเนื่องจากระบบตอบสนองตอทุกๆ Exit Signal     

โหมด Raw2 ยังกิน memory มากกวาโหมดอ่ืนอีกเชนกัน แตอยางไรก็ตามหากผูใชไมไดเขียนระบบท่ีตอง      

run Custom Backtest การใชโหมด Raw หรือ Raw2 ก็จะไมมีความแตกตางใดๆท้ังส้ิน 
 

ROTATIONAL TRADING 
 

รายละเอียดของ Rotational trading ซึ่งมีสัญญาณเขาออกตาม position score น้ันจะถูกอธิบาย 

ในหมวดของ EnableRotationalTrading  
 

HOLDMINBARS และ EARLY EXIT FEES (HOLDMINBARS AND EARLY EXIT FEES) 
 

HoldMinBars เปน feature ท่ีระงับสัญญาณการออก รวมไปถึงสัญญาณ Stop ท้ังหลาย รวมไปถึง        

การคํานวณ Trailling Stop จะไมคํานึงถึง Bar ท่ีอยูภายใตเง่ือนไข HoldMinBars น้ี  

 

ฟงกชันนี้ และ EarlyExitFee/EarlyExitBars สามารถนําไปใชสําหรับหุนรายตัวได 
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ตัวอยางเชน: 

 

SetOption("HoldMinBars", 127 ); 

Buy=BarIndex()==0; Sell=1; 
 

 // ถึงแมวาสัญญาณการขายจะเกิดข้ึนทุกวัน แตสัญญาณเหลานั้นจะถูกเพิกเฉยจนกวาจะถึง bar ท่ี 

128 
 

คาใชจาย Early exit (redemption) fee เกิดข้ึนเมื่อสัญญาณออกอยูในระยะเวลาของ N Bars หลัง         

จากเกิดสัญญาณเขา คาใชจายนี้จะรวมไปอยูกับ Commission Fees และจะเห็นไดใน Commission report  
 

// คําสั่ง 2 ตัวนี้สามารถตั้งคาตอ 1 สัญลักษณ 

// และจํานวน Bar ได 

// เลือกกําหนด early exit (redemption) fee SetOption("EarlyExitBars", 128 ); 

// สามารถตั้ง early redemption fee% SetOption("EarlyExitFee", 2 ); 

 

(หมายเหตุ 180 calendar days คือ 128 หรือ 129 trading day) 

 

// ใชคําสั่ง if เพื่อตั้งคาตอ 1 สัญลักษณ 

if( Name() == "SYMBOL1" ) 

{ 

SetOption("EarlyExitBars", 128 ); 

SetOption("EarlyExitFee", 2 ); 

} 

 

if( Name() == "SYMBOL2" ) 

{ 

SetOption("EarlyExitBars", 25 ); 

SetOption("EarlyExitFee", 1 ); 

} 
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นอกจากคําสั่ง HoldMinBars, EarlyExitBars ผูใชสามารถใชคําส่ัง HoldMinDays หรือ      

EarlyExitDays ที่ใชวันบน calendar days แทนขอมูลตาม Bar เราสามารถเขียนโคดจากดานบนโดยใช 2        

ฟงกชั่นไดดังนี้ 

 

 

// ถึงแมวาสัญญาณขายจะเกิดข้ึนทุกวันแตสัญญาณเหลานั้นจะถูกเมินจนกวาจะถือครบ 180 วัน 

 

SetOption(“HoldMinDays”, 180); 

Buy = BarIndex() == 0; 

Sell = 1; 

 

// คําสั่งสองตัวนี้สามารถตั้งคาตอ 1 สัญลักษณ  

// จํานวนวัน หรือ CALENDAR DAYS 

// และ early exit (redemption) fee SetOption("EarlyExitDays", 180 ); 

// early redemption fee (in percent) SetOption("EarlyExitFee", 2 ); 

 

(หมายเหตุ 180 วันในปฎิทิน คือ 128 หรือ 129 วันท่ีทําการเทรด) 

 

// ใชคําสั่ง if เพื่อตั้งคาตอ 1 สัญลักษณ 

if( Name() == "SYMBOL1" ) 

{ 

SetOption("EarlyExitDays", 180 ); 

SetOption("EarlyExitFee", 2 ); 

} 

 

if( Name() == "SYMBOL2" ) 

{ 
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SetOption("EarlyExitDays", 30 ); 

SetOption("EarlyExitFee", 1 ); 

} 
 

การแกไขปญหาการเขาซ้ือพรอมๆกัน (RESOLVING SAME BAR, SAME SYMBOL 

SIGNAL CONFLICTS)​SiamQuant 
 

มีความเปนไปไดที่จะเกิดสัญญาณเขาซื้อ และสัญญาณออกใน Bar เดียวกันตัวอยางเชน 
 

Buy = 1; 

Sell = 1; 

 

เมื่อคุณใสคําสั่ง exploration ดังกลาว: 

 

AddColumn(Buy,"Buy", 1.0 ); AddColumn(Sell, "Sell", 1.0 ); Filter = Buy OR Sell; 
 

จะพบกับหนาตางดังนี ้
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เนื่องจากตัว entry และ exit signals จะไมมีขอมูลเร่ืองเวลาอยูในน้ัน ดังน้ันจะไมรูวาสัญญาณไหน       

เกิดขึ้นกอน เราสามารถตีความกับความหมายของมันได 3 แบบ: 

 

1. only one signal is taken at any bar นั่นหมายความวาการ Trade เกิดข้ึนใน Bar ท่ี 1 และ               

ขาย ออกที่ Bar ที่ 2 และตัวถัดมาเขาซื้อท่ี Bar ท่ี 3 และออกท่ี Bar ท่ี 4 

 

2. both signals are used and entry signal precedes exit signal น่ันหมายความวาการซ้ือเกิดท่ี           

Bar 1 และการขายเกิดข้ึนหลังจากการซื้อใน Bar เดียวกัน การซื้อคร้ังตอมาเกิดข้ึนท่ี Bar ท่ี 2 และ          

ขายออกหลังจากนั้นใน Bar ท่ี 2 เชนกัน 

3. both signals are used and entry signal comes after exit signal. ในกรณีน้ี            

สัญญาณออกตัวแรกจะถูกเพิกเฉย และการเทรดจะเกิดข้ึนใน Bar ท่ีมีสัญญาณซ้ือ และ Exit จะเกิด       

ขึ้นใน Bar ถัดไป หลังจากนั้นสัญญาณซื้อจะเกิดข้ึนใน Bar ท่ีเราพ่ึง Exit ออกไป และไป Exit ใน Bar            

ถัดมา เปนอยางนี้ไปเร่ือยไป 

 

เราจําเปนตองจัดการกับปญหาการตีความนี้ บางคนอาจจะคิดวาเพียงกําหนดราคาซ้ือ และ ราคา    

ขายก็เพียงพอแลว แตนั่นไมใชวิธีการแกปญหาท้ังหมด เพราะ Array ของราคาก็ไมไดมีขอมูลเร่ืองระยะเวลา     

เชนกัน ดังนั้นหากราคาปดและเปดเทากัน (Doji) ก็ไมสามารถแยกไดวาตัวใดเกิดกอน แตอยางไรก็ตามโดย     

ปกติแลวคนจะไมระบุ Buy price และ Sell price อยางแนชัดมักจะตั้งกันตาม Open + Slippage และ           

ขายตอน Close – Slippage 

 

วิธีการแกปญหาการตีความของสัญญาณเขาออกใน Bar เดียวกันนั้นคือการใช AllowSameBarExit    

option และ HoldMinBars option 
 

กรณี 1. Only one signal per symbol is taken at any bar ( 1 Bar 1 Signal) 

กรณีนี้เกิดขึ้นเมื่อตั้งคา AllowSameBarExit ใหเปน False (turned off) 

 

กรณีนี้เราไมตองสนวาสัญญาณซื้อหรือขายเกิดข้ึนกอนใน Bar นั้นๆ ตัวอยางเชนสมมติเกิด entry     

signal (ดวย buy signal taking precedence over short) สัญญาณอ่ืนๆ ท่ีเกิดข้ึนหลังจากน้ันจะถูกเพิก          
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เฉยใน Bar นั้น ถาหากเรา Longในกรณีนี้ เราจะรอ Bar ถัดมาและ Sell ในBar น้ัน และเคล่ือนไปยัง Bar             

ถัดไป (เชนเดียวกันกับกรณี Short-Cover) ถาหากไมมีสัญญาณออก เราก็จะเคล่ือนท่ีไปพิจารณา Bar ถัดๆไป 
 

SetOption("AllowSameBarExit", False ); 

Buy = 1; 

Sell = 1; 
 

ดังภาพดังกลาว สยามควอนท 

 
 

 
 

 

 
 

กรณีที่ 2 สัญญาณในการเขา และ สัญญาณในการออกเกิดข้ึนพรอมๆกัน (Both 

entry and exit signals are used and entry signal precedes exit signal) 

กรณีนี้นี้จะเกิดขึ้นเมื่อผูใชตั้งคา AllowSameBarExit ใหเปน True (turned on) และต้ัง       

HoldMinBars ใหเปนศูนยซึ่งก็คือคา Default นั่นเอง 

 

ในเคสนี้เราจะตอบสนองตอ signal ท้ังสองอยางทันทีทันใด เมื่อเจอสัญญาณ entry แลวระบบจะ      

ตรวจหา exit ไวเชนกัน เมื่อเราตั้ง Long ไวเราจะ Sell signal นั้นๆ หากเรา Short มันไวเราจะ Cover             

ตัวนั้นๆ เราจะเคลื่อนที่ไปพิจารณา Bar ถัดไปเมื่อทําการกับสัญญาณทุกตัวใน Bar ปจจุบันเรียบรอยแลว 
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SetOption("AllowSameBarExit", True ); 

Buy = 1; 

Sell = 1; 

 

ดังรูปภาพดังกลาว 
 

 

กรณีที่ 3. สัญญษณทั้งสองเกิดข้ึนพรอมๆกัน 

แตสัญญษณในการเขามาทีหลังสัญญาณในการออก (Both signals are used and entry 

signal comes after exit signal) 

กรณีจะเกิดขึ้นเมื่อผูใชตั้งคา AllowSameBarExit เปน True (turned on) และ HoldMinBars เปน         

1 (หรือมากกวานั้น) 

 

ในเคสนี้เราจะตอบสนองตอสัญญาณใน Bar เดียวกันแตภายใตขอจํากัดของ HoldMinBars = 1      

ดังนั้นการเทรดที่เกิดขึ้นจะไมไดรับการ Exit ใน Bar เดียวกัน ระบบขะเคล่ือนท่ีไปพิจารณา Bar ถัดไป 
 

SetOption("AllowSameBarExit", True );  

SetOption("HoldMinBars", 1 ); 
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   Buy = 1; 

   Sell = 1; 

 

ดังภาพดังกลาว 
 

 

ใชงานในรูปแบบของพอรต (How does it work in portfolio case?) 
 

ระบบจะปฏิบัติในลักษณะเดียวกันตอหุนหลายๆตัวโดยท่ีจะใหนํ้าหนักการซ้ือขายตาม Position  

Score ปญหาของ First same-bar conflicts ในระดับพอรตโฟลิโอจะถูกแกไขเชนเดียวกับท่ีไดกลาวไป 
 

กลยุทธแบบ market-neutral, long-short balanced strategies (Support for 

market-neutral, long-short balanced strategies) 

 

กลยุทธการลงทุนที่ตองการจะหลีกเล่ียง market risk หรือท่ีเรียกวา market neutral สามารถทําได       

โดยการ hedging ซึ่งสามารถทําไดโดยการเปด Long และ Short equity positions ในหุนท่ีอยูใน Sector          

เดียวกัน เพื่อที่จะตัดความเสี่ยงใน Sector และ Market ใหมากท่ีสุด  
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ในเวอรชั่น 5.20 ผูใชสามารถรันระบบ Market Neutral ได ดวยคําส่ังดังกลาว 

SeparateLongShortRank, MaxOpenLong, MaxOpenShort 

 

SeparateLongShortRank backtester option​ SiamQuant 

 

หากตองการแยกการพิจารณาเกณฑการเขาของ Longและ Short ใหใสโคดดังกลาว:  

 

SetOption("SeparateLongShortRank", True ); 

 

เมื่อโหมดนี้ถูก activate ตัว backtester จะพิจารณา score ตาม "top-ranked" signal lists ของ           

position Long และ Short แยกกันทําใหสกอรของแตละอันมีเกณฑท่ีไมเหมือนกันได ตัวอยางเชน หุนท่ีคัด       

เลือกตามเกณฑเขาซื้อแบบ long ของเรา ในขณะท่ี หุนท่ีคัดเลือกตามเกณฑเขาซ้ือแบบ short น้ันเปนคาติด       

ลบซึ่งขัดกับโหมด default ของเราท่ีนําคาของ absolute value ของสกอรใดสกอรหน่ึง มาพิจารณาอยาง       

เดียว  

 

หลังจากที่ผูใชเปดโหมด SeparateLongShortRank แลว ตัว Backtester จะทําการจับคูตาม สกอร       

ของ Long และ Short ตัวท่ีสกอรสูงสุดบนกระดาน Long จะจับคูกับ ตัวท่ีสกอรทอปบนกระดาน Short         

ตามลําดับลงมาเรื่อยๆ (เมื่อสามารถจับคูได ในกรณีท่ีไมมีคู ระบบจะแสดงผลตามสัญญาณท่ีเหลือ) 

 

ตัวอยางเชน: 

Entry signals(score):ESRX=Buy(60.93), GILD=Short(-47.56), CELG=Buy(57.68), 

MRVL=Short(-10.75), ADBE=Buy(34.75), VRTX=Buy(15.55), SIRI=Buy(2.79), 

 

จะสังเกตไดวา สัญญาณ short นั้น ปะปนอยูกับ สัญญาณ Long ในขณะท่ีคา Absolute Value ของ           

สกอรนั้นมีจํานวนนอยกวา Long Signal ในบารนั้นมีสัญญาณ Short แค 2 ตัว ตัวท่ีเหลือจะเปนสัญญาณ         

Long ตาม Position Score ฟงกชันนี้มักนิยมใชกับ MaxOpenLong และ MaxOpenShort options 
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MaxOpenLong / MaxOpenShort backtester options 

 

MaxOpenLong - จํากัดจํานวน Position LONG ท่ีสามารถเปดได  

MaxOpenShort - จํากัดจํานวน Position SHORT ท่ีสามารถเปดได 

 

ตัวอยางเชน:  

 

SetOption("MaxOpenPositions", 15 ); 

SetOption("MaxOpenLong", 11 ); 

SetOption("MaxOpenShort", 7 ); 

 

หากใสเลขศูนยตอทายหมายความวาผูใชจะไมจํากัดจํานวน Position LONG และ SHORT ตัว      

Backtester จะขึ้นตรงตอ (MaxOpenPositions) ไมวาจะเปด Position ใดก็ตาม 

 

หมายเหตุ คําสั่งของ MaxOpenLong และ MaxOpenShort รวมกันน้ันสามารถระบุจํานวนท่ีเทา      

หรือ ไมเทากับ MaxOpenPositions 

 

เมื่อจํานวนของ MaxOpenLong + MaxOpenShort มากกวา MaxOpenPositions น้ัน จํานวน        

การถือ Position ทั้งหมดจะไมเกิน MaxOpenPositions สัดสวนการถือจะข้ึนอยูกับ long/short limits       

ที่ผูใชไดตั้งเอาไว ตัวอยางเชน หากระบบของทานตั้งคาไววา MaxOpenLong จะถือ 7 position และ        

maxOpenShort จะถือ 7 position เชนกันนั้น แตตั้งคา MaxOpenPositions ไวท่ี 10         

หากมีสัญญาณเกิดขึ้นทั้งหมด 20 ตัว: 9 long (highest ranked) และ 11 short ระบบจะทําการเปด Long            

7 position และเปด Short ไว 3 position 

 

เมื่อ MaxOpenLong + MaxOpenShort นั้นนอยกวา MaxOpenPositions แตมากกวาศูนยระบบ       

จะไมเปด Position เกินไปกวา MaxOpenLong +MaxOpenShort 

ฟงกชัน MaxOpenLong และ MaxOpenShort นั้นไมมีผลกระทบตอ Ranking น่ันคือ Position         

Score จะยังคง เลือกคา Absolute ท่ีสูงท่ีสุดตามคา Default  
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หาก position score ของผูใชนั้นไม symmetrical นั่นหมายความวาผูใชอาจจะไมได top-ranked       

signals จากฝงใดฝงหนึ่งตามตองการ ดังนั้นคําแนะนําคือใหใชคําส่ัง MaxOpenLong และ MaxOpenShort      

(หากดําเนินกลยุทธ"market neutral") ควบคูไปกับ separate long/short ranking ดังคําส่ังน้ี 

 

SetOption("SeparateLongShortRank", True ); 

 

ดูเพิ่มเติม: 

 

Backtesting your trading ideas​ article. 

 ​Backtesting systems for futures contracts​ article.  

Using AFL editor section of the guide. 

Insider guide to backtester (newsletter 1/2002) 
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การอานผลการ Backtest 

(Reading backtest report) 
 

หากตองการจะดูคาของการ Backtest ใหเลือกท่ีปุม Report ในหนา automatic analysis window        

หากตองการจะดูคาของ Backtest ท้ังหมดท่ีผานมาใหคลิกท่ีปุมลูกศรช้ีลงตรงคําส่ัง Report และเลือก     

Report Explorer หากผูใชคลิกขอมูลในแตละบรรทัด จะมีหนาตาง Report โชวข้ึนมา 

 

Report ในเวอรชั่นใหมนี้มีขอมูลใหมากกวาเดิม แยกสถิติของ Position Long และ Short รายละ         

เอียดของ Metric ตางๆ คราวๆดังนี้ สยามควอนท 

Exposure %  

'Market exposure ของ trading system นั้นคํานวณจากแตละ Bar นําผลรวมของ Exposure          

แลวหารดวยจํานวน Bar ทั้งหมด Single bar exposure คือ คาของ open positions หารดวย portfolio            

equity ของ Bar นั้นเอง SiamQuant 
 

Net Risk Adjusted Return %  

Net profit % หารดวย Exposure % 

Annual Return %  

Compounded Annual Return % (CAR) ผลตอบแทนทบตน 

Risk Adjusted Return % 

Annual return % divided by Exposure % 
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Avg. Profit/Loss 

หรือที่รูจัดกันในชื่อ Expectancy ($) - (Profit of winners + Loss of losers)/(number of            

trades), บงบอกถึงจํานวนเงินท่ีนาจะ ได/เสีย ตอการเทรด 1 คร้ัง 

Avg. Profit/Loss %  

หรือที่รูจัดกันในชื่อ Expectancy (%) - '(% Profit of winners + % Loss of losers)/(number of              

trades) บงบอกถึงเปอรเซ็นต ได/เสีย ตอการเทรด 1 คร้ัง 

Avg. Bars Held  

sum of bars in trades / number of trades จํานวน Bar เฉล่ียท่ีถือไวตอการเทรด 1 คร้ัง 

Max. trade drawdown  

ความหางระหวางจุดสูงสุด peak และจุดตํ่าสุด valley ของการเทรด 1 คร้ัง ย่ิงต่ําย่ิงดี 

Max. trade % drawdown  

Percentage ของความหางระหวางจุดสูงสุด peak และจุดตํ่าสุด valley ของการเทรด 1 คร้ัง 

ยิ่งตํ่ายิ่งด ี

Max. system drawdown  

ความหางระหวางจุดสูงสุด peak และจุดตํ่าสุด valley ของท้ังพอรต ย่ิงต่ําย่ิงดี 

Max. system % drawdown  

Percentage ของความหางระหวางจุดสูงสุด peak และจุดตํ่าสุด valley ของท้ังพอรต ย่ิงต่ําย่ิงดี 

Recovery Factor  

Net profit หารดวย Max. system drawdown 
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CAR/MaxDD 

Compound Annual % Return หารดวย Max. system % drawdown หากเกิน 2 ถือวาดี 

RAR/MaxDD 

Risk Adjusted Return หารดวย Max. system % drawdown หากเกิน 2 ถือวาดี 

Profit Factor 

Profit of winners หารดวย loss of losers 

Payoff Ratio 

อัตราสวนของ average win / average loss 

Standard Error 

Standard error วัดความไมแนนอน/ขรุขระ ของเสน equity line ย่ิงต่ําย่ิงดี 

 

Risk-Reward Ratio 

วัดความสัมพันธระหวาง ความเส่ียงและ potential gain ของระบบการเทรด ย่ิงสูงย่ิงดี 

โดยคํานวณจากการหา slope ของ equity line (expected annual return) ดวย standard error 

Ulcer Index 

Square root ของ sum of squared drawdowns หารดวย number of bars 

Ulcer Performance Index 

(Annual profit - Tresury notes profit)/Ulcer Index'>Ulcer Performance Index. ปจจุบัน 

tresury notes profit ถูกเซ็ทไวท่ี 5.4.ในอนาคตผูใชจะสามารถกําหนดเองได 
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Sharpe Ratio of trades  

คํานวณหา risk adjusted return ของ investment มากกวา 1 ถือวาดี หากเกิน 2 ถือวาดีมากๆ            

รายละเอียดเพิ่มเติมศึกษาไดท่ี ​http://www.stanford.edu/~wfsharpe/art/sr/sr.htm การคํานวณ:   

หาคาเฉลี่ยของ Return และ Standarn Deviation ออกมากอน หลังจากน้ันคูณดวย       

(NumberOfBarsPerYear) / (AvgNumberOfBarsPerTrade) ซึ่งเปนอัตราสวนทีทําใหคาอยูในหลัก ตอป     

(Annualized) จากนั้นนํา Risk Free Rate ซึ่งถูกตั้งไวท่ี 5 ไปลบจาก annualized average return           

และนํากอนนั้นไปหารดวย annualized SD of return 

 

K-Ratio  

ตรวจหาความไมตอเน่ืองของผลตอบแทน ควรจะเทากับ 1 หรือมากกวาน้ัน คํานวณจากการหา     

Linear regression slope ของ equity line คูณดวย square root ของ sum of squared deviations              

ของ bar number หารดวย standard error ของ equity line และนําไปคุณดวย square root of             

number of bars รายละเอียดเพ่ิมเติมดูไดท่ี Stocks & Commodities V14:3 (115-118): Measuring          

System Performance by Lars N. Kestner 
 

การใสสีเขาไปในผลการ backtest  (ใหมในเวอรช่ัน 5.60) (Color-coding in the 

backtest report)​SiamQuant 
 

เวอรชั่น 5.60 สามารถใหผูใชใสสีระบุคาท่ี 'good' และ 'bad' บน backtest report ไดคาบางคา          

นั้นจะถูกใสสีไวอยูแลว โดยสี นํ้าเงิน หมายถึง “ปานกลาง” เขียวหมายถึง “ดี” และแดงหมายถึง “แย”         

ตัวอื่นๆจะเปนสีดํา 

การใสสีบนคารีพอรตควรจะใสอยางมีจุดประสงค โดยท่ัวไปมักจะใชสีแดงเพ่ือบงบอกถึงการเตือน  

และหมั่นควรเช็คคาของรีพอรตเชนกันไมใชแคสี 
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 metrics เหลานี้ถูกใสสีไวตามคุณภาพของคาดังตอไปนี้  

 

Net Profit, Net Profit % - bad < 0, good > 0 

 

Annual Profit %, bad < 0, neutral betwen 0 and 10, good > 10 RAR % bad < 0, good 

> (10 / Exposure) 

 

Avg. Profit/Loss all trades (Expectancy $) - bad < 0, good > 0 Avg Profit/Loss % all 

trades (Expectancy %) - bad < 0, good > 0 

 

Max. system % drawdown - bad: dd worse than -30%, neutral: dd between -30 and 

-10%, good - -10% to 0% CAR/MaxDD, RAR/MaxDD - bad < 1, neutral between 1 and 

2, good > 2 

 

Recovery factor - bad < 1, neutral between 1 and 2, good > 2 Payoff ratio - bad < 1, 

neutral between 1 and 2, good > 2 

 

เพิ่มเติม : 

 

Old backtest report 

 

Backtesting your trading ideas​ article. ​Portfolio Backtesting​ article. 

Backtesting systems for futures contracts​ article. Using AFL editor section of the guide 

 ​Insider guide to backtester (newsletter 1/2002) 
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วิธีการ Optimize 

(How to optimize trading system)  
 

หมายเหตุ: เนื้อหามีความซับซอน ควรจะอานเนื้อหากอนหนานี ้

 

 

เกริ่นนํา (Introduction) SiamQuant 
 

คอนเซปของการ Optimize นั้นเรียบงาย ผูใชตอมีระบบการลงทุนกอน อาจจะเปนระบบ Simple      

moving average Crossover หรืออะไรก็ตาม ในทุกๆระบบ จะมี Parameter ท่ีกําหนดวาตัวระบบจะ        

ทํางานอยางไร (ในกรณีนี้ตัวอยางเชนคาของ averaging period สําหรับการ crossover) การ Optimize        

คือการหาคา Parameter ที่เหมาะสมและดีท่ีสุดตอระบบ เพ่ือใหไดผลตอบแทนท่ีดีท่ีสุดตอ หุนตัวเด่ียวๆ หรือ      

ตอทั้งพอรตนั่นเอง Amibroker เปนเพียงไมกี่โปรแกรมท่ีสามารถ optimize หุนหลายๆตัวได 

 

การ Optimize นั้นผูใชจะตองกําหนดคา Parameter ตั้งแต 1 คาไปจนถึง 10 คา และกําหนด          

คาสูงสุด และ ตํ่าสุดของแตละ Parameter หลังจากนั้น Amibroker จะทําการ Backtest หลายๆคร้ัง         

โดยหยิบ parameter เหลานั้นมาทําการ Backtest (การจับคูท่ีเปนไปไดท้ังหมด) เม่ือจบการ Backtest       

หลายๆ ครั้งนี้แลว Amibroker จะแสดงผลการ Backtest ท้ังหมดเรียงตาม Profit คุณสามารถเลือกคา        

Parameter ตามตองการได 

 

โคด AFL formula (Writing AFL formula) 
 

การเขียนฟงกชัน Optimization นั้นมีลักษณะดังนี้  

 

variable = optimize( "Description", default, min, max, step );  
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โดยที่: variable - คือตัวแปรท่ีเก็บขอมูลของการ Optimize ซึ่งสามารถตั้งข้ึนโดยผูใชเอง 

(คาที่ออกมาจะเปนคา default variable = default;) 

 

ในโหมด optimization จะใหคาตามการปรับ Parameter จากคา Min ท่ีต้ังไวไปจนถึงคา Max เปน 

Step เรื่อยๆไป 

 

"Description"  คือ ช่ือของตัวแปร Optimize ซึ่งช่ือนี้จะอยูบนคอลัมน optimization result list 

 

default คือ คา Default ท่ีระบบจะเลือกใชในโหมด exploration, indicator, commentary, 

scan และ normal back test modes 

 

min คือคาตํ่าสุดของ Parameter ท่ีอยาก Optimize 

 

max คือคาสูงสุดของ Parameter ท่ีอยาก Optimize 

 

step คือจํานวนการเพ่ิมข้ึนของ Parameter จาก Min ไป Max 

 

หมายเหตุ: 

 

● AmiBroker รับตัวแปร Optimize Variable ไดแค 64 ตัวเทาน้ัน หากผูใชใช exhaustive         

optimization ควรจะจํากัดจํานวนของการ optimization 

 

● การ Optimize แตละคร้ังจะใหจํานวนผลลัพธออกมาเปน จํานวน Step ของการ Optimize       

คูณดวย จํานวน Step ของการ Optimize ของตัวแปรถัดไป ตัวอยางเชน หากตองการ Optimize         

Parameter 2 ตัว ตัวละ 10 Step จะไดคาผลลัพธืออกมาท้ังหมด 10*10 = 100 คา (Loop            

Backtest 100 ครั้ง) 

● เรียกใช optimizae function ตอหนึ่งตัวแปรดานบนของโคดของคุณ เน่ืองจากการเรียก     

optimizae function แตละคร้ังจะทําใหเกิด optimization loop อันใหม 
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● Amibroker รองรับ Multiple-symbol optimization  

●  Maximum search space คือ 2 64  ​(10​19  ​= 10,000,000,000,000,000,000) combinations 
 

  

ตัวอยางเชน  สยามควอนท 
 

1. การ Optimize 1 ตัวแปร: 

 

sigavg = Optimize( "Signal average", 9, 2, 20, 1 ); 

 

Buy = Cross( MACD( 12, 26 ), Signal( 12, 26, sigavg ) ); 

Sell = Cross( Signal( 12, 26, sigavg ), MACD( 12, 26 ) ); 
 

2. การ Optimize 2 ตัวแปร (suitable for 3D charting) 

 

per = Optimize("per", 2, 5, 50, 1 ); 

Level = Optimize("level", 2, 2, 150, 4 ); 

 

Buy=Cross( CCI(per), -Level ); 

Sell = Cross( Level, CCI(per) ); 

 

3. การ Optimize 3 ตัวแปร: 

 

mfast = Optimize( "MACD Fast", 12, 8, 16, 1 ); 

mslow = Optimize("MACD Slow", 26, 17, 30, 1 ); 

sigavg = Optimize( "Signal average", 9, 2, 20, 1 ); 

 

 

Buy = Cross( MACD( mfast, mslow ) , Signal( mfast, mslow, sigavg ) ); 

Sell = Cross( Signal( mfast, mslow, sigavg ), MACD( mfast, mslow ) ); 
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หลังจากใส formula ใหกดปุม Optimize ในหนาตาง "Automatic Analysis" AmiBroker จะเร่ิม         

ทําการทดสอบ และจับคูคา Parameter ตางๆและแสดงผลออกมาใน Report คาท่ีออกมาจะเรียงตาม Net       

% profit ผูใชสามารถเรียงคาตาม lowest drawdown, lowest number of trades, largest profit           

factor, lowest market exposure และ highest risk adjusted annual % return คอลัมนทายๆ            

จะบงบอกถึงคาที่ผูใช Optimize  SiamQuant 

 

เมื่อผูใชพบกับ Parameter ท่ีเหมาะสมท่ีสุดแลว ใหใสคานั้นลงไปในคา Default ใน Optimize       

function (พารามิเตอรที่สองของฟงกชัน optimize 

 

แสดงผล optimization แบบสามมิติ (Displaying 3D animated optimization 

charts) 
 

ผูใชสามารถเรียกรูปกราฟสามมิติ ออกมาไดหากทําการ Optimize 2 ตัวแปร (two-variable 

optimization) ซึ่งตองมีการเปดฟงกชัน Optimize() 2 รอบ ตัวอยางเชน: 

 

 per = Optimize("per", 2, 5, 50, 1 ); 

Level = Optimize("level", 2, 2, 150, 4 ); 

 

Buy=Cross( CCI(per), -Level ); 

Sell = Cross( Level, CCI(per) ); 
 

หลังจากใสโคดแลวใหกดปุม Optimize 

 

ผุใชสามารถเรียกกราฟสามมิติออกมา เพียงคลิกท่ีปุมลูกศรเล่ือนลงตรงปุม Optimize และ เรียก     

View 3D optimization graph เพียงเส้ียววินาทีผูใชจะพบกับกราฟ 3 มิติ ดังตัวอยางดานลาง 
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โดยทั่วไปกราฟสามมิติจะแสดงผลในรูปของ แกน Net profit และแกน optimization variables       

ซึ่งผูใชสามารถเลือกที่จะเปลี่ยนแกนได และเลือกแกนจากคอลัมนของ optimization result table เพียง      

เลือกหัวคอลัมนที่ตองการ ( เชน Max. System Drawdown, CAR/Max. DD …) เลือกเปนแกน และคลิกให           

result เรียงตามคอลัมนที่ตองการ หลังจากนั้นใหกด View 3D optimization graph อีกรอบ 

 

ผูใชสามารถใชกราฟสามมิติในการตัดสินใจท่ีจะเลือกใช Parameter ใหเหมาะกับ Trading System     

ซึ่ง Parameter ที่ดีนั้นจะโชวการเคล่ือนข้ึนของกราฟอยางชาๆ ไมใชข้ึนมาโดดๆ กราฟสามมิติยังเปนเคร่ืองมือ     

ในการปองกัน curve-fitting Curve-fitting (หรือ over-optimization) เกิดข้ึนเม่ือระบบใสตัวแปรท่ีเอ้ือ      

อํานวยตอสถานการณใดสถานการณหนึ่ง ซึ่งอาจจะไมเกิดข้ึนในอนาคต จุดท่ีโดดข้ึนมาจากกราฟ สามมิติ    

อยางผิดปกตินั้น บงบอกถึงความ over-optimization ผูใชควรจะเลือก Parameter ในลักษณะท่ีมี พ้ืนท่ี       

สูงและกวาง สวนตัวที่โดดออกมาเดี่ยวๆนั้นไมเหมาะกับการใชในระบบ SiamQuant 
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การควบคุมกราฟสามมิติ (3D chart viewer controls) 
 

AmiBroker's 3D chart ใหผูใชสามรถดูกราฟไดหลากหลายมุมมอง ตามคําส่ังดังกลาว 

 

Mouse controls: การใชเมาสเพ่ือเลือกปรับเปล่ียนมุมมอง 

 

- การ Rotate - คลิกเมาสซายและเล่ือนไปตามแกน X/Y  

- การ Zoom-in, zoom-out -  คลิกเมาสขวาและเล่ือนไปตามแกน X/Y  

- การ Move (translate) - คลิกเมาสซายพรอมกับการกด CTRL และเล่ือนไปตามแกน X/Y 

- การ Animate -  คลิกเมาสซาย และเล่ือนเมาสอยางรวดเร็วและปลอยเมาสออก 

 

Keyboard controls: การใชคียบอรดปรับเปล่ียนมุมมอง 

 

SPACE - ทําการ auto-rotate 

LEFT ARROW KEY - rotate ไปทางซาย 

RIGHT ARROW KEY - rotate ไปทางขวา  

UP ARROW KEY - rotate ข้ึนดานบน 

DOWN ARROW KEY - rotate ลงดานลาง  

NUMPAD + (PLUS) - Near (zoom in)  

NUMPAD - (MINUS) - Far (zoom out)  

NUMPAD 4 - เคลื่อนท่ีไปทางซาย 

NUMPAD 6 - เคลื่อนท่ีไปทางขวา 

NUMPAD 8 - เคลื่อนท่ีไปดานบน  

NUMPAD 2 - เคลื่อนท่ีลงดานลาง  

PAGE UP - water level up 

PAGE DOWN - water level down 
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โหมด Smart (non-exhaustive) optimization (Smart (non-exhaustive) 

optimization) 

 เกริ่นนํา (Introduction) 

AmiBroker มีโหมด smart (non-exhaustive) optimization นอกเหนือจากแบบธรรมดา      

exhaustive search 

โหมด Non-exhaustive search จะมีประโยชนเมื่อการรวมกันของ Parameter ในระบบน้ันมีขนาด      

ที่ใหญเกินกวาโหมด exhaustive search จะประมวลได 

 

Exhaustive search หรือโหมดธรรมดานั้นเหมาะกับตัวแปรท่ีไมเยอะมาก สมมติวา ผูใชตองการจะ     

Optimize 2 Parameters แตละตัวไลเสต็ปจาก 1 ไป 100 รวมกันก็เทากับ 10,000 combinations (10^2)           

ถาหากเพิ่มอีก 1 parameter เขาไป คาท่ีออกมาจะได 1,000,000 combination โหมด Exhaustive Search          

อาจจะยังประมวลผลได แตถาหากคุณเพ่ิมเขาไป 4 Parameter เพ่ิมไป 5 Parameter คุณจะมีถึง 10,000         

ลาน combination ไปถึงจุดนั้นมันเปนการยากมากท่ีจะตองมาไลดูทีละตัว โหมด non-exhaustive     

จะเขามาแกปญหานี้ได 

 

Quick Start 

นี่คือวิธีการใช new non-exhaustive optimizer ท่ีเรียบงายท่ีสุด (ในกรณีน้ีCMA-ES). 

 

1. เปด Formula จาก Formula Editor SiamQuant 

 

2. เพิ่มโคดนี้ไวบนสุดของ formula:  

OptimizerSetEngine("cmae"); // คุณสามารถใชคําส่ัง"spso" หรือ "trib" 

3. (เลือกไดวาจะทําขั้นตอนนี้หรือไม) เลือกคา Target ท่ีอยากจะ Optimize โดยปดติแลวคา Default 

จะ Optimize ตัว CAR/MDD เลือกผาน Automatic Analysis, Settings, "Walk-Forward" tab, 

และ Optimization target เพียงแคนั้น 
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หากผูใชรัน optimization โดยใชโคดนี้ จะพบกับการใช (non-exhaustive) CMA-ES optimizer 

 

ขั้นตอนเปนอยางไร (How does it work ? ) 
 

จุดประสงคของ optimization จะเปนเพ่ือการหาจุดตํ่าสุด หรือ จุดสูงสุด ของ Function ระบบการ        

ลงทุนสามารถมองในรูป Function ไดโดย Input ท่ีใสเขาไปคือ Parameters และ Quotation Data สวน          

output ที่ออกมาคือ คา Optimization Target (ซึ่งในกรณีนี้คือ CAR/MDD) และ ผูใชตองการจะหาคาสูงสุด         

ของมัน  

 

smart optimization algorithms บางรูปแบบ ใชคอนเซปของ ธรรมชาติและวิวัฒนาการของสัตว -       

PSO algorithm, หรือ biological process - Genetic algorithms, และบางรูปแบบกใชหลักคณิตศาสตรท่ี         

คิดคนโดยมนุษย - CMA-ES. 

 

algorithms เหลานี้พบอยูบอยๆในหลากหลายสาขาโดยเฉพาะสาขา Finance สามารถคนหา "PSO     

finance" หรือ "CMA-ES finance" ใน Google แลวคุณจะพบกับหลายๆคําอธิบายและบทความท่ีเก่ียวของ 

 

Non-exhaustive (หรือ "smart") methods จะเฟนหา global หรือ local optimum จุดสูงสุด          

เปาหมายคือการหาจุดสูงสุดของทุก Parameter แตไมใชจุดท่ีโดดออกมาจากพ้ืนท่ีรอบขาง (Curve-Fitting)    

ระบบจะเฟนหา พื้นที่ที่มีระนาบสูงสุดแทนนั่นเอง สยามควอนท 

 

การคนหาโดย algorithm ของ non-exhaustive จะมีลักษณะดังน้ี: 

 

a) optimizer จะสราง starting population ของ parameter set แบบสุม 

b) ระบบจะทําการ Backtest parameter set แตละตัวจาก กลุม population ท่ีสรางข้ึนมา 

c) ผลของ Backtest จะถูกประเมิน ถาหากยังไมพบคาก็จะสุมสราง  Population Set ใหมข้ึนมา 

d) หากระบบคนพบจุดสูงสุด จะหยุดการคนหา หรือ จนกวาจะตรงกับ stop criteria ท่ีวางไว 
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ตัวอยางของ stop criteria เชน: 

 

a) เมื่อระบบรันระบบใหมซํ้าแลวซํ้าเลาไปจนถึงจุดๆหนึ่ง (maximum iterations) 

b) หยุดเมื่อคาที่ดีที่สุดของ X generations ท่ีผานมาเปน 0 

c) หยุดเมื่อถาใส 0.1standard deviation vector เขาไปในแกนแลวพบวาคาของ objective value 

ที่ดีที่สุดไมเปลี่ยนแปลง 

d)  อื่นๆ 

 

หากตองการจะใช smart (non-exhaustive) optimize ในรูปแบบอ่ืนๆใหใสโคดโดยเร่ิมตนจาก     

OptimizerSetEngine function 

 

OptimizerSetEngine("name"); 

 

Amibroker มี 3 engines ใหเลือก: Standard Particle Swarm Optimizer ("spso"), Tribes           

("trib"), and CMA-ES ("cmae") - ช่ือในวงเล็บใหนําไปใสใน (“name”) 

 

ผูใชอาจจะตองการ Set คา internal parameters ในแตละ Engine ใหใช OptimizerSetOption         

function​SiamQuant 

 

OptimizerSetOption("name", value ) function 

 

ฟงกชันนี้จะสราง additional parameters สําหรับ optimization engine ข้ึนมา ซ่ึง paramtere         

เหลานี้จะขึ้นอยูกับ engine ท่ีใช 

Engine ทั้ง 3 ตัวที่ AmiBroker (SPSO, Trib, CMAE) รองรับ สามารถเลือก Parameter ไดแค 2             

ตัวคือ: "Runs" (number of runs) และ "MaxEval" (maximum evaluations (tests)per single run)            

ลักษณะของ parameter ทั้ง 2 จะข้ึนอยูกับ engine ท่ีใช ดังนั้นคาท่ีไดออกมาจาก engine ท่ีแตกตางกันจะ          

ไมเหมือนกัน 
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ความแตกตางของ Runs และ MaxEval ดังนี้ Evaluation (หรือ test) เปรียบเสมือน single          

backtest (ไวประเมินคาของ objective function value) RUN คือ การไลหาจุด optimum value ตาม           

algorithm  ซึ่งมักจะใชหลายๆ evaluations ในการชวยหา 

 

การ run แตละครั้งจะ RESTARTS กระบวนการ optimization ต้ังแตแรกทุกคร้ัง (new initial         

random population) ดังน้ันถาระบบยังไมเจอคาท่ีสูงท่ีสุดของ Population (Global Optimum) การรัน       

อาจจะเจอจุดสูงสุดหรือตํ่าสุดหลายๆจุดจากทุกๆการรันท่ีแตกตางกัน ดังนั้น Run จะเปนตัวกําหนดจํานวน    

การเริ่มคนหาจุด Optimal ในขณะท่ี MaxEval คือจํานวนการประเมินผลหรือ Backtest ในแตละ Run        

เพื่อหาคาที่สูงที่สุด ถาหากจุด optimal นั้นหาไดงายโดยอาจจะใชเพียง1000 test (Evaluations) การรัน       

5x1000 ก็เหมาะสมในการหาจุด Global Optimum เพราะระบบจะมีโอกาสนอยท่ีจะแสดงคา Local      

Optimum เนื่องจากการรันแตละคร้ังจะเร่ิมจาก Random Population ท่ีแตกตางกัน 

 

การเลือก 2 parameter นี้ข้ึนอยูกับ ปญหาท่ีเจอและความซับซอนของระบบ การใช stochastic       

non-exhaustive method ไมสามารถรับประกันไดเสมอไปวาจะสามารถหาจุด global optimum ได      

คําแนะนําสําหรับการตั้งคา Parameter คือ ตั้งคาใหกวางท่ีสุด และ คํานึงถึงระยะเวลาในการคํานวณให      

เหมาะสมวาคุณตองการใชขอมูลในตอนไหน คําแนะนําอีกอยางคือการ คูณ 10 ดวยจํานวน Test ท่ีใสมิติ       

ใหมๆเขาไปนี่อาจจะเปนการเพ่ิมจํานวนการ test เกินความจําเปน แตเพ่ือความแมนยํา ส่ิงสําคัญคือ smart      

optimization methods นั้นจะใชงานไดอยางมีประสิทธิภาพเมื่อ parameter น้ันเปน continuous      

parameter spaces และ objective functions เองมีความราบร่ืนในการหาขอมูล ถาหาก parameter        

space เปนแบบ discrete แลว evolutionary algorithms เหลานี้อาจจะมีปญหาในการหา optimum        

value ซึ่งตัว binary (on/off) parameters นี้ไมเหมาะสมตอการใช smart method เหลาน้ี ทางท่ีดีหากมี          

parameter เปน binary ควร Optimize แต continuous parameters โดยใช smart optimizer           

และเปลี่ยน binary parameters  SiamQuant 

 

SPSO - Standard Particle Swarm Optimizer 
 

Standard Particle Swarm Optimizer นั้นมาจาก SPSO2007 code บนสมมติฐานท่ีวา เราจะ         

สามารถหาผลลัพธที่ดีไดหากเลือก parameters (เชน Runs, MaxEval) ท่ีถูกตองตอแตละปญหา 
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การหาคา Parameter เหลานี้เปนเร่ืองท่ีซับซอนและจะเปล่ียนตามสถานการณ 

 

SPSO.dll จะมาพรอมกับ full source codes ในไฟลยอย"ADK" ตัวอยางโคดของStandard       

Particle Swarm Optimizer : (ตองการหา optimum value จาก 1000 test คนจาก search space 10              

000 combinations) 

 

OptimizerSetEngine("spso");  

OptimizerSetOption("Runs", 1 ); 

OptimizerSetOption("MaxEval", 1000 ); 

 

sl = Optimize("s", 26, 1, 100, 1 ); 

fa = Optimize("f", 12, 1, 100, 1 ); 

 

Buy = Cross( MACD( fa, sl ), 0 );  

Sell = Cross( 0, MACD( fa, sl ) ); 

 

TRIBES - Adaptive Parameter-less Particle Swarm Optimizer 
 

Tribes เปนอีกเวอรช่ันของ PSO (particle swarm optimization) non-exhaustive optimize        

ซึ่งจะมีลักษณะที่เปน Adaptive และ Parameter-less adaptive รายละเอียดทางดานวิทยาศาสตรหาดูไดท่ี: 

http://www.particleswarm.info/Tribes_2006_Cooren.pdf 

 

ในเชิงทฤษฎีแลวควรจะทํางานดีกวา regular PSO เพราะมันสามารถ ปรับเปล่ียน swarm sizes       

และ algorithm strategy ตอปญหาท่ีมันกําลังแกอยูนั่นเอง 

 

ผลออกมาพบวาทํางานไดใหผลคลายคลึงกับ  PSO 
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สําหรับ Tribes.DLL plugin จะใชงาน "Tribes-D" (i.e. dimensionless) variant.อางอิงจาก        

http://clerc.maurice.free.fr/pso/Tribes/TRIBES-D.zip​ โดย Maurice Clerc 

 

Tribes.DLL มีโคดเต็มตัวอยูใน “ADK” Folder 

 

Supported parameters : "MaxEval" - maximum number of evaluations (backtests) per run            

(default = 1000). 

 

 OptimizerSetOption("MaxEval", 1000 ); 

 

ผูใชควรจะเพิ่มจํานวน evaluations ตาม Dimension ท่ีเพ่ิม (จํานวน Parameters ท่ีอยาก        

Optimize) 

 

คา default 1000 เหมาะสําหรับ 2 - 3 dimensions 

 

"Runs" - number of runs (restarts). (default = 5 ) 

คุณสามารถทิ้งคานี้ไว 5 

โดยทั่วไปแลวคานี้จะถูกตั้งไวท่ี 5 

 

หากตองการใช Tribes optimizer ใหใสโคดดังกลาว  

 

OptimizerSetEngine("trib"); 

OptimizerSetOption("MaxEval", 5000 ); // 5000 evaluations max 

 

  CMA-ES - Covariance Matrix Adaptation Evolutionary Strategy optimizer 
 

CMA-ES (Covariance Matrix Adaptation Evolutionary Strategy) เปน engine 

ที่ซับซอนขึ้นไปอีก สําหรับขอมูลเชิงวิทยาศาสตร scientific background see: 
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http://www.bionik.tu-berlin.de/user/niko/cmaesintro.html 

พบวาวิธีนี้ใหผลดีกวา อีก 9 วิธีท่ีมีความโดงดัง (like PSO, Genetic and Differential evolution). 

http://www.bionik.tu-berlin.de/user/niko/cec2005.html 

 

CMAE.DLL ใช "Global" variant ของการ search และ restarts หลายๆคร้ังโดยแตละคร้ังเพ่ิม         

จํานวน population size 

 

CMAE.DLL มากับโคดเต็มรูปแบบในไฟล “ADK” 

 

โดย default จํานวนของ runs (or restarts) ตั้งไวท่ี 5 ซึ่งเราแนะนําใหคงคาน้ันไว 

 

ผูใชอาจจะปรับเปลี่ยนได OptimizerSetOption("Runs", N ) และจํานวนควรจะอยูในชวงของ     

1..10. การใสจํานวน Run ที่มากกวา 10 ข้ึนไปนั้นเราจะไมแนะนําถึงแมวาเปนไปไดก็ตาม 

 

หมายเหตุ จํานวน run ในแตละคร้ังจะมี Population Size ท่ีเพ่ิมข้ึน 2 เทา โตแบบ exponentially           

ดังนั้นหากมี 10 runs คุณจะจบท่ี population ท่ีมีขนาดมากกวาตัว population ใน run คร้ังแรกถึง 2^10           

(1024 times) เทา สยามควอนท 

 

นอกจากนี้ยังมี parameter อีกตัว "MaxEval" คา default จะอยูท่ี ZERO ซ่ึงหมายความวาระบบ         

จะคํานวณหา MaxEval เอง เราแนะนําใหใชคา Default นี้ ตัว algorithm จะ minimize number of            

evaluations และเขาหาคําตอบใหเร็วท่ีสุดอยูแลว และมักจะหาไดเร็วกวากลยุทธอ่ืนๆ 

 

มันเปนเรื่องปกติที่ระบบจะขาม evaluations steps ถึงแมวามันจะหาคําตอบไดก็ตาม และคุณไม     

ควรจะแปลกใจที่ ระบบสามารถ optimize ไดรวดเร็วในบางชวง plugin มีความสามารถท่ีจะเพ่ิม number       

of steps (Evaluation) ถาหากจําเปนตอการหาคําตอบ เนื่องจากระบบมีลักษณะท่ีเปน Adaptive เปล่ียน       

แปลงอยูตลอดเวลา ดังนั้น "estimated time left" และ "number of steps" ท่ีแสดงใหเห็นเปนเพียงคา          

ประมาณการณเทานั้น SiamQuant 
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  หากตองการจะใช CMA-ES optimizer ใสโคดดังกลาว:  

 

 OptimizerSetEngine("cmae"); 

 

ซึ่งระบบจะ Run Optimization ดวยคา Default Setting 

 

ขอสังเกตคือสําหรับการ Optimize แบบ continouos-space search โดยใช algorithms น้ัน        

ถาหากผูใชลด Step หรือจํานวนการเพ่ิมข้ึนของคา Parameter ใน Optimize() function น้ันจะไมมีผลตอ        

ระยะเวลาในการ Optimization มาก ส่ิงท่ีมีผลตอระยะเวลามากท่ีสุดคือ "dimension", น่ันก็คือจํานวนของ      

parameter ที่ตองการจะ Optimize (จํานวนของฟงกชชัน Optimize ท่ีถูกเรียก) ดังน้ัน จํานวน Step         

สามารถตั้งไดโดยไมมีผลกระทบตอ optimization time โดยทฤษฎีแลว algorithm ควรจะหาคําตอบไดภาย      

ใน 900*(N+3)*(N+3) backtests เมื่อ "N" คือคา dimension โดยปฏิบัติแลวมันจะเคล่ือนเขาหาคําตอบเร็ว        

กวานั้น ตัวอยางเชนถาใหหาคําตอบเมื่อ N=3 จาก dimensional parameter space ท่ี 100*100*100 = 1           

million exhaustive stepsคุณสามารถหาไดภายใน 500-900 CMA-ES steps 

 

Multi-threaded individual optimization 
 

ตั้งแต AmiBroker 5.70 ข้ึนไปนอกเหนือจากการทํา multiple-symbol multi threadin แลวคุณ        

ยังสามารถทํา multi-threaded single-symbol optimization ได การใชงานเร่ิมตนจากคลิกเลือกลูกศรลง      

จากปุม Optimize ในหนาตาง New Analysis window และเลือก "Individual Optimize" 
 

"Individual Optimize" จะใชทุก processor cores ท่ีมีอยูเพ่ือประมวลผล single-symbol 

optimization ทําใหไดคาที่เร็วกวาการทํา optimization แบบธรรมดา 
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หากตั้ง "Current symbol" mode ระบบจะ Optimize เพียงตัวน้ันตัวเดียว แตหาก ต้ังคา"All         

symbols" และ "Filter" ระบบจะทําการ Optimize แตละตัวตามลําดับไปเร่ือยๆ น่ันคือ Optimize ตัวท่ีหน่ึง         

เสร็จ Optimize ตัวที่สองตอไปเร่ือยๆ 

 

 ขอจํากัด : 

1. ไมรองรับ Custom backtester  

2. ไมรองรับ Optimization แบบ Smart optimization engines  

 

คําอธิบายของขอจํากัดสามารถหาดูได Tutorial: Efficient use of multi-threading 

สุดทายแลว Amibroker อาจจะรองรับกระบวนการเหลานี้ในอนาคต 
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Walk-forward testing 
  

คุณสมบัติเดนใน AmiBroker ตั้งแตเวอรช่ัน 5.10 ข้ึนไปก็ คือ โหมดการทดสอบ Walk-Forward        

โดยอัตโนมัติ การทดสอบ Walk-Forward โดยอัตโนมัติ นั่นหมายถึง ระบบๆหน่ึง ท่ีเราออกแบบไว ดวยส        

มมุติฐานที่วา เราทําการ Optimize พารามิเตอรตางๆของขอมูลในอดีต (in-sample) และ หลังจากน้ัน       

เราจะวัดผลศักยภาพของระบบของเรา ดวยการทดสอบมันตอไปขางหนาซ่ึงตอจากขอมูลชุดเกาอีกทีหน่ึง  

(out-of-sample) (การ วัดศักยภาพของระบบนั้น จะตองดูผลลัพธจากการทดสอบขอมูล Out of sample       

เทานั้น เราจะไมวัดผลจากขอมูลท่ีเรานํามาทําการ Optimize ) โดยกระบวนการน้ี เราไมจําเปนตองทดสอบ      

โดยใหขอมูลทั้งสองชวงที่ตอเนื่องกันก็ได (ขอมูล Out of Sample กับ In Sample ไมจําเปนตองตอเน่ืองกัน ) 

 

ภาพประกอบตอไปน้ีแสดงใหเห็นถึงวิธีการทํางานของระบบการทํางานกระบวนการน้ี S​(โปรดทําความเ

ขาใจรูปดังกลาวก็อานหัวขอถัดๆไป) SiamQuant 
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จุดประสงคของการทํา Walk Forward คือ การทดสอบวา ไมวาจะเปนในชวงเวลาใดก็ตาม      

ระบบของเราที่ทําการ Optimize ไวนั้น จะเปนอยางไร มันจะมีความสมจริงท่ีเปนไปได (realistic) หรือ เกิด        

curve-fitting กันแน ศักยภาพของระบบสามารถท่ีจะวัดผลของความสมจริงได (realistic) มีเง่ือนไขสองอยาง     

คือ ผานการทดสอบขอมูลในสวนท่ีเราไมเห็นขอมูลมากอน (ขอมูล Out of sample) และ อีกขอหน่ึงคือ        

เมื่อเราออกแบบระบบเสร็จเรียบรอยแลวเทานั้น ในการเทรดจริง ประสิทธิภาพของระบบควรจะใกลเคียงกับ   

ตอนที่เราทําการ Optimize เพราะฉนั้น ระบบ จะใชงานไดดีก็ตอเมื่อมันถูกทดสอบดวย walk forward แลว        

หรือ เราสามารถที่จะพูดไดในอีกทางหนึ่งคือ เราไมไดสนใจเกี่ยวกับผลลัพธของการทดสอบในชวง In sample     

(เพราะมันแนนอนอยูแลววาผลลัพธมันจะตองออกมาวาดี) สําหรับการทดสอบกันขอมูล Out of Sample น้ัน      

จะเปนการประมาณการที่มีความสมจริง และ วัดประสิทธิภาพของระบบออกมาได วาเกิดปญหาจาก curve     

fitting หรือไม และ ถาหากผลลัพธจาก Out of sample ออกมาไมดีแลวน้ัน คุณก็ไมควรท่ีจะนําระบบน้ีมา         

เทรดจริงเชนกัน 

 

คาพารามิเตอรที่เปนผลลัพธท่ีไดมาจากการ optimize นั้น มีหลักฐานบงช้ีวาการท่ีเรา optimize     

ขอมูลในอดีตที่เพิ่งผานมา จะไดผลลัพธท่ีดีกวาการท่ีเรา optimize ขอมูลท่ีผานมานานมากๆแลว พวกเรา     

คาดหวังเปนอยางยิ่งเสมอวาพารามิเตอรท่ีเราเลือกในการ optimize นั้น จะสอดคลองกับสภาวะของตลาด    

ในตอนที่เรานําระบบไปใช เราจะไดสามารถนํามันไปใชไดทันที (คือ Optimize เสร็จ ก็หวังวาพารามิเตอรท่ีเรา      

Optimize ไวนั้นมันจะยังคงใชไดดีอยู) แตชวงเวลาดังกลาวท่ีเราเลือกมาทดสอบน้ัน อาจจะเปน หรือ     

อาจจะไมเปนชวงเวลาที่ตลาด ผานวัฐจักรท้ังแบบ ขาลง และ ขาข้ึน ก็ได ดังน้ัน คุณควรท่ีจะระมัดระวังในการ        

เลือกชวงระยะเวลาที่จะการนํามาใชสําหรับการทดสอบ ขอมูลเพ่ิมเติมเกี่ยวกับการออกแบบระบบ และ การ    

ตรวจสอบการใชกระบวนการ การทํา walk-forward รวมถึง ข้ันตอนและทุกประเด็นท่ีเก่ียวของน้ัน     

เราแนะนําใหคุณที่จะอานหนังสือของ Howard Bandy : "Quantitative Trading Systems" (ดูลิงคไดบน        

หนาเว็ปไซต AmiBroker) เพื่อท่ีคุณจะไดมีความเขาใจท่ีมากข้ึน 

 

 เพื่อการใชงานฟงชันก Walk-Forward optimization โปรดทําตามข้ันตอนดังตอไปน้ี :  

 

1.ไปที่ Tools-> Automatic Analysis (ถาหาไมเจอใหเขาหนา Analysis เหมือนตอนท่ีเราทํา backtest) 

2. คลิกปุม Setting และ เลือกไปท่ีแถบขอมูลท่ีช่ือวา Walk-Forward สยามควอนท 
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3. ทีนี้คุณก็จะเห็นการตั้งคาการทํา Walk Forward ในสวนของ In-sample เพ่ือทําการ optimization        

และ out-of-sample เพื่อทําการ backtest 

 

วันที่ Start และ End คือการเลือกชวงเวลาท่ีทําการเร่ิมตน และ ส้ินสุด ชวงเวลาดังกลาวท่ีเราต้ังคาไว        

จะเคลื่อนที่ไปขางหนาทีละ Step จนกระท้ัง End (ไปตรงกับวันสุดทายท่ีเราตั้งคาไวพอดี) 

 

วันที่เริ่มตน (Start) เราสามารถตั้งคาใหมันเคล่ือนท่ีไปขางหนาเปน Step หรือ ถาอยากต้ังล็อกให      

วันที่ทําการเริ่มตนที่เวลาเดียวกันก็ได หากติ๊กท่ีชอง Anchored  

  

นอกจากนี้ หากคุณต๊ิกชอง Use today ขอมูลในชอง Last นั้นจะไมถูกนํามาพิจารณา แตจะดึงขอมูล        

ในวันปจจุบันมาใชแทน  
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โดยคาเริ่มตนของโปรแกรม จะถูกเลือกไวใหเปน “EASY MODE” ซ่ึงเปน กระบวนการท่ีงายท่ีสุด      

ของการตั้งคาในการทําทํา Walk Forward  

 

ซึ่งมันมีสมมุติฐานดังนี้: 

 

a) สวนของ Out-of-sample จะตอเนื่องกับชุดขอมูลในสวนของ In-sample 

b) ระยะความกวางของ Out-of-sample หนึ่งชวงจะมีคาเทากับความกวางของ Step 

 

นอกจากสมมุติฐาน 2 ขอ ดังกลาวแลว “EASY Mode” จะใช วันสุดทาย(END) ของ in-sample ให           

เปนวันเดียวกับวันที่เริ่มตน (START) ของ out-of-sample และ จะใชชวงเวลท่ีระบุใน STEP ของ In-sample         

เปนตัวกําหนดเวลาในการทํา out-of-sample  

  

คาของ Step ที่ตั้งไวใน In-sample และ Out-of-sample นั้นจะถูกต้ังคาไวเปนคาเดียวกัน ( “EASY         

Mode” นั้นจะรับประกันความถูกตองของกระบวนการ Walk-Forward ในการต้ังคา ) SiamQuant 

  

คุณควรจะใช Easy mode (EOD) เมื่อคุณทดสอบขอมูลท่ีเปน End-of-day หรือ Easy mode         

(Intraday) เมื่อคุณทดสอบขอมูลท่ีเปน Intraday ส่ิงท่ีแตกตางกันก็คือ ใน “EOD mode” วันสุดทาย (END)         

ของชวงเวลากอนหนา และ วันเร่ิมตน (START) ของชวงเวลาถัดไป จะเปนวันเดียวกัน เพ่ือปองกันการเกิด       

ชองวางในการทําการทดสอบระหวาง 2 ชวงเวลา สวน “Intraday mode” จะต้ังใหวันเร่ิมตน (START)        

ของชวงเวลาถัดไป เปนวันถัดไป หลังจากวันสุดทาย (END) ของชวงเวลากอนหนา ซ่ึงการทําแบบน้ี ทําให       

สามารถรับประกันไดวา จะไมเกิดการทําซํ้าเมื่อทดสอบขอมูลแบบ intraday 

  

ใน Advanced mode ผูใชงานจะสามารถควบคุม คาตางๆไดท่ีถูกล็อกไวใน Easy Mode ไดท้ังหมด        

เพื่อที่จะขยายขอบเขตการทํางานของกระบวนการทํา Walk Forward หนาตางจะเปดใหเลือกต้ังคาในสวน    

ของ In-sample และ Out-sample โดยการติ๊กเคร่ืองหมายถูก (สามารถท่ีจะใหทําการ backtest โดยปราศ        

จากการ Optimize ได) การต้ังคาท้ังหมดจะแสดงผลทันทีในชองหนาตางแสดงท่ีดานลาง ในสวนของ IS/OOS      

และ วันเวลาที่กําหนด 
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4. ในชองของ Optimization target คือ การเลือกผลลัพธการ Optimize ท่ีเราตองการใหแสดงออกในรูป        

ของ Colum ซึ่งมันจะถูกใชเพ่ือเรียงขอมูลเพ่ือหาผลลัพธท่ีดีท่ีสุดอยางหนึ่ง (เอาไวใหเราใช sort ขอมูล) ใน       

หนาตางของการทดสอบ คาเร่ิมตนท่ีโปรแกรมตั้งไวก็คือ CAR/MDD ซึ่งคุณสามารถท่ีจะเปล่ียนมันเปนคาอ่ืนๆ    

ก็ทําไดเชนกัน ตามที่คุณตองการ นอกจากนี้คุณสามารท่ีจะใสคา เพ่ือท่ีจะสรางคาผลลัพธท่ีคุณตองการจะให    

โปรแกรมแสดงผลลัพธออกมาไดเชนกันดวยการใช custom backtester interface 

 

5. หลังจากที่คุณตั้งคาตางๆเรียบรอยแลวใหคุณกลับไปท่ี Automatic Analysis 

 

6. คุณจะเห็บแถบดานลางของการทดสอบ ใหคุณเลือกไปท่ีแถบชีทท่ีเขียนวา “Walk Forward     

Optimization” โปรแกรมจะ รันลําดับของการ optimize และการ backtest รวมถึงผลลัพธในหนาตาง       

แสดงผลของ Walk Forward ขณะท่ีการ optimize กําลังประมวลผลอยู คุณสามารถท่ีจะคลิกปุม       

“MINIMIZE” โปรแกรมจะแสดงผลลัพธของการ Walk Forward ขณะท่ีมันกําลังประมาณผลไดทันที 
 

การสรางเสน IN-SAMPLE และ OUT-OF-SAMPLE (IN-SAMPLE and OUT-OF-SAMPLE 

combined equity) 
  

เสน equities ในสวนของ in-sample และ out-sample นั้นถูกแยกเก็บกันไวอยางชัดเจนใน ticker        

ชื่อ ~~~ISEQUITY และ ~~~OSEQUITY(ชวงเวลาท่ีตอเนื่องกันของ IS และ OOS จะถูกแบงแยกกัน        

ในคนละสเกล เพื่อจะทําใหเสน equity มีความตอเนื่องกัน โดยท่ัวไปแลวจะเปนการพูดถึง compounding      

profits ) 

  

คุณสามารถแสดงผลของเสน equityท้ังในสวน  IS และ OOS ดังตอไปนี้ได:  
  

PlotForeign("~~~ISEQUITY","In-Sample Equity", colorRed, styleLine); 

PlotForeign("~~~OSEQUITY","Out-Of-Sample Equity", colorGreen, styleLine);  

Title = "{{NAME}} - {{INTERVAL}} {{DATE}} {{VALUES}}"; 
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บันทึกสรุปผลลัพธโดยรวมจากขอมูล OUT-OF-SAMPLE (ใหมสําหรับเวอรช่ัน 5.60) 

(OUT-OF-SAMPLE summary report (new in 5.60)) 
  

นี่เปนการเปลี่ยนแปลงคร้ังใหญในการทําการทดสอบแบบ walk Forward เพ่ือท่ีจะสรางบันทึกสรุป    

ผลจากขอมูล Out-of-sample ออกมา ส่ิงท่ีสําคัญท่ีสุดในการเปล่ียนแปลงในคร้ังน้ีคือ ในการลําดับขอมูลใน     

แตละชุดนั้น เงินทุนเริ่มตนจะใชเทากับเงินทุนของชวงกอนหนา (เอาเงินทุนท้ังหมดหลังจากการทดสอบชวง   

กอนหนาเสร็จ) จากที่แตเดิมใชเปนคาเงินทุนเร่ิมตนคงท่ีเลย (เชน เงินทุนเร่ิมตน 1 แสน พอทดสอบขอมูลชุด       

ใหมก็ใช 1 แสนไปเรื่อยๆ ไมคํานึงถึงตนทุนกอนหนาท่ีเปล่ียนแปลงไปจากการลงทุน) การเปล่ียนแปลงน้ีจะ     

เหมาะสมสําหรับการคํานวณทางสถิติ / ตัวช้ีวัดท่ัวทุกสวนจากการทดสอบขอมูล out-of-sample  

 

บันทึกสรุปผล จะแสดงถึงขอมูลตัวช้ีวัดตางๆอยางถูกตองจากขอมูล out-of-sample ท้ังหมด    

แตบันทึกสรุปผล[แบบกําหนดเอง] จะตองถูกระบบโดยผูใช ดังนี ้

 

1 คาเริ่มตน, 2 คาสุดทาย, 3 คารวม, 4 คาเฉล่ีย, 5 คาตํ่าสุด, 6 คาสูงสุด 

 

โดยคา default ของผลสรุปรวมนั้นจะแสดงคาสุดทายของตัวช้ีวัดท่ีเรากําหนด เวนแตวา ผูใชจะ     

กําหนดตัวชี้วัดอยางเฉพาะเจาะจงในรูปแบบ 

 

bo.AddCustomMetrics() call 

  

bo.AddCustomMetrics คือ การกําหนดคาพารามิเตอรท่ีจะแสดงผลใหม - CombineMethod 

  

bool AddCustomMetric( string Title, variant Value, [optional] variant LongOnlyValue, 

[optional] variant ShortOnlyValue , [optional] variant DecPlaces = 2, [optional] variant 

CombineMethod = 2 ) 

  

วิธีการนี้จะเพิ่มตัวบงช้ีท่ีเรากําหนดเองในผลลัพธการ backtest ของเราในสวนของ backtest report 

, backtest "summary" และ ผลลัพธของการ optimization 
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Title คือชื่อของตัวบงช้ีท่ีจะแสดงในบันทึกสรุปผล, Value คือ คาของตัวบงช้ีน้ันๆ ,      

LongOnlyValue, ShortOnlyValue เพ่ือรองรับ คาของการ long/short เพ่ือสรางคอลัมในบันทึกการสรุป      

ผลและ ตัวสุดทาย DecPlaces จะคอยควบคุมจํานวนตําแหนงทศนิยมท่ีจะแสดงผลออกมา SiamQuant 

 

ขอมูลการสนับสนุน CombineMethod มีคาตางๆดังนี้ : 

 

1  คาเริ่มตน - บันทึกสรุปผล จะแสดงคาตัวบงช้ีท่ีกําหนดจากข้ันตอนเร่ิมแรกสุดของขอมูล 

out-of-sample 

2  คาสุดทาย (default), - บันทึกสรุปผล 

จะแสดงคาตัวบงชี้ที่กําหนดจากข้ันตอนสุดทายสุดของขอมูล out-of-sample 

3  คารวม - บันทึกสรุปผล จะแสดง ”ผลรวม” 

ของคาตัวบงชี้ที่เรากําหนดจากข้ันตอนท้ังหมดของขอมูล out of sample 

4  คาเฉลี่ย - บันทึกสรุปผล จะแสดง “คาเฉล่ีย” 

ของคาตัวบงชี้ที่เรากําหนดจากข้ันตอนท้ังหมดของขอมูล out of sample 

5 คาตํ่าสุด - บันทึกสรุปผล จะแสดง “คาตํ่าท่ีสุด” 

ของคาตัวบงชี้ที่เรากําหนดจากข้ันตอนท้ังหมดของขอมูล out of sample 

6 คาสูงสุด - บันทึกสรุปผล จะแสดง “คาสูงท่ีสุด” 

ของคาตัวบงชี้ที่เรากําหนดจากข้ันตอนท้ังหมดของขอมูล out of sample 

 

หมายเหตุ : วิธีการคํานวณตัวช้ีวัดนั้นมีความซับซอนเปนอยางมาก ยกตัวอยางคือ การหาคาเฉล่ีย มัน      

จะมีการคํานวณทางคณิตศาสตรท่ีไมถูกตองเทาไหรนักหากคํานวณเอง ผลสรุปของตัวบงช้ีท่ีมีอยูแลวใน  

โปรแกรม จะมีการคํานวณทางคณิตศาตรท่ีถูกตอง out-of-the-box (ยกตัวอยางเชน มันจะไมทําการหาคา     

เฉลี่ยโดยตรง แตจะหาวิธการคํานวณท่ีเหมาะสมกับตัวบงช้ีนั้นๆ) ความขัดแยงน้ีเกิดจากการสรางตัวบงช้ีดวย   

ตัวเอง เนื่องจากพวกเขาใช user-definable (โหมดท่ีผูใชเปนคนกําหนดตัวแปรดวยตนเองท้ังหมด) ซ่ึงมันข้ึน     

อยูกับผูใชที่จะเลือกรวม (combining) วิธีการตางๆเขาดวยกัน มันยังคงเกิดข้ึน การวิธีการคํานวณแบบ     

ประมาณคาตางๆ  สยามควอนท 
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การจําลองดวยวิธี Monte Carlo 

(Monte Carlo Simulation of your trading system) 
  

หมายเหตุ: หัวขอขั้นสูง โปรดแนใจแลววาคุณไดอานหัวขอกอนหนา 
  

บทนํา (Introduction) 
  

โดยทั่วไปแลว หากพูดถึงวิธีการทํา "Monte Carlo" จะถูกแทนในเร่ืองของวิธีการทางคอมพิวเตอร     

ที่มีการทดสอบแบบ ซํ้าแลวซํ้าอีก เพ่ือใหไดคุณสมบัติตามกระบวนการกําหนดไว มันถูกสรางข้ึนโดย นักนัก     

คณิตศาสตร ชาวโปแลนดที่มีช่ือวา Stanislaw Ulam เร่ืองมีอยูวา ขณะนั้นเคาทํางานเก่ียวกับการวิเคราะห      

อาวุธนิวเคลียรที่ Los Alamos lab ในขณะท่ีเขาไมสามารถท่ีจะวิเคราะห กระบวนการทางกายภาพท่ีซับซอน      

ไดดวยวิธีการทางคณิตศาสตรท่ัวๆไป เขาก็นึกข้ึนไดวาเขาสามารถท่ีจะสรางชุดการทดลองแบบสุมข้ึนมาเพ่ือท่ี  

จะเอาไวสังเกตุมันได 

  

เกี่ยวกับเรื่องราวและวิธีการเกี่ยวกับ Monte Carlo โดยท่ัวไปแลว คุณสามารถเขาไปศึกษาขอมูล     

เพิ่มเติมไดที่นี่  https://en.wikipedia.org/wiki/Monte_Carlo_method 

  

ในการพัฒนาระบบเทรดนั้น การสรางแบบจําลอง Monte Carlo หมายถึง กระบวนการของการสุม      

ลําดับของการเทรด เพื่อประเมินผลทางสถิติของระบบการเทรดนั้นๆ มันมีอยูหลายวิธีการทีเดียว ท่ีจะคํานวณ    

ผลลัพธออกมาดวยวิธีการที่แตกตางกันไป (แตกตางกันเมื่อลึกลงไปรายละเอียด) แตวิธีการคํานวณท่ีตรงไป   

ตรงมามากที่สุด และดูสมจริงมากท่ีสุดก็คือวิธีการทํา bootstraping ซึ่งดําเนินการสุมตัวอยางโดยการแทนท่ี    

trade list ที่เกิดจากการ backtest ลงไป 

  

ไปที่ ​https://en.wikipedia.org/wiki/Bootstrapping_(statistics) เพ่ือศึกษาเก่ียวกับการ   

พิจารณาดวยวิธี bootstrapping  
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วิธีการจําลองดวยวิธี Monte Carlo แบบตางๆนั้น จะชวยใหระบบเทรดมีความย่ังยืน (robustness)      

และชวยหาวา โอกาสทางสถิติท่ีระบบจะพังเปนเทาไหร รวมถึงสามารถท่ีจะหาคาทางสถิติแบบอ่ืนๆ ไดอีก    

ดวย 

  

แลวมันทํางานอยางไรบน AmiBroker? (How does it work in AmiBroker?) 
  

เพื่อที่จะทํา Monte Carlo simulation (หรือการทดสอบ bootstrap ) กับระบบของคุณ, กระบวน         

การบน Amibroker เปนดังนี้ : 

  

A. สรางชุดขอมูลที่จะทําการปอน 

  

A.1 ดําเนินการ backtest ระบบเทรดของคุณ เพ่ือสรางชุดขอมูลการเทรดดังเดิมท้ังหมด N  เทรด 

  

B. ทําซํ้า (1000+ คร้ัง) 

  

B.1 สุมเลือก trade list จากขอมูลการเทรดดังเดิม เพ่ือท่ีจะนํามาเรียงและสรางขอมูลการเทรด      

ชุดใหมๆออกมาก ซึ่งจะสมจากการเทรดท้ังหมด N คร้ัง (ขอมูลท้ังหมดท่ีเกิดจากวิธีน้ี เรียกวา      

realization)​SiamQuant 

  

ชุดขอมูลที่เกิดจากการสุมดังกลาวจะยังมีจํานวนขอมูลในการเทรดเทาเดิม ระบบจะทําการสุม ราย   

การเทรดบางรายการก็อาจจะถูกขามไป หรือ ถูกใชซํ้าก็ได (เปนการเปล่ียนแปลงโดยการทําซ้ํา หรือ     

การเปลี่ยนแปลงโดยการแทนท่ี) (จากผูแปล : ตรงนี้เหมือนกับการท่ีเราสุมเลือกรายการเทรดท่ีมีต้ัง    

แต A ถึง D (สมมุติใหมีการสุม 4 คร้ัง) สมมุติวาเราหยิบได A เมื่อเราเอา A เก็บเขาไปแลวการสุมคร้ัง            

หนาเราอาจจะได A อีกก็ได และเมื่อเราจบการสุมท้ังหมด 4 คร้ังแลวก็ไมจําเปนท่ีตองสุมไดครบท้ัง A       

B C D ถูกไหมครับ อาจจะขาดตัวใดตัวหนึ่งไปก็ได) เนื่องจากขอมูลของการทํา realization       

ที่ไมซํ้ากันคือ N^N (ดังนั้นแคการเทรด 100 เราก็จะมี 10000 realization ท่ีแตกตางกันเรียบรอย        

แลว) และดวยจํานวนการเทรดท่ีมีนัยยะสําคัญนั้น (>100) โอกาสท่ีจะเลือกไดขอมูลท่ีมีการเรียงกัน    

ของ trade list ดังเดิมชุมเดิมนั้น แทบจะเปนศูนยเลยทีเดียว 
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B.2 การคํานวณ gain/loss ในแตละการสุมเลือกนั้น จะใช position sizing ในการสราง equity  

ของระบบ 

  

B.3 บันทึก equity ของระบบโดยการกระจายตัว (distribution) 

  

C.  กระบวนการ 

  

C.1 ประมวลผลขอมูลท่ีไดจากข้ันตอน B เพ่ือสรางการกระจายตัวทางสถิติ และ กราฟ ข้ึนมา 

  

ขั้นตอนทั้งหมดที่กลาวมาดานบนนี้ จะเกิดข้ึนเมื่อคุณกดปุม Backtest แคปุมเดียวเทาน้ัน ในหนาตาง     

New Analysis กระบวนการจําลองดวยวิธี Monte Carlo บน Amibroker น้ัน รวดเร็วมากและใช เวลาแค          

เสี้ยววินาทีเทานั้น บนการ backtest แบบปกติ 
  

การตั้งคา (Settings) 

  

การที่การจําลองดวยวิธีการ Monte Carlo จะทํางานไดนั้น สามารถควบคุมท้ังหมดไดจากหนา     

Analysisi Setting ในสวนของแถบ Monte Carlo 
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Enable Monte Carlo simulation 

เมื่อกลองนี้ถูกติ๊กเม่ือไหรก็ตาม ระบบจะทําการจําลองแบบ Monte Carlo โดยอัตโนมัติ โดยเปน       

สวนหนึ่งของการ backtest (ขอมูลจะแสดงผลอยูใน backtest report ในทางแถบดานขวาเม่ือทําการ      

backtest เสร็จ ) 

  

Number of runs 

 แสดงถึงจํานวนครั้งในการทําการจําลองแบบ Monte Carlo (ควรท่ีจะมากกวา 1000 คร้ัง) 

Position sizing 

 เพื่อเลือกการใช position sizing ในการทําแบบจําลองดวยวิธีการ Monte Carlo  : 
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Don't change - ใชขนาดของ position size        ดั้งเดิมท่ีใชอยูในระหวางการ backtest  

Fixed size - ใชจํานวนคงท่ีของจํานวนหุน และ สัญญา ตอการเทรด  

Constant value - ใชจํานวนเงินเทาเดิมในการเทรดแตละคร้ัง  

Percent of equity - ใชเปอรเซ็ยของการจําลองของมูลคา equity กอนหนา  

  

Enable MC equity curves (Min/Max/Avg) 

เพื่อเปดกราฟ Monte Carlo equity (รวมถึง คาสูงสุด, ตํ่าสุด และ คาเฉล่ียของ equity นอกจากน้ี            

ยังมีกราฟที่แสดงถึง equity ในแตละการสุมแตละคร้ังอีกดวย) 

 

หมายเหตุ : เสนสีเขียว และ สีแดง (min/max equity) ไมไดหมายถึง สัญญาณท่ีแยท่ีสุด หรือ ดีท่ีสุด           

พวกมันหมายถึงจุดที่ bar-by-bar สูงท่ีสุด (max) และ ตํ่าท่ีสสุด( min) ของ equities ท้ังหมดท่ีถูกสรางดวย          

วิธีการจําลองแบบ Monte Carlo 

ดังนั้นพวกมันจึงเปนท้ัง จุดท่ีดีท่ีสุด ของ equity ท้ังหมด แตก็เปนจุดท่ีแยท่ีสุด ของ equity ท้ังหมด         

เชนกัน นอกจากนี้ เสนสีนํ้าเงิน (avg) แสดงถึงคาเฉล่ียของ equity ท้ังหมด 

  

Show absolute value - แสดงมูลคา แอปโซลูท ของ equities  

  

Show Percent change - แสดง equities เปน "rate of change" ต้ังแตท่ีมันเร่ิมมา 

  

Straw broom chart plots - กําหนดจํานวนการทดสอบ equites ซ่ึงควรสรางออกมาในรูปของ        

กราฟ Straw broom (หากจํานวนเยอะมากๆ จะทําใหกระบวนการสวนน้ีเกิดความลาชา) 
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การอานและตีความผลลัพธจากการทดสอบแบบ Monte Carlo (Interpreting the 

results)​สยามควอนท 
  

ผลลัพธของการจําลองดวยวิธีการ Monte Carlo จะแสดงผลไวในหนา "Monte Carlo ของผลลัพธ       

การ backtest SiamQuant 

  

ดานบนสุดของหนา เราจะเห็นตารางท่ีแสดงถึงคาสําคัญๆทางสถิติ ท่ีเกิดจากการกระจายตัวของ   

ผลลัพธการจําลองดวยวิธี Monte Carlo และนี่ คือตัวอยางของผลลัพธ (บริเวณท่ีเนนเปนสีน้ําเงินเพ่ืองายตอ      

การอธิบาย ตอนผลลัพธออกมาจริงๆจะไมมี) ในตัวอยาง จะเร่ิมตนดวยเงิน 10,000 โดยสอบกับขอมูล      

End-of-day เปนเวลา 7 ป 
 

  Final Equity Annual Return Max. Drawdown $ Max. Drawdown % Lowest Eq. 

1% 5706 -7.37% 1302 7.23% 3618 

5% 7987 -3.02% 1549 9.76% 5853 

10% 9706 -0.41% 1726 11.32% 6690 

25% 12851 3.48% 2136 14.38% 8107 

50% 16174 6.78% 2747 19.77% 9135 

75% 19632 9.64% 3563 27.63% 9640 

90% 23258 12.21% 4626 38.48% 9922 

95% 25269 13.48% 5292 45.47% 10000 

99% 29139 15.71% 7685 63.82% 10000 

 

คอมลัมแรก แสดงถึงระดับเปอรเซนตไทด (คาดานลางจะใหคาเปอรเซ็นตไทดท่ีใชในการสังเกตการท่ี   

ระบบจะลมเหลว) ลองมาดูกันท่ี ระดับเปอรเซ็นตไทดท่ี 10 มันบอกวาจากการสังเกตขอมูล 10% ไดผลลัพธ       

ออกมาดังคาตามตารางนี้ ยกตัวอยางเชน คาของ annual return ท่ี ระดับเปอรเซ็นตไทดท่ี 10 จะเทากับ         

-0.41% หมายถึง 10% จากการทดลองท้ังหมด (realizations) จะมี annual profit นอยกวาหรือเทากับ         
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ที่แสดงไว (-0.41%) ดังนั้นเราสามารถท่ีจะบอกไดวามีโอกาส 10 % ท่ีระบบของเราจะไมทําเงินใหเราเลย      

นอกจากนี้ คา max. drawdown ท่ีระดับเปอรเซ็นตไทดท่ี 90 (38.48%) หมายถึง จากตัวอยาง 90%          

ของการทดลองทั้งหมด drawdown จะมีคานอยกวา 38.48% ดังนั้น ส่ิงท่ีตารางน้ีจะบอกคุณก็คือระบบน้ี      

มันมีโอกาสเพียงแค 10% ท่ี drawdown จะมีคาสูงกวานั้น ถาหากเราสังเกตเพ่ิมเติมท่ีระดับ 99%       

ก็จะเห็นวามันมีโอกาสถึง 99% ท่ี drawdown ของระบบเราจะ นอยกวา 63.82% 

  

ดานลางจะแสดงถึงคา min/avg/max และ straw broom chart ของ equity ออกมา 
 

 

หมายเหตุ : ยํ้าอีกครั้งวา เสนสีเขียว และ สีแดง (min/max equity) ไมไดหมายถึง สัญญาณท่ีแยท่ี          

สุด หรือ ดีที่สุด พวกมันหมายถึงจุดท่ี bar-by-bar สูงท่ีสุด (max) และ ต่ําทีสสุด( min) ของ equities            

ทั้งหมดที่ถูกสรางดวยวิธีการจําลองแบบ Monte Carlo ดังนั้นพวกมันจึงเปนท้ัง จุดท่ีดีท่ีสุด ของ equity       

ทั้งหมด แตก็เปนจุดที่แยที่สุด เชนกัน และ เสนสีนํ้าเงิน (avg) แสดงถึงคาเฉล่ียของ equity ท้ังหมด และ          

เสนที่เทา เปนตัวแทนของเสน equity ในแตละการทดสอบ ซึ่งเราสามารถเห็นไดวา ถึงแมจะใชระบบการ      

เทรดเดียวกัน ก็สามารถที่จะสรางผลลัพธท่ีแตกตางกันออกมาได เมื่อเง่ือนไขของสภาพตลาดเปล่ียนแปลงไป   

และ การจําลองดวยวิธี Monte Carlo ก็พยายามท่ีจะ สรางผลลัพธท่ีแตกตางกันออกมา และ เตรียมคาทาง        

สถิติใหคุณนําไปพิจารณาขอดี ขอเสียของระบบแลว 
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หลังจาก straw broom chart คุณก็สามารถท่ีจะหา cumulative distribution function (CDF)         

chart ของ equity สุดทายได ไมวาจะเปน CAR, drawdowns และ lowest equity (และอีกเชนกัน           

เสนสีเขียว และ สีแดง แสดงไวใหเพ่ือการสังเกตในคูมือเลมนี้เทานั้น ในโปรแกรมจริงๆจะไมมี) 
 

 

 

Cumulative distribution แสดงถึงขอมูลเดิมท่ีอยูในตารางดานบนของหนา Monte Carlo แตแสดง      

ออกมาในรูปของกราฟ อีกครั้ง เมื่อเราสังเกตรูปแบบการกระจายตัวของ annual profit % (CAR) เรา        

สามารถที่จะประมาณไดวา ใน 10 % ของระบบท้ังหมดจะไม break even (ยังคงใหคา CAR ท่ีติดลบอยู )           

และ เราสามารถที่จะประมาณได คาท่ีประมาณ 35% CAR ของเราก็ยังคงจะต่ํากวา 5 % นอกจากน้ีน้ัน         

Profits มากกวา 10% จะเกิดข้ึนก็ตอเมื่อ เปนคาท่ีดีท่ีสุด 20 % ของการทดลองท้ังหมด 

  

ในสวนของกราฟอื่นๆใน หนา Monte Carlo ก็จะมีรูปแบบการตีความท่ีเหมือนกับตัวอยางดานบน 

  

กราฟแสดง คา equity ตอนเมื่อจบการทดลองนั้น จะแสดงออกมาในรูปของ cumulative      

distribution function ของมูลคา equity ตอนสุดทาย (ในจุดส้ินสุดของการ backtest) 

  

กราฟของ Annual return ก็จะแสดงถึง cumulative distribution function ของ compound         

annual ในหนอยของเปอรเซ็นตจากการ backtest SiamQuant 
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กราฟของ Max. Drawdown $ และ Max. Drawdown % แสดงcumulative distribution          

function ของ drawdowns (ระยะทางจากสุด peak ถึง valey ในหนอย เงิน/เปอรเซ็นต)         

ที่ระบบประสบเจอระหวางการ backtest 

  

กราฟของ Lowest Equity แสดงcumulative distribution function ของ lowest equity ท่ี          

ระบบประสบเจอระหวางการ backtest 
  

 

จะควบคุมมัน จากการใสสูตร/โคด (formula) ไดอยางไร? (How to control it from the 

formula level?) 
  

นอกเหนือจากการตั้งคาท่ีไดกลาวไวดานบนแลว คุณสามารถท่ีจะใชคําส่ัง SetOption() ฟงกชัน เพ่ือ     

ควบคุมการทํางานของ การสรางแบบจําลองแบบ Monte Carlo ไดเชนกัน นอกจากน้ีคุณสามารถท่ีจะ      

เรียกดูคาตางๆไดดวยการใข GetOption ฟงกชัน 
  

SetOption( "MCEnable", 0 ); // value == 0 หมายถึงไมเรียกใช Monte Carlo simulation            

SetOption( "MCEnable", 1 ); // value == 1 หมายถึง เรียกใช Monte Carlo เฉพาะในการทํา             

backtest (default) 

SetOption( "MCEnable", 2 ); // value == 2 หมายถึง ใช Monte Carlo ในทุกๆการทดสอบ             

(ในทุกๆ mode แมกระท้ังการ  optimization ซึ่งจะทําใหกระบวนการยาวนานมาก) 
  

โปรดทราบไววาไมแนะนําเปนอยางมากใหเปดการใชงาน Monte Carlo ในการ optimization ถาคุ      

ณไมไดตองการที่จะ ใชมันเพื่อหาคา target นั้นจริงๆ ในอีกนัยหนึ่ง การใชการกระจายตัวของ Monte Carlo        

บนกระบวนการ optimization กระบวนการ Monte Carlo จะเสียเวลาเอามากๆ และ ในขณะท่ี        

การทําจะใชเวลาในการ backtest หนึ่งคร้ังใชเวลาเพียงไมกี่รอยมิลลิวินาทีเทาน้ัน ซ่ึงมันแทบจะไมมีเสียเวลา    

อะไรเลย แตในกรณีการทํา optimizations หลายๆตัวแปร คุณสามารถท่ีจะทําใหเวลาในการทํางานของมัน     

เพิ่มขึ้นไดอยางงายดาย ดังนั้นหากคุณไมตองการใช การกระจายตัวของ Monte Carlo ในการสรางตัวบงช้ี      

จริงๆ และ เพื่อหาเปาหมายในการ optimization อยาเปดใชงาน Monte Carlo ในการ optimization         

จะดีกวา 
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SetOption("MCRuns", 1000 ); // กําหนดจํานวนคร้ังในการ รัน Monte Carlo (realizations) คา           

พารามิเตอรตางๆของ Monte Carlo สามารถท่ีจะใช SetOption และก็เรียกใชดวย  GetOption ได 

 

·  "MCChartEquityCurves" (true/false) 

·  "MCStrawBroomLines" (0..100) 

·  "MCPosSizePctEquity" (0..100) 

·  "MCPosSizeMethod" - 0 - don't change, 1 - fixed size, 2 - constant amount, 3 - 

percent of equity (ความหมายเหมือนตอนตั้งคา) 

·  "MCPosSizeShares" (ตัวเลข), 

·  "MCPosSizeValue" (ตัวเลข) 

·  "MCPosSizePctEquity" (ตัวเลข) 

  

จะเพิ่มตัวบงชี้ที่กําหนดขึ้นเองในการทํา Monte Carlo ใน backtest Report ไดอยางไร? 

(How to add custom metric based on MC test distribution(s) to the backtest 

report ?) 

 

นอกไปจาก Monte Carlo report ตามปกติแลว คุณสามารถท่ีจะสรางตัวบงช้ีตางดวยคุณเองโดยใช       

ฟงกชั่น GetMonteCarloSim() ถาคุณสรางตัวบงช้ีใหมข้ึนมาเอง โปรด ศึกษาเพ่ิมเติมในสวนของ "How to       

add custom metrics to backtester report" เปนอันดับแรก 

  

การจําลองดวย Monte Carlo นั้นมีฟงกชันเดียวคือ GetValue( "field", percentile ) ท่ีใชในการ         

เขาถึงคา CDF ที่จําแนกไดดังตอไปนี้  

  

·  "FinalEquity" 

·  "CAR" 

·  "LowestEquity" 

·  "MaxDrawdown" 

·  "MaxPercDrawdown" 
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ทีนี้เราจะพาไปดูตัวอยางของโคดเบื้องตน ท่ีเพ่ิมรายงานในสวนของระดับ เปอรเซ็นตไทดท่ี 30 ลงไป 

โดยประกอบดวย  FinalEquity และ CAR 

 

SetOption( "MCEnable", True );  

SetOption( "MCRuns", 1000 );  

SetCustomBacktestProc( "" ); 

  

if( Status( "action" ) == actionPortfolio ) 

{ 

bo = GetBacktesterObject(); 

  

bo.Backtest(); // รันคา default ของกระบวนการ backtest  

  

// เขาสูกระบวนการแสดงผลลัพธของ Monte Carlo  

// note 1: มันอาจจะ NULL ถา Monte Carlo ไมไดถูกเรียกใช 

// note 2: ผลลัพธ Monte Carlo จะแสดงผลหลังจากการ Backtest() หรือ PostProcess 

// เมื่อ การจําลองแบบ Monte Carlo เสร็จกระบวนการในข้ันตอนสุดทาย 

 mc = bo.GetMonteCarloSim(); 

  

if( mc ) 

{ 

// ใชระดับเปอรเซ็นตไทดท่ี 30 ของ final equity และ การกระจายตัวของ CAR  

 bo.AddCustomMetric( "FinalEq30", mc.GetValue( "FinalEquity", 30 ) ); 

bo.AddCustomMetric( "CAR30", mc.GetValue( "CAR", 30 ) ); 

  

// คุณสามารถท่ีจะรวมคาทางสถิติของ Monte Carlo ดวยคาทางสถิติปกติได 

 st = bo.GetPerformanceStats(0); 
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bo.AddCustomMetric( "CAR30/MDD", mc.GetValue( "CAR", 30 ) / 

st.GetValue( "MaxSystemDrawdownPercent" ) ); 

} 

} 
  

เมื่อเราเพิ่มตัวบงชี้ใหมเขาไปในระบบแลว เราก็สามารถท่ีจะใชตัวบงช้ีใหมน้ี เพ่ือเปนเปาหมายในการ   

Optimization ไดเชนกัน (อยาลืมท่ีจะเปล่ียน MCEnable เปนเลข 2) และ ใชในกระบวนการ Walk         

Forward เพื่อเปน objective function ไดอีกดวย เพ่ือท่ีจะเลือกตัวบงช้ีท่ีจะทําการ optimization คุณจึงใส        

ชื่อตามประเภทที่คุณตองการลงใน AddCustomMetric ในชอง "Optimization Target" บนกลองการต้ังคา      

ในหนา Walk Forward วิธีนี้จะทําใหคุณสามารถรัน optimization / walk forward โดยตรงไดจากการ         

จําลองการกระจายตัวดวยวิธี Monte Carlo ดังนั้น ยกตัวอยางเชน แทนท่ีคุณจะใช CAR/MDD       

คุณสามารถที่จะใช CAR30/MDD (ระดับเปอรเซ็นตไทด ท่ี 30 ของ Monte Carlo CAR เปรียบเทียบกับ          

max. system drawdown) 
 

จะใชการสุมแบบ Monte Carlo แทนการใชการทดสอบแบบ bootstrap ไดอยางไร? (How 

about Monte Carlo randomization instead of bootstrap test?) 
  

การสุมดวยวิธี Monte Carlo นั้น แตกตางจากการทดสอบแบบ bootstrap เพราะวา มันไมไดใช        

trade list ตัวจริง (realized) จากการ backtest โดยตรง แตพยายามท่ีจะใช "ผลลัพธแตละอันของขอมูล         

realized หรือ ขอมูลเชิงสมมุติฐาน" ยกตัวอยางเชน เมื่อระบบเทรดเกิดสัญญาณในการซ้ือจํานวนมากกวาท่ี     

เราจะสามารถซื้อได เราจะจะเลือก วาการเทรดไหนควรจะเทรด หรือการเทรดไหนท่ีเราจะขามไป โดยปกติ     

แลว การเลือกนี้จะอยูในสวนของตัวแปร PositionScore ในโปรแกรม Amibroker จะเปนตัวบอกตัวไหนท่ี      

ควรจะเทรดมากกวากัน ในกระบวนการทดสอบแบบสุมนั้น แทนท่ีเราจะใชการพิจารณาจาก PositionScore    

คุณจะไดการสุมมาแทน ถาหากเกิดจํานวนสัญญาณมากกวาท่ีจะเขาเทรดได กระบวนการในข้ันตอนน้ีจะสุม   

เพื่อเลือกการเทรดที่จะเขาเทรด ตอนนี้การใช Optimize() ฟงกชัน และ การสุม PositionScore เราสามารถ        

ที่จะรัน เปนพันๆครั้งไดเพื่อทําการสุมในข้ันตอนการทดสอบดวย Monte Carlo randomization :  
  

step = Optimize( "step", 1, 1, 1000, 1 ); // 1000 backtests 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 

 

http://www.siamquant.com/thai-amibroker-manual


 

 

 

- 208 - 

//ดวยการสุมเลือกการเทรดจากขอมูลท้ังหมดท่ีเรามีอยู (โปรดทําใหแนใจดวยวาคุณรันบท watch 

lists ที่มีจํานวนรายชื่อมากๆ) 

PositionScore = mtRandom(); 

  

การทดสอบดวยการสุม มีขอเสียเปรียบใหญๆอยูขอหนึ่ง: คือมันไมสามารถใชไดในหลายๆกรณี เม่ือ    

ระบบไมสรางจํานวนสัญญาณท่ีมากเพียงพอในแตละ bar ซึ่งมันก็จะไมมากเพียงพอท่ีจะถูกเลือก ท่ีสําคัญย่ิง    

ไปกวานั้นคือ วิธีการสุมแบบ Monte Carlo จะไปขัดกับสมมุติฐานท่ีวาโอกาสในการเทนดแตละคร้ังน้ันมี     

โอกาสเทากัน เพราะในหลายๆกรณีมันไมเปนอยางนั้น บอยคร้ังท่ีระบบการเทรดท่ีเฉพาะเจาะจงของเรา   

กําหนดใหเลือกการเทรดในหลายๆโอกาสจาก การเรียงลําดับ หรือ การใหคะแนน เม่ือระบบใช score      

(เรียงลําดับ) เปนเหมือนแกนหลักของระบบ (เชนระบบท่ีใชการ rotation) ถาหากคุณแทนท่ีการใช score      

ดวยการสุม มันคือการที่คุณกําลังทดสอบ white noise(ถาจะใหแปล คําจํากัดความของมันคือ เสียงท่ีเราใช      

กลบเกลื่อนเสียงอื่น อาจจะเปนเสียงพัดลม หรือเสียงทีวี ซึ่งจะเปนเสียงท่ีดังสม่ําเสมอ ) เทาน้ันไมใชการทด      

สอบระบบ SiaสยามควอนทmQuant 
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Pyramiding (scaling in/out) และ 

การปรับใชอัตรตราแลกเปลี่ยนคาเงินในการ backtest 

พอรทการลงทุน  

(Pyramiding (scaling in/out) and mutliple currencies 

in the portfolio backtester) 

 

สําคัญ : โปรดแนใจวาคุณไดอานหัวขอ Backtesting your trading ideas article และ Portfolio          

Backtesting จบแลว 

 

เริ่มตนจาก เวอรชั่น 4.70 ผูทําการ backtest นั้นสามารถท่ีจะ position scaling และ ใชสกุลเงิน           

หลายสกุลได 

  

หมายเหตุ ฟงกชันสูงนี้จะทํางานเพ่ือสนับสนุน ผูทําการ backtest เปนพอรทการลงทุนเทาน้ัน     

ฟงกชัน Old single-security backtester และ single-security equity() function น้ันไมสนับสนุนการใช         

ฟงกชั่นนี ้

  

Pyramiding / Scaling 
  

การใช sigScaleIn / sigScaleOut ถูกนําเขามาเพ่ือตอบสนองความตองการของผูใชเม่ือตองการท่ีจะ     

scale-in/out (จากผูแปล : การทํา Pyramiding คือการซื้อ/ขาย หลายๆคร้ังไมไดจบแคเพียงคร้ังเดียว หรือท่ี        

เราชอบเรียกวาการเขาซื้อขายหลายๆไมนั้นละครับ) 

  

สิ่งที่คุณตองทําทั้งหมดในการทํา Pyramiding คือ 
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- ใช sigScaleIn เพื่อสรางตัวแปรในการ BUY/SHORT ถาคุณตองการท่ีจะ scale-in (เพ่ิมขนาดของ        

size) LONG/SHORT  

- ใช sigScaleOut เพ่ือสรางตัวแปรในการ BUY/SHORT ถาคุณตองการท่ีจะ scale-out (ลดขนาด        

ของ size) LONG/SHORT 

  

การ Scaling size ถูกกําหนดดวยตัวแปร PositionSize ในกรณีท่ีวาเราไมไดทําการ ซ้ือ/ขาย ดวยเงิน        

ที่เทาเดิม แตใชเงินที่เพิ่มขึ้น หรือ ลดลง 

  

สําคัญมาก: โปรดทราบวาในการ backtest นั้นจะถือวาการ scale-in/out ในแตละคร้ังน้ันนับเปน      

การเทรดหนึ่งครั้ง (จะแสดงใหเห็นแตละคร้ังของการเทรดใน trade list) ขอแตกตางเพียงหน่ึงเดียว     

เมื่อเปรียบ เทียบกับการเทรดธรรมดานั่นคือ มันจะคํานวณคาเฉล่ียของ ราคาเขาซ้ือ (และ อัตราเฉล่ียของคู      

เงิน) คิดมาจาก ราคาที่เขาซื้อบางสวน และ คาเฉล่ียของ ราคาขาย (และ อัตราเฉล่ียของคูเงิน) คิดมาจาก         

ราคาที่ขายออกบางสวน นอกจากนี้มันจะ แสดงถึงราคาซื้อ/ขาย โดยเฉล่ียอีกดวย สวนคา commission      

แนนอนวาจะคํานวณอยางถูกตองตามจํานวนท่ีแบงในการ เขาซื้อ/ขาย จริง 

  

หากคุณตองการที่จะทราบรายละเอียดเกี่ยวกับการ scaling คุณตองรัน backtest ดวยโหมด     

"DETAIL LOG" มันเปนทางเดียวเทานั้นท่ีคุณจะสามารถเห็นวา การทํางานของการ scaling-in /out มัน       

ทํางานอยางไร และ ราคาเฉล่ียนั้นมันคํานวณออกมาไดอยางไร 

  

โปรดทราบ วาการ scaling-in/-out และ multiple-currency น้ันรับรองเฉพาะ portfolio       

backtest การ backtest แบบเกา เชน การใช Equity() ฟงกชันจะไมสามารถใชกับการ scaling-in/out หรือ          

การ multiple currencies ได (ระบบจะไมสนใจการใชคําส่ัง scaling นั้นๆ) 
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ตัวอยาง อยางงาย ( Easy examples) 

ตัวอยางที่ 1: dollar-cost averaging (แตละเดือนซื้อหุนดวยจํานวนเงินที่เทาๆกัน) 

(Example 1: dollar-cost averaging (each month you buy stocks for fixed 

dollar amount)) 

  

 FixedDollarAmount = 500; 

MonthBegin = Month() != Ref( Month(), -1 ); 

 FirstPurchase = Cum( MonthBegin ) == 1; 

Buy = IIf( FirstPurchase, 1, // True (or 1) เปนตัวแทนของสัญญาณการซ้ือ  IIf( MonthBegin, 

sigScaleIn, // ในแตละเดือเพ่ิมขนาดของ position 

0 ) ); // ไมมีสัญญาณ 

  

Sell = 0; // เราจะไมทําการขาย 

 

 PositionSize = FixedDollarAmount;  

ตัวอยางที่ 2: dollar-cost averaging (เปนโคดอยางงาย เนื่องจาก amibroker 

ถือวาหากมีสัญญาณครั้งแรกใหซื้ออยูแลว) (Example 2: dollar-cost averaging 

(simplified formula because AB treats first sigScaleIn as buy anyway)) 
  

FixedDollarAmount = 500; 

MonthBegin = Month() != Ref( Month(), -1 );  

FirstPurchase = Cum( MonthBegin ) == 1; 

Buy = IIf( MonthBegin, sigScaleIn, 0 ); //ในแตละเดือเพ่ิมขนาดของ position 

  

Sell = 0; //เราจะไมทําการขาย 
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PositionSize = FixedDollarAmount; 
  

ตัวอยางที่ 3: เพิ่มขนาดของ position เมื่อเทรดแลวไดกําไร โดยปราศจากการทํา 

Pyramiding เพิ่มขนาดเมื่อกําไรมากกวา 5% และลดขนาดเมื่อ ขาดทุนมากกวา -5% 

(Example 3: increasing position when profit generated by trade without 

pyramiding becomes greater than 5% and decreasing position when loss is 

greater than -5%)​ สยามควอนท 
  

// %การลงทุนเปลี่ยนแปลงในการทํา Pyramiding  

PyramidThreshold = 5; 

  

// เงื่อนไขการเทรดเบ้ืองตน (ไมทํา Pyramiding) 

Buy = Cross( MACD(), Signal() ); 

Sell = Cross( Signal(), MACD() ); 

  

e = Equity(1); // สรางเงินลงทุนโดยปราศจากผลกระทบจาก Pyramiding 

 PcntProfit = 100 * ( e - ValueWhen( Buy, e ) )/ValueWhen( Buy, e );  

InTrade = Flip( Buy, Sell); 

// ExRem ถูกใชเพื่อใหแนใจในการเกิด scaling-in/out  

// เกิดการเขาเพียงแคคร้ังเดียว 

DoScaleIn = ExRem( InTrade AND PcntProfit > PyramidThreshold, Sell );  

DoScaleOut = ExRem( InTrade AND PcntProfit < -PyramidThreshold, Sell ); 

  

// ปรับเปลี่ยนกฎเพื่อจัดการพีระมิด 

Buy = Buy + sigScaleIn * DoScaleIn + sigScaleOut * DoScaleOut; 
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PositionSize = IIf( DoScaleOut, 500, 1000 ); // ทําการเขาและ scale-in ขนาด $1000, 

scale-out ขนาด: $500 
 

 

ตัวอยางที่ 4: การออกบางสวน (scaling out) เมื่อถึงเปากําไรที่เรากําหนด 

(Example 4: partial exit (scaling out) on profit target stops) 
  

ใน code จะเปนการยกตัวอยาง ออก 50% ในเปากําไรแรก และ 50% ในเปากําไรถัดไป 

และออกทั้งหมดที่เหลือเมื่อหลุด trailing stop 

 

Buy = Cross( MA( C, 10 ), MA( C, 50 ) ); 

Sell = 0; 

  

// ระบบจะออกเมื่อ 

// 50% ของ position ถาหากถึงเปากําไรแรก 

// 50% ของ position ถาหากถึงเปากําไรท่ีสอง 

// 100% ของ position ถาหากหลุด TRAILING STOP 

  

FirstProfitTarget = 10; // กําไร SecondProfitTarget = 20; // เปน % 

TrailingStop = 10; // % เชนกัน 

  

priceatbuy=0; highsincebuy = 0; 

  

exit = 0; 

  

for( i = 0; i < BarCount; i++ ) 

{ 

if( priceatbuy == 0 AND Buy[ i ] ) 
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{ 

priceatbuy = BuyPrice[ i ]; 

} 

  

if( priceatbuy > 0 ) 

{ 

highsincebuy = Max( High[ i ], highsincebuy ); 

  

if( exit == 0 AND 

High[ i ] >= ( 1 + FirstProfitTarget * 0.01 ) * priceatbuy ) 

{ 

// ชนเปากําไรแรก - scale-out exit = 1; 

Buy[ i ] = sigScaleOut; 

} 

  

if( exit == 1 AND 

High[ i ] >= ( 1 + SecondProfitTarget * 0.01 ) * priceatbuy ) 

{ 

// ชนเปากําไรท่ีสอง - ใหออก 

exit = 2; 

SellPrice[ i ] = Max( Open[ i ], ( 1 + SecondProfitTarget * 0.01 ) * 

priceatbuy ); 

} 

  

if( Low[ i ] <= ( 1 - TrailingStop * 0.01 ) * highsincebuy ) 

{ 

// หลุด trailing stop - ใหออก 

exit = 3; 
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SellPrice[ i ] = Min( Open[ i ], ( 1 - TrailingStop * 0.01 ) * highsincebuy ); 

} 

 

  

  

if( exit >= 2 ) 

{ 

Buy[ i ] = 0; 

Sell[ i ] = exit + 1; // มารคการออกท่ีเหมาะสม  

exit = 0; 

priceatbuy = 0; //รีเซ็ทราคาใหม 

highsincebuy = 0; 

} 

} 

} 

  

SetPositionSize( 50, spsPercentOfEquity ); 

SetPositionSize( 50, spsPercentOfPosition * ( Buy == sigScaleOut ) ); // scale out 50% 

ของ position 

  

 Mulitple Currency Support 
  

 ในการ backt portfolio นั้นผูใชสามารถท่ีจะ backtest ระบบท่ีมี สินคาท่ีมี สกุลเงินท่ี        

แตกตางกันได นั่นรวมถึงความสามารถในการใชอัตราการแลกเปล่ียนสกุลเงินในอดีตมาคํานวณไดอีกดวย ซ่ึง   

อัตราการเเลกเปลี่ยน จะถูกกําหนดไวในหนา "Currencies" ท่ีอยูในสวน preferences อัตราแลกเปล่ียน      

ที่ใชใน สินคาใดๆก็ตามสามารถท่ีจะกําหนดไดโดยไปท่ี SiamQuant 

Symbol -> Information page 
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ในหนาของ "Currencies" ท่ีอยูใน Preferences - สามารถท่ีจะกําหนด คาสกุลเงินพ้ืนฐาน และ        

อัตราแลกเปลี่ยน (คงที่ หรือ ไมคงท่ี) สําหรับสกุลเงินท่ีแตกตางกัน ส่ิงนี้จะชวยใหผลลัพธของการ backtest       

มีความถูกตอง เมื่อเราตองการท่ีจะทดสอบ สินคาท่ีมี สกุลเงินท่ีแตกตางกัน  

 

 

แลว Amibroker จะรูไดอยางไรวาเมื่อ ไหรเราตองการ ใหมัน คงท่ี หรือ ไมคงท่ี? เง่ือนไขดังตอไปน้ีท่ี         

โปรแกรมตองการจะเปนตัวกําหนด ในการใชคาของสกุลเงินตางๆ 

 

a) Symbol->Information, "Currency" ใหใสคาของสกุลเงินท่ีแตกตางจากฐานขอมูลเดิมลงไป 

b) คาสกุลเงินที่เหมาะสม (จะถูกกําหนดใน Symbol) จะถูกจับคู โดย Preferences -> ในหนาของ         

Currencies 

c) การใชอัตราแลกเปล่ียนท่ีไมคงท่ี "FX SYMBOL" จะถูกกําหนดใน preferences EXISTS       

ในฐานขอมูลของคุณ และใหคาท่ีเหมาะสมในแตละวันภายใตชวงเวลาของการวิเคราะห น้ันๆ  

  

อะไรคือ  "INVERSE" check box ใน preferences? เรามาดูตัวอยางดวย EURUSD กันดีกวา  

 

เมื่อ "USD" เปน สกุลเงินหลักของคุณและอัตราแลกเปล่ียนของ EUR เปนแบบ "เสนตรง" คูเงิน        

EURUSD (เชน 1.3) แตเมื่อ "EUR" เปนสกุลเงินหลักของคุณ อัตราแลกเปล่ียนของ USD จะกลายเปน         

INVERSE ของ EURUSD (เชน 1/1.3) ในตรงกันขามมันจะเปนจริงกับ คูเงินเชน USDJPY (ท่ีเปน "inverse"          

เรียบรอยแลว) 
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การเขียนโคดเพ่ือตั้งการแจงเตือน 

(Using formula-based alerts) 

 

 บทนํา(Introduction) 
  

บนการใชงาน AmiBroker นั้น คุณสามารท่ีจะกําหนดใหระบบตั้งแจงเตือนได เม่ือสัญญาณท่ีเรา     

กําหนดไวถูกจับไดเมื่อไหร มันสามารถท่ีจะแสดงการแจงเตือนออกมาในรูปแบบท่ีเปน ขอความ , เสียงเตือน ,      

e-mail แจงเตือน และ การสงออกขอมูลภายนอกตางๆท่ีรองรับการทํางานได 

 

ทั้งหมดนี้จะทํางานบนฟงกชัน AlertIF  

  

โดย default แลว การแจงเตือนท้ังหมดจะสรางขอความแจงเตือนไวบน หนาตาง Output เพ่ือแสดง       

หนาตางดังกลาว คุณจําเปนท่ีจะตองไปท่ี Window -> Alert Output 

นอกจากนี้ยังมีหนาตาง Easy Alerts ซึ่งจะทําใหคุณกําหนดการตั้งการแจงเตือนอยางาย ท่ีคุณไมตอง     

ทําการเขียนโคดใดๆเลย S​(แตไมแนะนําสําหรับ S​ผูท่ีตองการจะใชระบบการแจงเตือนแบบเต็มรูปแบบดวย 

AlertIf ฟงกชัน) สยามควอนท 
  

การตั้งคาตางๆ (Settings) 
  

Alert - สัมพันธการต้ังคาในแถบ "Alerts" ใน Tools-> หนาตาง Preferences 

  

เราสามารถที่จะกําหนด e-mail account , เสียงตอนแจงเตือน และ กําหนดวาสวนใดของ       

AmiBroker สามารถที่จะสรางการแจงเตือนไดโดย AlertIF ฟงกชัน 

  

หนาของการตั้งคา E-mail ตอนนี้สามารถท่ีจะเลือกวิธีการตางท่ีไดรับความนิยมได อยางเชน : AUTH      

LOGIN (นิยมมากที่สุด), POP3-before-SMPT (ไดรับความนิยม), CRAM-MD5, LOGIN PLAIN 
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"Enable alerts from" การติ๊กเคร่ืองหมายถูกในสวนนี้ จะทําใหคุณ เลือกการต้ังเตือนให เปด/ปด       

ตามอัตโนมัติ, หรือตาม ความคิดเห็น/การตีความ และ ตัวช้ีวัดท่ีเรากําหนดเอง 

  

หนาตางที่แสดงผลการแจงเตือนนั้น รูปแบบตอนนี้จะแสดงเปน colum ท่ีแสดงการแจงเตือน ถามัน     

เปนแบบอัตโนมัติ ,ความคิดเห็น/การตีความ หรือ ตัวช้ีวัดท่ีเรากําหนดเอง มันจะงายตอการคนหาวาสวนใด     

ของ Amibroker ที่ทําการแจงเตือนนั้นๆ 

  

สําหรับ AmiBroker 5.30 ข้ึนไป - สนับสนุนกับ SSL (secure connection) ซ่ึงเอาไวใชกับ GMail           

ยกตัวอยางเชน เพื่อที่จะเปดการใชงานการสนับสนุนดวย SSL support คุณจําเปนตองทําตามข้ันตอน     

ดังตอไปนี้ : 

 

1. Download และ run SSL add-on 0kd  http://www.amibroker.com/bin/SSLAddOn.exe 

2. กําหนดคา(Tools->Preferences->Alerts) ดวยการเปดใช SSL ท่ีแสดงดานลาง  
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ฟงกชัน AlertIF (AlertIF function) 
  

AlertIF ฟงกชัน จะมีลักษณะคลายคลึงกับ WriteIF แตแทนท่ีมันจะเขียนเฉพาะตัวหนังสือในหนาตาง     

แสดงการแจงเตือนแลวนั้น มันยังสามารถท่ีจะ : 

  

·  กําหนดขอความที่เรากําหนดข้ึนเองใหไปแสดงผลท่ี หนาตางการแสดงผลลัพธการแจงเตือนได 

·  กําหนดเสียง (เปนเพียงแคเสียงปปจากคอมพิวเตอร หรือจากไฟลสกุล .WAV) 

·  สง e-mail 

·  เปดใชการเชื่อมตอกับแอปพลิช่ันอ่ืนๆ SiamQuant 

  

มี syntax ตามดังตอไปนี้ : 
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AlertIf( BOOLEAN_EXPRESSION, command, text, type = 0, flags = 1+2+4+8, lookback = 1 ); 

  

1. BOOLEAN_EXPRESSION คือการแสดงออกมาวาถามันวัดผลแลวเปน True (ไมไดมีคาเปนศูนย)     

จะทําใหเกิดการแจงเตือน และ ถาวัดผลออกมาแลวคาเปน False (มีคาเปนศูนย) จะไมมีการแจงเตือนใดๆ      

เกิดขึ้น หมายเหตุ จะมีเพียงแคการมองยอนกลับไปมากท่ีสุดเพียงแคไมกี่ bar ลาสุดเทาน้ัน ท่ีจะถูกนํามา      

พิจารณา 

  

2. command (string) เปนตัวกําหนดการกระทําเมื่อเกิดการแจงเตือนเกิดข้ึน ถาหากปลอยคาเวนไว     

การแจงเตือนก็จะแสดงไปที่หนาตางการแจงเตือนตามปกติ (Window->Alert Output) อยางอ่ืนท่ีชวยสนับ    

สนุนคาในการใช command มีดังนี้: 

  

SOUND the-path-to-the-WAV-file 

EMAIL 

EXEC the-path-to-the-file-or-URL <optional args> 

 

 คําสั่ง SOUND จะเลนเสียงจากไฟลสกุล WAV 1 ไฟล 

  

คําสั่ง EMAIL จะสงคําสั่งไปท่ี e-mail ท่ีทําการระบุไวตอนท่ีเราตั้งคากอนหนาน้ี (Tools -> Preferences ->         

E-mail) รูปแบบของการตั้ง e-mail มีดังตอไปนี้: 

 

 Subject: Alert type_name (type) Ticker on Date/Time Body: text 

  

คําสั่ง EXEC จะดําเนินการใชแอปพลิเคช่ันภายนอก , ไฟล, หรือ URL ท่ีเฉพาะเจาะจงหลังจากใช EXEC 

<optional args> จะถูกแนบมาหลังจาก ช่ือไฟล และ ตัวหนังสือถูกแนบมาดวยในตอนสุดทาย 

 

3.  Text จะกําหนดวาตัวหนังสือท่ีเปนผลลัพธนั้นจะถูกแสดงบนหนาตางของการแจงเตือน หรือ 

จะถูกสงไปยัง e-mail หรือ แอปพลิเคช่ันภายนอกท่ีถูกระบุไวโดยคําส่ัง EXEC  
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4. Type จะเปนตัวกําหนดประเภทของการแจงเตือน กอนการกําหนดไวคา types จะเปน 0 -        

default, 1 - buy, 2 - sell, 3 - short, 4- cover โดยคุณสามารถท่ีจะระบุคาท่ีสูงมากกวาน้ี (เชน 5 6 7 8)                  

และ ระบบจะสงผลลัพธออกมาเปน other แทน 

  

5. Flags จะเปนตัวควบคุมพฤติกรรมของ AlertIF ฟงกชันได มันจะประกอบไปดวยการทํางานรวม      

ตัวกันของคําสั่งตางๆ โดยมีคาดังนี้: 

( 1 - หมายถึงสงขอความไปยังหนาตางแสดงการแจงเตือน, 2 - สรางเสียงปป (บนคอมพิวเตอร), 4 -          

ไมแสดงการแจงเตือนใดๆซํ้าอีก หากการแจงเตือนมี type ท่ีเหมือนเดิม, 8 - ไมแสดงการแจงเตืนใดๆซ้ํา       

หากมี date/time ที่เหมือนเดิม) โดย default ทางเลือกตางๆจะถูกเปดไวท้ังหมด  

  

6. lookback เปนพารามิเตอรท่ีคอยคุมวา จะดู bar ยอนหลังกี่ bar เพ่ือนํามาพิจารณาในการแจง        

เตือน ยกตัวอยางเชน : 

 

Buy = Cross( MACD(), Signal() );  

Sell = Cross( Signal(), MACD() ); 

Short = Sell; 

Cover = Buy; 

  

AlertIF( Buy, "EMAIL", "A sample alert on "+FullName(), 1 ); 

  

AlertIF( Sell, "SOUND C:\\Windows\\Media\\Ding.wav", "Audio alert", 2 ); 

 AlertIF( Short, "EXEC Calc.exe", "Launching external application", 3 );  

AlertIF( Cover, "", "Simple text alert", 4 ); 

 

หมายเหตุ : คําสั่ง EXEC จะใช ShellExecute ฟงกชัน และใชไดท้ังไฟล  EXE และ URLs เชนกัน 
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หมายเหตุ (Notes) สยามควอนท 

1. โปรดทราบไววา โดย default แลว AlertIf ฟงกชัน จะไมสรางสัญญาณท่ีซ้ํากัน เม่ือการสแกน          

รันหลายๆครั้ง ในระหวางการทดลอง คุณอาจจะชอบท่ีจะใหเกิดการทําซํ้าของสัญญาณ ในการเกิดสัญญาณท่ี    

ตามๆกันมา ( เหมือนคอยเนนยํ้า เตือนเรา ) เพ่ือทําแบบนั้นแลวคุณตอง เปล่ียน คา default ของ flags เปน            

1 + 2 : 

  

AlertIF( condition, "", "Text", 1, 1+2 ); 

  

2. ถาคุณตองการที่จะสรางการแจงเตือนเฉพาะ bar ท่ีจบ bar แลว คุณจําเปนท่ีจะเพ่ิม โคดน่ีลงไป : 

  

barcomplete = BarIndex() < LastValue(BarIndex()); 

 

  

AlertIF( barcomplete AND condition, "", "Text", 1 ); 
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การเปดใชหนาตางการตีความ 

(Using interpretation window) 

 
  

โปรดทราบ: คุณควรท่ีจะอาน หัวขอ How to write your own chart commentary          

มากอนบทความนี ้

  

หนาตางการตีความ (Interpretation window) (Window->Interpretation) จะแสดง     

chart-sensitive และ เพื่อที่จะเพ่ิม การการตีความนี้ คุณแคเพียงใช Formula Editor และเพ่ิมโคดลงไป        

หลังจาก โคดสําหรับตัวบงชี้( indicator) โปรดทราบไววา เพ่ือใหไดศักยภาพท่ีดีท่ีสุด คุณควรท่ีจะใชคําส่ัง      

เงื่อนไขที่ทําใหมั่นใจวา การตีความนี้นั้น จะแสดงเฉพาะใน "commentary" โหมด เทาน้ัน SiamQuant 
  

if( Status("action") == actionCommentary ) 

{ 

// printf statements here.... 

} 

  

ตัวอยาง: 

  

Plot( Close, "Price", -1, 64 ); 

Plot( SAR( Prefs( 50 ), Prefs( 51 ) ), "SAR",-17, 8+16 ); 

  

if( Status("action") == actionCommentary ) 

{ 

printf("The Parabolic SAR provides excellent exit points. \n"); 

 printf("You should Close long positions when the price falls below\n"); 
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 printf("the SAR AND Close Short positions when the price rises above the 

SAR.\n"); 

printf( WriteIf( Graph1 > Close, "SAR is above close", "SAR is below close" ) ); 

} 
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 การสนับสนุนการใช Multiple Time Frame 

ดวย AFL 

(Multiple Time Frame support in AFL) 
  

ปลอยออกมาตอนเวอรชัน 4.41 นําไปพาไปสูความสามารถในการใช multiple time frames (ชวง       

เวลาตางๆในหนวย bar ) ในสูตรเดียว ฟงกชัน time frame สามารถท่ีแบงการทํางานไดออกเปน 3         

กลุมดวยกัน : SiamQuant 

  

1.  เปลี่ยนกรอบเวลาของตัว O, H, L, C, V, OI, Avg arrays: TimeFrameSet, 

TimeFrameRestore 

2.  การบีบ/ขยาย  arrays ใดๆ ไปยังชวงเวลาท่ีเฉพาะเจาะจง: TimeFrameCompress, 

TimeFrameExpand 

3.  เขาถึง price/volume arrays ไดทันท่ีใน time frame ท่ีแตกตางกัน: TimeFrameGetPrice 

  

กลุมแรก: ​ถูกใชเมื่อคุณตองการดําเนินการคํานวณบางอยางบน time frame ท่ีแตกตางกัน (ไมไดใช Time       

Frame เดียว) ยกตัวอยางเชน หากคุณตองการท่ีจะคํานวณ 13-bar moving average บนขอมูลใน        

TimeFrame 5 นาที และ 9 bar exponential avarage บนขอมูลใน TimeFrame 1 ช่ัวโมง ในขณะท่ี             

คุณกําลังแสดงผลกราฟเปนขอมูลมูล 1 นาทีอยู คุณควรจะเขียนโคดดังนี้: 
  

TimeFrameSet( in5Minute ); // เพ่ือเปล่ียนเปน  Time Frame 5 นาที 

  

/* ตอนนี้ MA จะทํางานอยูบนขอมูล 5 นารที , ma5_13 จะถูกกําหนดใหคํานวณจากขอมูล 13 bar 

และเปน MA ของขอมูล 5 นาที */ 

  

ma5_13 = MA( C, 13 ); 
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TimeFrameRestore(); // เพ่ือคืนคาใหกลับไปใช Time Frame ด้ังเดิม 

 TimeFrameSet( inHourly ); // เพ่ือเปล่ียนเปน  Time Frame 1 ช่ัวโมง 

mah_9 = EMA( C, 9 ); // 9 bar moving average จากขอมูล 1 ช่ัวโมง 

TimeFrameRestore(); // เพ่ือคืนคาใหกลับไปใช Time Frame ด้ังเดิม  

Plot( Close, "Price", colorWhite, styleCandle ); 

  

//สรางเสนคาเฉลี่ยใน Time Frame ท่ีกําหนด 

  

Plot( TimeFrameExpand( ma5_13, in5Minute), "13 bar moving average from 5 min 

bars", colorRed ); 

Plot( TimeFrameExpand( mah_9, inHourly), "9 bar moving average from hourly bars", 

colorRed ); 
  

TimeFrameSet​( ใสชวงระยะเวลาท่ีเราตองการลงไป) - เปนการแทนท่ี price/volume arrays      

(open, high, low, close, volume, openint, avg) ดวยการระบบชวงเวลท่ีเราตองการจะเปล่ียน        

และเพื่อที่จะเปลี่ยนไปยัง Time Frame ดังเดิมของเรา เราตองใช TimeFrameRestore() ฟงกชัน ถาหลัง        

จากนั้นคุณตองการที่จะเปลี่ยน Time Frame อีก คุณก็แคเพียงเรียกใช TimeFrameSet อีกคร้ังหน่ึง       

แตกอนที่คุณจะเรียกใชใหมคุณจําเปนตอง คืนคาไปยัง Time Frame ดังเดิมเสียกอน โดยใช      

TimeFrameRestore() หมายเหตุ : ชวงระยะเวลานั้นจะถูกกําหนดดวย Time Frame ในหนวยวินาที  

ยกตัวอยางเชน: 60 ก็จะหมายถึง 1 นาที คุณควรท่ีจะใชคาคงท่ีเพ่ือความสะดวก      

สําหรับชวงเวลาทั่วๆไป โดยใช คําส่ังเหลานี้: in1Minute, in5Minute, in15Minute, inHourly, inDaily,        

inWeekly, inMonthly 

  

ตั้งแตเวอรชั่น 4.70 คุณสามารท่ีจะระบุชวงเวลาใหเปน N-tick ได ซ่ึงเราสามารถทําไดโดยเพียงใส      

เครื่องหมายลบไปดานหนาระยะเวลาท่ีเรากําหนด เชน -5 ก็จะหมายถึง 5-tick bar และ -133 ก็จะหมายถึง         

133-tick bar นอกจากนี้ โปรดทราบไววาการใช N-tick นั้นจะใชไดก็ตอเมื่อ database ของคุณ ใช Tick          

เปนฐานขอมูลหลัก สามารตั้งคาไดใน File -> Database Settings  
 

TimeFrameSet( -133 ); // เปล่ียนไปใช 133-tick  
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TimeFrameRestore() - เพ่ือคืนคาของ arrays ราคา ท่ีถูกเปล่ียนไปกอนหนาน้ีดวย      

TimeFrameSet() หมายเหตุ นี่เปนคาเฉพาะ OHLC, V, OI และ Avg เทาน้ัน ตัวแปรอยางอ่ืนท่ีถูกสรางข้ึน          

เมื่ออยูใน time frame ที่แตกตางกันก็ยังคงโดนบีบอัดอยู เพ่ือยกเลิกการบีบอัดน้ัน คุณจําเปนท่ีจะตองใช      

TimeFrameExpand (จากผูแปล : คําวาบีบอัดและขยายในท่ีนี้ หมายถึง เวลาท่ีคุณมี Time Frame ใหญ         

หากคุณตองการที่จะเห็นรายละเอียดเพ่ิมเติมใน Time Frame ท่ีเล็กลงคุณก็จําเปนตอง “ขยาย” Time      

Frame ที่ใหญอยู ในตอนแรก เชนเดียวกับกรณีบีบอัด Time Frame ในการเปล่ียนจาก Time Frame         

ที่มีขนาดเล็กไปยัง Time Frame ท่ีมีขนาดใหญ) 

  

เมื่อคุณเปลี่ยน time frame ไปคร้ังนึงแลวดวยการใช TimeFrameSet ฟงกชัน AFL ท้ังหมด        

จะทํางานบน time frame ท่ีคุณเลือก จนกระท่ังคุณเปล่ียนกลับไปใช time frame ด้ังเดิม โดยการใช         

TimeFrameRestore หรือ ใชการเปล่ียน time frame อีกคร้ังหนึ่งดวยการใช TimeFrameSet ซ่ึงเราแนะ        

นําวา มันจะเปนการดีมาก หากคุณเรียกใช TimeFrameRestore ทุกคร้ังหลังจากท่ีคุณจบการใชงาน time      

frame ที่คุณเลือกแลว 

  

เมื่อ time frame ถูกเปล่ียนไปยัง time frame อ่ืนท่ีไมใช time frame ดังเดิม ผลลัพธของฟงกช่ัน           

ทุกอันหลังจากที่คุณเรียกใชฟงกชัน TimeFrameSet ก็จะถูกเปล่ียนไปดวยเชนกัน ถาหากคุณตองการท่ีจให    

มันใช Time Frame ดั้งเดิมของมันคุณจําเปนท่ีจะตอง ขยาย (expand) พวกมันในภายหลัง ตัวแปรตางๆท่ี        

สรางขึ้นกอนที่จะเรียกใช TimeFrameSet() ก็จะยังคงอยูใน time frame ท่ีมันถูกสรางข้ึน การกระทําตางๆ       

เหลานี้สามารถทําไดอยางไมมีขีดจํากัดในหนึ่ง formula 

  

หมายเหตุ : การที่คุณจะบีบอัดขอมูล คุณทําไดแคจาก Time Frame ท่ีเล็ก ไป Time Frame          

ที่เล็กที่ใหญกวาไดเทานั้น ดังน้ันหากคุณใชงาน ขอมูล 1 นาที คุณสามารท่ีจะบีบอัดขอมูลเปน 2, 3, 4, 5, 6,           

....N-นาที ได แตเมื่อคุณทํางานบนขอมูล 15 นาที คุณไมสามารท่ีจะใชขอมูล 1 นาทีได นอกจากน้ีก็จะมีควา         

มคลายคลึงกันในการใชงาน หากขอมูลของคุณมีแคเพียง ขอูล EOD คุณก็จะไมสามารถเขาถึงขอมูล intraday      

time frames ได สยามควอนท 

  

กลุมที่สอง: ​TimeFrameCompress/TimeFrameExpand ​สามารท่ีจะบีบอัด หรือ ขยาย array      

เดี่ยวๆไปยัง Time Frame ท่ีแตกตางกันได โดยเฉพาะอยางยิ่งคุณควรท่ีจะทราบไวอยางย่ิงวา ใน      
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TimeFrameExpand ถูกใชเพ่ือคลายการบีบอัดตัวของตัวแปร array ท่ีถูกสรางข้ึนใน time frame ท่ีแตกตาง       

กัน การคลายการบีบอัดตัว จําเปนท่ีจะตองบอกถึง array ท่ีถูกสรางข้ึนใน time frame ท่ีแตกตางกัน        

ยกตัวอยางเชน หากคุณตองการท่ีจะใช weekly moving average คุณตองทําการ ขยาย(expand) มัน        

ดังนั้นขอมูลของหนึ่ง weekly จะครอบคลุม bars 5 วัน (Monday-Friday) ของสัปดาหท่ีสอดคลองกัน 

  

TimeFrameExpand( array, interval, mode = expandLast ) การขยาย array ของจาก          

'interval' time frame ไปสู time frame หลัก ('interval' จะตองสอดคลองกับคาท่ีถูกใชใน         

TimeFrameCompress หรือ TimeFrameSet) 

 

 mode ที่สามารใชได : 

 

expandLast - คาท่ีถูกบีบอัด จะถูกขยายโดยการเร่ิมตนจาก bar สุดทาย ในชวงระยะเวลาท่ีเรา       

กําหนด( ยกตัวอยางเชน weekly close/high/low จะใชบน bar ของวันศุกร) 

expandFirst - คาท่ีถูกบีบอัด จะถูกขยายโดยการเร่ิมตนจาก bar แรก ในชวงระยะเวลาท่ีเรา       

กําหนด(ยกตัวอยางเชน weekly close/high/low จะใชบน bar ของวันจันทร) 

expandPoint - array ผลลัพธท่ีไดนั้นจะไมมีคาท่ีวางเปลาเลยโดยนับจากชวงระยะเวลาท่ีเรากําหนด    

(เอา bar ทุก bar ที่ไมเปน Null (ไมมีคา)). 

Caveat: expandFirst ใชเมื่อ price แตกตางจากราคาเปด ซึ่งบางทีอาจจะเปนการมองไปในอนาคต      

ยกตัวอยางเชน หากคุณสราง ราคา High ท่ีเปน weekly แลวทําการขยายมันเปนระยะเวลาท่ีเปน daily        

โดยใช expandFirst จะชวยใหคุณรูในวันจันทรวา high ของท้ังสัปดาหอยูตรงไหน 

  

TimeFrameCompress ถูกออกแบบมาอยางสมบูรณแบบ มันสามารท่ีจะใชเม่ือคุณตองการท่ีจะ   

ขยายชวงเวลาของ array หนึ่งๆ โดยปราศจากการสงผลใดๆตอ OHLC,V arrays หากคุณเรียกใช       

TimeFrameCompress มันจะไมสงผลใดๆตอผลลัพธของ ฟงกช่ันอ่ืนๆเชนกัน 

  

wc = TimeFrameCompress( Close, inWeekly ); 
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/* ตอนนี้ time frame ยังคงไมถูกเปล่ียน (ยังเปน daily อยู ) และ MA จะทํางานบน ขอมูลท่ีเปน             

daily */ 

  

dailyma = MA( C, 14 ); 

 

/* แตถาเราเรียก MA บนcompressed array มันจะเปน MA ท่ีเปน time frame อ่ืน 

*/ 

  

weeklyma = MA( wc, 14 ); // โปรดทราบวานี้คือ time-compressed array  

Plot( dailyma, "DailyMA", colorRed ); 

weeklyma = TimeFrameExpand( weeklyma, inWeekly ); // ไดถูกขยายชวงเวลเรียบรอยแลว 

 Plot( weeklyma, "WeeklyMA", colorBlue ); 

 

ใน formula นี้ time frame จะยังคงอยูท่ีการตั้งคาดังเดิม มันจะเปล่ียน time frame แค  array เดียว 

  

TimeFrameCompress( array, interval, mode = compressLast ) 

- การบีบอัด array เดียวนั้นสามารทําไดโดยใช  compression mode ดังตอไปน้ี: compressLast - 

ใช คาสุดทายของ array (close) ในชวงเวลานั้น 

compressOpen - ใช คา open array ในชวงเวลานั้น 

compressHigh - ใช คาสูงท่ีสุดของ array ในชวงเวลานั้น compressLow -ใช คาต่ําท่ีสุดของ array 

ในชวงเวลานั้น compressVolume - ใช คารวม array ในชวงเวลานั้น 

  

Graph0 = TimeFrameExpand( TimeFrameCompress( Close, inWeekly, compressLast ), 

inWeekly, expandLast ); 

Graph1 = TimeFrameExpand( TimeFrameCompress( Open, inWeekly, compressOpen 

), 

inWeekly, expandFirst ); 
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กลุมที่สาม ประกอบดวยเพียงแคหนึ่งฟงกชันท่ีมีประโยชนมาก: TimeFrameGetPrice จะทําใหการ    

อางอิง price และ volume จาก time frames โดยปราศจาก การเปล่ียน /การบีบอัด/การขยาย time           

frame ใดๆอีกเลย แคหนึ่งฟงกชันเทานั้น เพ่ือดึง price จาก time frame ท่ีใหญกวา และมันยังไมเพียง          

แคอางอิงจากปจจุบัน แตมันยังสามารถท่ีจะอางอิง bar ในอดีตใน time frame ท่ีแตกตางกันไดอีกดวย 

  

TimeFrameGetPrice( pricefield, interval, shift = 0, mode = expandFirst ); 

 

-  อางอิง OHLCV จาก time frame อ่ืนๆมันสามารถทํางานไดทันทีโดยปราศจากการเรียกใช 

TimeFrameSet ฟงกชัน 

 

Price field สามารใชเปนอันใดอันหนึ่งจาก : "O", "H", "L", "C", "V", "I" (open interest)  

Interval คือ ชวงเวลาในหนวยวินาที 

shift คือการอางอิงจากในอดีต (คาติดลบ) และคาในอนาคตคือ future (คาเปนบวก) จากขอมูลใน       

time frame ที่ใหญขึ้น เชน -1 คือใชขอมูลจาก bar กอนหนา (เหมือนกับฟงกชัน Ref แตมันใชงานใน time            

frame ที่ใหญขึ้น) 

  

ตัวอยาง: 
  

TimeFrameGetPrice( "O", inWeekly, -1 ) // เพ่ือสรางราคา Open -ของ 1 week กอนหนา 

TimeFrameGetPrice( "C", inWeekly, -3 ) // เพ่ือสรางราคา Close ของ 3 week กอนหนา 

TimeFrameGetPrice( "H", inWeekly, -2 ) // เพ่ือสรางราคา High ของ 2 week กอนหนา 

TimeFrameGetPrice( "O", inWeekly, 0 ) // เพ่ือสรางราคา Open ของ week ปจจุบัน 

TimeFrameGetPrice( "H", inDaily, -1 ) // เพ่ือสรางราคา High ของ 1 Day กอนหนา 

เมื่อใชในขอมูล intraday 

 

Shift ทํางานเหมือน Ref() ฟงกชัน แตมันเปนการประยุกตบนการบีบอัด time frame 

  

หมายเหตุ: ฟงกชั่นเหลานี้ทํางานเหมือนกับ3 ฟงกช่ันท่ีซอนกันเหลาน้ี 
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TimeFrameExpand( Ref( TimeFrameCompress( array, interval, compress(ข้ึนอยูกับ field ท่ีใช) ), 

shift ), interval, expandFirst ) 

 

ดังนั้นหาก shift = 0 การบีบอัดขอมูลอาจจะเปนการมองไปในอนาคต (high ของ week         

สามารถที่จะรูไดในวันจันทร) หากคุณตองการท่ีจะเขียนระบบการเทรด โดยใชฟงกช่ันน้ีโปรดทําใหแนใจวา   

คุณอางอิงขอมูลในอดีต ดวยการใช คา shift ท่ีติดลบ 

 

สิ่งเดียวที่แตกตางกันของของการใช TimeFrameGetPrice คือมันจะเร็วกวา 2 เทา แทนการใช      

Expand/Compress ปกติ SiamQuant 

  

หมายเหตุเกี่ยวกับศักยภาพของ TimeFrame ฟงกชัน : 
  

a) การวัดคาจะทําบน Athlon 1.46GHz, 18500 daily bars จะถูกบีบอัดใหเปน  weekly time 

frame 

TimeFrameGetPrice( "C", inWeekly, 0 ) - 0.0098 sec (9.8 milliseconds)  

TimeFrameSet( inWeekly ) - 0.012 sec (12 milliseconds)  

TimeFrameRestore( ) - 0.006 sec (6 milliseconds) 

TimeFrameCompress( Close, inWeekly, compressLast ); - 0.0097 sec (9.7 milliseconds) 

TimeFrameExpand( array, inWeekly, expandLast ); - 0.0098 sec (9.8 milliseconds) 

b) การวัดคาจะทําบน 1.46GHz, 1000 daily bars จะถูกบีบอัดใหเปน  weekly time frameall 

functions below 0.0007 sec (0.7 millisecond) 
  

มันทํางานไดอยางไร ? (How does it work internally ?) 
  

Time-frame ฟงกชัน ไมไดทําการเปล่ียน BarCount - พวกมันแค บีบ arrays ดังน้ัน คุณจะมี          

N-bars อันแรกที่เปน NULL (แทงแรกไมมีคา) และจากนั้น สวนสุดทายของ array จะยังคงใช time frame          

ในชวงระยะเวลาที่ถูกบีบอัดไวอยู ดังนั้นนี้จึงเปนเหตุผล หลักท่ีเราจะตองขยายขอมูลใหกลับไปยังขอมูลท่ีเปน   

ระยะเวลาดั้งเดิมของมันดวย TimeFrameExpand นี่คือการตรวจสอบอยางงายๆ (ใชการ exploration) โดย      
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แสดงวามันจะเกิดอะไรขึ้นหลังจากท่ีคุณเปล่ียนไปใช time frame ท่ีใหญข้ึน โดยการรัน Exploration บน       

current symbol, all quotations,ตั้งคาชวงเวลาเปน daily และคุณจะเห็นวา "ราคา close ท่ีถูกบีบอัดใน         

weekly เปนอยางไร" column จะประกอบดวยคาท่ีไมมีคา จากจุดเร่ิมตน และ ถูกบีบอัดขอมูลเปน weekly        

ในตอนสุดทายของ array 

  

Filter = 1; 

AddColumn(Close, "Daily close"); 

  

TimeFrameSet(inWeekly); 

AddColumn(wc = Close, "weekly close compressed"); TimeFrameRestore(); 

  

AddColumn( TimeFrameExpand(wc, inWeekly), "weekly close expanded"); 

  

ตัวอยาง 

  

ตัวอยางที่ 1: สรางกราฟ weekly MACD และสรางลูกศรเมื่อเกิดการ cross กัน จากขอมูล daily 

  

TimeFrameSet( inWeekly ); 

m = MACD(12, 26 ); // MACD จากขอมูล  WEEKLY 

TimeFrameRestore(); 

m1 = TimeFrameExpand( m, inWeekly ); Plot( m1, "Weekly MACD", colorRed ); 

PlotShapes( Cross( m1, 0 ) * shapeUpArrow, colorGreen );  

PlotShapes( Cross( 0, m1 ) * shapeDownArrow, colorGreen ); 

  

ตัวอยางที่ 2: สรางกราฟ weekly candlestick วางทับบนเสนราคาของขอมูล daily 

 

wo = TimeFrameGetPrice( "O", inWeekly, 0, expandPoint );  

wh = TimeFrameGetPrice( "H", inWeekly, 0, expandPoint );  
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wl = TimeFrameGetPrice( "L", inWeekly, 0, expandPoint );  

wc = TimeFrameGetPrice( "C", inWeekly, 0, expandPoint ); 

  

PlotOHLC( wo, wh, wl, wc, "Weekly Close", colorWhite, styleCandle ); Plot( Close, 

"Daily Close", colorBlue ); 

 

ตัวอยางที่ 3: ระบบแบบ 3 หนาจอ 

 

/* เปลี่ยนไปใช weekly time frame */ TimeFrameSet( inWeekly ); 

whist = MACD( 12, 26 ) - Signal( 12, 26, 9 ); 

wtrend = ROC( whist, 1 ); // weekly trend - การเปล่ียนแปลงของ macd histogram ใน 1 

week 

TimeFrameRestore(); 

  

/* ขยายการคํานวณ  MACD ไปสู daily เพ่ือท่ีเราจะสามารท่ีจะใชสัญญาณตางท่ีเกิดข้ึนจากขอมูล 

daily ได */  

 

wtrend = TimeFrameExpand( wtrend, inWeekly ); 

  

/* elder ray */ 

bullpower= High - EMA(Close,13); bearpower= Low - EMA(Close,13); 

  

Buy = wtrend > 0 /* หนาจอแรก: weekly trend ท่ีเปนบวก */ 

AND 

bearpower < 0 AND bearpower > Ref( bearpower, -1 ) /* หนาจอท่ีสอง : bear power 

negative แตเพิ่มขึ้น */ 

AND 

H > Ref( H, -1 ); /* หนาจอท่ีสาม: ถาหาก price ทํา new high*/ 

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 

 

http://www.siamquant.com/thai-amibroker-manual


 

 

 

- 234 - 

  

BuyPrice = Ref( H, -1 ); // buy stop level; 

  

Sell = 0 ; // exit เฉพาะ by stops 

ApplyStop( stopTypeProfit, stopModePercent, 30, True );  

ApplyStop( stopTypeTrailing, stopModePercent, 20, True ); 
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ฟงกชั่นการจัดอันดับ 

(Ranking functionality) 

 

การจัดอันดับนั้น คือ ความสัมพันธระหวางชุดของขอมูล สําหรับขอมูลสองส่ิงข้ึนไป  

แบบแรกคือการ “จัดอันดับท่ีสูงกวา”, “จัดอันดับท่ีตํ่ากวา” , “จัดอันดับท่ีสูงกวา” และ      

“จัดอันดับที่เทากัน”  สยามควอนท 

แบบที่สองคือ วิธีที่งายท่ีสุด คือการจัดอันดับโดยการเรียงลําดับ 'value' หรือ 'score' ยกตัวอยางเชน       

คุณสามารถที่จะใช 100-bar rate of change ของ symbol ใดๆ เพ่ือเปน 'score' หรือ 'value ของคุณ             

จากนั้นทําการเรียงลําดับผลลัพธเหลานั้น คุณก็จะได symbol list ท่ีตัวแรกคือ ตัวท่ีมีศักยภาพท่ีดีท่ีสุด (rate       

of change สูงที่สุด) และ ตัวสุดทายของ list คือ ตัวท่ีมีศักยภาพตํ่าท่ีสุด SiamQuant 

  

AmiBroker มีรูปแบบใหผูใชเลือกใชในการจัดอันดับ อยู 3 รูปแบบดวยกัน 

  

1.ใชการจัดอันดับจากสัญญาณการเทรด (buy/short) เพ่ือตัดสินใจ วาตัวไหนนาสนใจกวาตัวอ่ืนๆ    

ในขณะที่ทําการ backtest portfolios หรือ optimization 

2.ทําการจัดอันดับ โดยเลือกไดหลายๆตัวแปรในการจัดอันดับดวยการใช Exploration 

3.สรางการจัดอันดับเปนตัวเลขเพ่ือใชในภายหลังข้ึนมา(ฟงกช่ันเพ่ือใชงานท่ัวไป) 

  

การจัดอันดับแบบแรก นั้นจะถูกคํานวณอัตโนมัติ หากระบบเทรดของคุณมีการกําหนดตัวแปร   

PositionScore คุณสามารถท่ีจะใชตัวแปร PositionScore ในการตัดสินใจวาการเทรดคร้ังไหน ควรท่ีจะเขา     

มากกวากันเมื่อ เราไมสามารถทําการเขาซื้อไดในทุกๆสัญญาณท่ีเขามา ในกรณีน้ี AmiBroker จะใชคา     

absolute ของตัวแปร PositionScore ในการตัดสินใจ สําหรับรายละเอียดของ ฟงกชันในการจัดอันดับ คุณ       

สามารอานไดใน Portfolio Backtester tutorial 

  

การจัดอันดับแบบที่สอง เปนเพียงแคการกําหนดตัวเลขข้ึนมาตัวเลขนึงเพ่ือการจัดอันดับ โดยการใช   

ผลลัพธจากการ explore colum ท่ีมีการจัดอันดับนั้นสามารถทําไดโดยใชฟงกชัน AddRankColumn หลัง      
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จากนั้นใช SetSortColumns ฟงกชันเพ่ือการเรียงลําดับ คุณสามารถท่ีจะเรียกใช SetSortColumns ไดหลาย      

ครั้ง และคุณก็สามารถที่จะใช AddRankColumn เพ่ือสรางหลายๆ colum เพ่ือการเรียงลําดับท่ีหลากหลาย      

ไดมากยิ่งขึ้นอีกดวย สามารถดูตัวอยางไดจากดานลาง: 

  

Filter = 1; 

AddColumn( Close, "Close" ); 

 AddColumn( Volume, "BI" );  

AddSummaryRows( 31 + 32, 1.5 ); 

  

 

AddRankColumn(); // ไมตองทําการเรียงลําดับกอน AddRankColumn แคเพียงเพ่ิม line 

number  

เทานั้น 

 

SetSortColumns( -4 ); 

AddRankColumn(); // การจัดอันดับตาม Colum ท่ี 4 (จากนอยไปมาก) 

SetSortColumns( -3 ); 

AddRankColumn(); // การจัดอันดับตาม Colum ท่ี 3 (จากมากไปนอย) 
  

การจัดอันดับแบบที่สาม คือการจัดอันดวยดวยวัตถุประสงคโดยท่ัวๆไป โดยใชการจัดอันดับแบบ bar    

ตอ bar ดวยขอมูลจาก ตัวแปรแบบตัว(static variables) ซึ่งมันตัวแปรท่ีตองการขอมูลมากท่ีสุด แตก็ใหความ       

เปนไปไดมากที่สุดเชนกัน โดยท่ัวไปแลวการท่ีจะสรางตัวแปรแบบท่ีคงตัวจะถูกใชเพ่ือ เรียงลําดับหรือจัดอันดับ   

(sorting/ranking) ยกตัวอยางเชน การสรางตัวแปรท่ีเปน "scores" และหลังจากน้ันก็เรียงมันดวย ฟงกชัน      

พิเศษ (StaticVarGenerateRanks) ซึ่งมันจะ ทําการสรางชุดของตัวแปรแบบคงตัวใหมข้ึนมา เพ่ือใชในการจัด     

อันดับ 

  

หมายเหตุ: ฟงกชันนี้ไมไดมีจุดประสงคในการแทนท่ีการจัดอันดับผาน PositionScore 
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ในทางตรงกันขามเลย หากคุณสามารท่ีจะใช PositionScore คุณก็ควรท่ีจะเลือกใช PositionScore     

เนื่องจากความเร็วในการประมวลผลของมันมากกวา และใชเนื้อท่ีความจําท่ีนอยกวาอีกดวย มันเปนหนทางท่ี   

จะทําใหการจัดอันดับในการทํา backtest ของคุณมีประสิทธิภาพอยางมาก 

  

StaticVarGenerateRanks 

โดยทั่วไปแลวมันถูกสรางขึ้นมาเพ่ือใชในงานอ่ืนๆมากกวาเอาไวใชเพ่ือการ backtest เชนใชในการ   

explorations หรือใน indicators ท่ีอาจจะตองการฟงกชันของการจัดอันดับ แตแนนอนมันสามารถท่ีจะใช     

กับการ backtest ไดเชนกัน เมื่อ PositionScore เพียงอยางเดียวไมเพียงพอตอส่ิงท่ีคุณตองการในการสราง      

ระบบเทรดของคุณ  

  

โปรดระวัง: ฟงกชันนี้ใชการประมวลผลและหนวยความจําท่ีคอนขางมาก มันใชเวลาถึง 20ms    

สําหรับ 15K bars และ 7 symbol พยายามท่ีจะเรียกใชมันเพียงคร้ังเดียวตอการ       

scan/exploration/backtest การใช if( Status("stocknum")==0) หรือจะดีกวาในใชการทํางานท่ีแยกกัน     

โดยการสแกนขอมูลกอนการ คํานวณ แลวคอยนํามาจัดลําลับในภายหลัง แตถาคุณทํามันไมได    

คุณสามารถที่จะเรียกใชฟงกชัน 

StaticVarGenerateRanks​S​ศักยภาพในการทํางานของโปรแกรมจะลดลงอยางมีนัยยะสําคัญSเพราะไมเพียง 

แตฟงกชันนี้จะใชเวลามากในการทํางาน มันยังปดกันการเขาถึงการใชงานฐานขอมูลรวมกันอีกดวย น่ัน   

หมายถึงการที่คุณจะเขาถึงการใชตัวแปรแบบท่ีคงตัวนั้น คุณจําเปนท่ีจะรอจนกระท่ังฟงกชันน้ีทํางาน เสร็จ 
  

StaticVarGenerateRanks ฟงกชัน (StaticVarGenerateRanks function) 
  

StaticVarGenarateRanks( "outputprefix", "inputprefix", topranks, tiemode ) 

นี่เปนองคประกอบหลักของฟงกชัน มันตองใช 4 พารามิเตอรดวยกัน :  

ซึ่งเปนแกนหลักของการใชการจัดอันดับแบบท่ี 3 

  

"outputprefix" - คํานําหนาท่ีจะนําไปตอทายผลลัพธตัวแปรแบบคงตัวของเรา(output) 

ซึ่งนําไปใชในการจัดอันดับ 

 "inputprefix" คํานําหนาของตัวแปรแบบคงตัวท่ีใชในการทํา score (input)  
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 topranks ใชในการกําหนดวาจะมีจํานวนเทาไรในการจัดอันดับ top/bottom 

ซึ่งรวมถึงจํานวนในการจัดอันดับชุดขอมูลดวย 

tiemode ใชในการกําหนด ความสัมพันธ (equal ranks) แบบไหนควรไดรับการแกไข 

 

"inputprefix" คือตัวนําหนาท่ีจะกําหนดช่ือของตัวแปรแบบคงตัว ท่ีจะถูกใชในการนําไปจัดอันดับ   

(ตัวที่จะนําไป input) AmiBroker จะทําการคนหา ตัวแปรแบบคงตัวท้ังหมดท่ีเร่ิมดวยคํานําหนาน้ันๆ     

และสมมุติใหวามันเปนสวนหนึ่งของ ช่ือหุนนั้นๆ ดังนั้น หากคุณตองการท่ีจะ จัดอันดับโดยใช ROC      

(rate of change) ส่ิงท่ีคุณตองทําคือ การเก็บคาของมันลงในตัวแปรแบบคงท่ี ใหเราบอกวาเรา      

จะใชชื่อตัวแปรแบบคงตัว เชน "ItemScoreAPPL", "ItemScoreMSFT" และอ่ืน ๆ 

  

เพื่อที่จะสรางตัวแปรแบบคงตัวคุณสามารใช loop นี้ได 

  

for ( i = 0; ( sym = StrExtract( symlist, i ) ) != ""; i++ ) 

{ 

SetForeign( sym ); Value = ROC( C, 10 ); 

RestorePriceArrays(); 

StaticVarSet( "ItemScore" + sym, Value ); 

} 

  

ตอนนี้คุณสามารถที่จะเขาสูการ การเรียงลําดับ/การจัดอันดับไดแลว (sorting/ranking) พวกมันมี 2     

โหมดคือ normal ranking mode และ Top/Bottom Rank mode วิธีแบบ Normal ranking mode            

จะถูกใชเมื่อตัว toprank มีคาตั้งแต 0  

  

StaticVarGenerateRanks( "rank", "ItemScore", 0, 1224 ); 

  

ในกรณีนี้ StaticVarGenerateRanks จะถูกเรียกเพ่ือสราง ชุดของตัวแปรแบบคงตัว ท่ีข้ึนตนดวย     

คํานําหนาซึ่ง กําหนดมาจากสอง argument แรก ท่ีเรากําหนดไว ดังนั้นในกรณีน้ี RankItemScoreMSFT       

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 

 

http://www.siamquant.com/thai-amibroker-manual


 

 

 

- 239 - 

จะใชในการจัดอันดับของ MSFT, RankItemScoreAAPL จะใชในการจัดอันดับของ AAPL หมายเหตุ      

AmiBroker จะจัดอันดับโดยการเร่ิมตนจากเลขหนึ่ง  

  

argument ที่สาม (topranks) ถาเราใหคาเปน 0 หมายถึงเลือกใช normal ranking mode 

argument ที่สี่  (tiemode) กําหนดความสัมพันธในการจัดอันดับ  

Supported modes คือ 1234 และ 1224 ( 1224 mode จะใหความสัมพันธของตัวแปรท่ีมี 

คาเทากันดวย) 

  

code ตัวอยาง สําหรับ normal ranking mode (ทุกอยางท่ีทําเสร็จแลว 

มันจะจบในการรันครั้งเดียว(สามารท่ีจะใชใน indicator ได) : 

 

 symlist = "C,CAT,DD,GE,IBM,INTC,MSFT"; 

  

// ลบตัวแปรแบบคงตัว 

StaticVarRemove( "ItemScore*" ); 

  

// ปอนขอมูล  arrays ท่ีคงท่ี 

  

for ( i = 0; ( sym = StrExtract( symlist, i ) ) != ""; i++ ) 

{ 

SetForeign( sym ); Value = ROC( C, 10 ); 

RestorePriceArrays(); 

StaticVarSet( "ItemScore" + sym, Value ); 

} 

  

// ทําการจัดอันดับ 

StaticVarGenerateRanks( "rank", "ItemScore", 0, 1224 ); // normal rank mode 
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// อานคาการจัดอันดับ 

for ( i = 0; ( sym = StrExtract( symlist, i ) ) != ""; i++ ) 

{ 

Plot( StaticVarGet( "RankItemScore" + sym ), sym, colorCustom10 + i ); 

} 

  

Top/bottom ranking mode (คือ การสรางตารางการจัดอันดับจาก top/bottom ว่ึงตรึงคา       

ดัชนีไปไวดานบนสุด เมื่อ topranks > 0 คาของ top ranked จะถูกใช และเม่ือ topranks < 0 คาของ              

bottom ranked จะถูกใช คาท่ีถูกเก็บไวในตัวแปรมีรูปแบบดังนี้  SiamQuant 

 

OutputprefixInputprefixN เมื่อ N คือตัวเลข 1, 2, 3 ซ่ึงเปนตัวเลขท่ีแสดงถึงอันดับของ        

top/bottom ranks 

ลองสมมุติวา OutputPrefix นี้มีพารามิเตอรคือ "Top" และ Inputprefix พารามิเตอร คือ ROC         

ในแตละอันตัวแปร ตามนี้ TopROC1 จะถูกตึงดวยอันดับของคา Top rated นอกจากน้ี TopROC2 จะถูก         

ตรึงดวย อันดับที่สอง ของคาและ อ่ืนๆ 

 

ฟงกชั่น StaticVarGenerateRanks ใชเลขตําแหนงท่ีเร่ิมตนจากท่ีหน่ึง ใน top ranking mode       

StaticVarGenerateRanks 

 

จะเตรียมตัวแปรแบบคงตัว ท่ีคั่นดวยเคร่ืองหมาย “ , ” เพ่ือแยก list ของช่ือตัวแปร ซ่ึงมันสามารถท่ี         

จะใชเพื่อคนหาวา ดัชนีตัวไหนอางอิงจาก symbol ตัวไหน ดังนั้นถา TopROC1 ถูกตึงดวย 1 ท่ีคุณจะหา         

substring แรกในตัวแปร ในตัวแปร TopROCSymbols เพ่ือหาวาตัวแปรตัวไหน (symbol) ถูกจัดอันดับไว       

บนสุด 

นอกจากนี้ StaticVarGetRankedSymbols ใหวิธีการท่ีงายตอการใชงาน เพ่ือท่ีจะแยก list ของการ      

จัดอันดับดวยเครื่องหมาย “,” โดยเฉพาะอยางยิ่งกับการใชกับ วันท่ี (datetime) 

  

ตัวอยางโคดใน top ranking mode : 
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symlist = "C,CAT,DD,GE,IBM,INTC,MSFT"; 

  

// ลบตัวแปรแบบคงตัว 

 StaticVarRemove( "ItemScore*" ); 

  

// ปอนขอมูล  arrays ท่ีคงท่ี 

  

for ( i = 0; ( sym = StrExtract( symlist, i ) ) != ""; i++ ) 

{ 

SetForeign( sym ); Value = ROC( C, 10 ); 

RestorePriceArrays(); 

StaticVarSet( "ItemScore" + sym, Value ); 

 

  

} 

  

// ทําการจัดอันดับ 

StaticVarGenerateRanks( "rank", "ItemScore", 0, 1224 ); // normal rank mode 

StaticVarGenerateRanks( "top", "ItemScore", 3, 1224 ); // top-N mode 

StaticVarGenerateRanks( "bot", "ItemScore", -3, 1224 ); // bottom-N mode 

// อานคาการจัดอันดับ 

for ( i = 0; ( sym = StrExtract( symlist, i ) ) != ""; i++ ) 

{ 

Plot( StaticVarGet( "RankItemScore" + sym ), sym, colorCustom10 + i ); 

} 

  

sdt = SelectedValue( DateTime() ); 

  

 

 

 

- คูมือการใชงาน Amibroker ฉบับแปลไทย โดย SiamQuant - 

 

http://www.siamquant.com/thai-amibroker-manual


 

 

 

- 242 - 

Title = "{{NAME}} -{{DATE}} - {{VALUES}} TOP: " + StaticVarGetRankedSymbols( "top", 

"ItemScore", sdt ) + 

" BOT: " + StaticVarGetRankedSymbols( "bot", "ItemScore", sdt ) ; 
  

 จะสามารถใช StaticVarGenerateRanks ใน Analysis window ไดอยางไร (How to 

use StaticVarGenerateRanks in Analysis window) 
  

เนื่องจากการจัดอันดับ เปนกระบวนการท่ีมีความความตองการของขอมูลเปนอยางมาก ดังน้ันมัน   

ควรจึงทํางานแคหนึ่งครั้งตอการรัน Analysis หนึ่งคร้ัง ไมใชบนทุกๆ symbol คุณสามารถ ซ่ึงคุณสามารถ       

ทํามันไดโดยการ รันแยกกันของ การใชสูตรในการใหมันจัดอันดับกอนท่ีจะใหมัน รัน Analysis หรือ      

การใชStatus("stocknum") == 0 ท่ีเปนคําส่ังท่ีจะใหคุณมันใจวากระบวนการจัดอันดับน้ันทําอยูบนแค    

symbol แรกจาก watch list ภายใต analysis เทานั้น สยามควอนท 

  

และนี่คือตัวอยางของโคดสําหรับการ exploration ท่ีใชกับ active watch list หรือ symbol list         

ทั้งหมด และดําเนินการจัดอันดับ 
 

 if ( GetOption( "ApplyTo" ) == 2 ) 

{ 

wlnum = GetOption( "FilterIncludeWatchlist" ); 

List = CategoryGetSymbols( categoryWatchlist, wlnum ) ; 

} 

else 

 

if ( GetOption( "ApplyTo" ) == 0 ) 

{ 

List = CategoryGetSymbols( categoryAll, 0 ); 

} 

else 

{ 
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 Error( "The formula works fine if your ApplyTo setting is 'Filter' or 'All'" ); 

} 

 

if ( Status("stocknum") == 0 ) // สรางการอันดับ เมื่ออยูบน SYMBOL แรก 

 

{ 

StaticVarRemove( "values*" ); 

  

for ( n = 0; ( Symbol = StrExtract( List, n ) )  != "";  n++ ) 

{ 

SetForeign ( symbol ); values = RSI(); RestorePriceArrays(); 

StaticVarSet (  "values"  +  symbol, values ); 

_TRACE( symbol ); 

} 

  

StaticVarGenerateRanks( "rank", "values", 0, 1224 ); 

} 

  

symbol = Name(); 

  

values = StaticVarGet ( "values" +  symbol ); rank = StaticVarGet ( "rankvalues" + 

symbol ); 

  

AddColumn ( values, "values" ); AddColumn ( rank, "rank" ); 

  

  

Filter = 1; 
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SetSortColumns( 2, 4 ); 

คียลัดในโคด AFL 

(Using AFL Code snippets) 

 

คียลัดโคด นั้นเปนสวนเล็กๆสวนหนึ่งของการใชงานใหมๆบน โคด AFL มันสามารถท่ีจะนําเขาไดโดย 

·  คลิกขวาบนหนาตาง AFL editorและเลือกเมนู "Insert Snippet" หรือ 

·  ลากคียรลัดจาก Snippet window 

·  หรือคียรลัดบนคียบอรด (เชน @for ) 
 

 

 

ในเวอรชั่น 5.90 โคดคียลัดสามารถทํางานไดอัตโนมัติบน list  ใน the AFL Editor แคเพียง ใช @ 

แลวเขียนตัวอักษรแรกลงไป มันก็จะแสดง list ของคียลัดท่ีคุณสามารใชได 
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การเปลี่ยนคียบอรดเปนอีกทางหนึ่งท่ีจะชวยใหคุณใชงานมันได โดยท่ีไมตองใชงานฟงกชันดานบน 

ดังนั้นแค @keytrigger และแทนทีมันดวยคัยรลัด 
 

  

การกําหนดคียลัดของตัวคุณเอง (DEFINING YOUR OWN SNIPPETS) 

 

 คุณสามารถที่จะเพิ่มคียลัดของตัวคุณเองไดงายๆ ดวยการเขียนดวยหนาตาง Code Snippet ซ่ึง 

Code Snippets window นั้นจะทํางานบนหนา AFL editor มันสามารถท่ีจะแสดงบนหรือซอนไว ดวยการใช 

Window menu 

  

เพื่อที่จะสรางคียลัดดวยตัวคุณเอง ส่ิงท่ีคุณตองทําก็คือ : SiamQuant 

  

1. ประเภทของโคดที่คุณตองการ สยามควอนท 

2.  เลือก (mark) โคดท่ีคุณตองการจะใหเปนคียลัด 

3.  กด Save selection ใหเปนปุม ในหนาตาง Code Snippets 
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ถาคุณทําตามขั้นตอนขางตนโตแลวกลองโตตอบตอนี้จะปรากฏข้ึน : 
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ตอนนี้คุณตองใสคําอิธบิยของคียตางๆลัดลงไปในชอง Name, Description และ Category ในสวน      

ของ Category สามารถเลือกไดจากรายการท่ีมีอยูแลว (ใช drop down box) หรือ สราง category          

ขึ้นมาใหม โดยการพิมพลงไปในชอง category เลย Key trigger คือพ้ืนท่ีสําหรับตัวเลือกท่ีประกอบดวยขอมูล       

โคดคียลัดที่เปนแบบอัตโนมัติ (ตามท่ีอธิบายไวขางตน) Formula คือพ้ืนท่ีท่ีเอาไวใสโคดคียลัดของตัวมันเอง    

หลังจากที่เติมขอมูลครบทุกชองแลวก็กด OK คียลัดใหมของคุณก็จะปรากฏข้ึนมา 
 

  

  

จากนั้นคุณสามารถใชคียลัดโคดของคุณเองแบบเดียวกับตัวอยางท่ีมีอยูตามท่ีไดอธิบายไวแลว 

บางทีวิธีที่สะดวกที่สุดอาจจะเปนการใชการลากวางจาก list ไปยัง AFL editor 

  

บางทีคุณอาจจะสังเกตเห็น user-defined snippets (ตัวคียลัดท่ีเรากําหนดเอง) ถูกมารคไวดวย     

กลองสีแดงใน Code Snippets list มีแคเพียง user-defined snippets ท่ีสามารถท่ีจะเขียนทับ หรือ ลบได          

เทานั้น สยามควอนท 
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หากตองการแกไขขอมูล user-defined snippet ท่ีมีอยูท่ี คุณสามารถทําตามข้ันตอนดานบน และใช      

ชื่อที่มีอยูเดิมแลว Amibroker จะถามคุณหาก คุณตองการท่ีจะ เขียนทับ คียลัดท่ีมีอยูเดิม หรือคุณแคเพียง       

คลิกบนปุม Properties และแกไขมัน โดยตรงไดเลย 
 

 

  

เพื่อที่จะลบคียลัด ใหเลือกคียลัดท่ีคุณตองการจะลบจาก list และกดปุม Delete (X) ในหนาตาง       

Code Snippet  
  

 TECHNICAL INFO (สําหรับผูใชข้ันสูง) (TECHNICAL INFO (advanced users only)) 

  

มีสองไฟลอยูใน  Amibroker directory ท่ีเปนคียลัด : 

CodeSnippets.xml - คียลัดเหลานี้จะมาพรอมกับการติดตั้ง AmiBroker (และสามารถถูกทับไดโดย     

การติดตั้งใหมในภายหลัง ดังนั้น โปรดอยาแกไขมัน)  

UserSnippets.xml - นี่คือ user-definable snippets ไฟลน้ีไมไดมาพรอมในการติดต้ัง และ       

ผูใชงานสามารถสรางไดดวยตัวของพวกเขาเอง 

  

โครงราง XML สําหรับไฟลคียลัด อยางงาย (ตามดานลาง) ฟงกช่ันทริกเกอรท่ียังไมไดดําเนินการ 

 

อยางไรก็ตาม Keytrigger ควรรวมอยูในคํานิยามสําหรับใชงานในอนาคต มันจะทํางานเหมือนกับ    

การทําใหสมบูรณอัตโนมัติ แคเพียงคุณใชคียลัด มันจะทําการ unfold formula น้ันๆ SiamQuant 

  

<?xml version="1.0" encoding="ISO-8859-1"?> 

<AmiBroker-CodeSnippets CompactMode="0"> 

  

<Snippet> 

<Name>First Snippet</Name> 
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<Description>Description of the snippet</Description> 

<Category>User category</Category> 

<KeyTrigger>?trigger1</KeyTrigger> 

<Formula> 

<![CDATA[ 

  

// the formula itself 

  

]]> 

</Formula> 

</Snippet> 

  

<Snippet> 

<Name>Second Snippet</Name> 

<Description>Description of the snippet</Description> 

<Category>User category</Category> 

<KeyTrigger>?trigger2</KeyTrigger> 

<Formula> 

<![CDATA[ 

  

// the formula itself 

  

]]> 

</Formula> 

</Snippet> 

</AmiBroker-CodeSnippets> 
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คูมือการใชงานแบบวิดีโอ (on-line) 

(Video Tutorials (on-line)) 
  

เพื่อความสะดวกของคุณ เราไดเตรียมบทเรียนวิดีโอตอไปนี้ (ในรูปแบบโปรแกรม Macromedia 

Flash) บนหนาเว็บของเรา: SiamQuant  

  

· ​ How to install AmiBroker 

· ​ How to use drag-and-drop charting interface 

· ​ How to setup new database with eSignal RT feed​ (RT version) 

· ​ How to setup new database with IQFeed RT feed​ (RT version) 

  ​ How to setup new database with Interactive Brokers​ (RT version) 

· ​ How to use AmiQuote in 'manual' mode 

· ​ How to use chart sheets and layouts 

· ​ How to use layers 

· ​ How to use AFL Code Wizard 

  

สําหรับวิดีโอเพิ่มเติมโปรดเช็คท่ี:  http://www.amibroker.com/support.html 
  

  

 

SiamQuant  

สยามควอนท 
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